
Avid ISIS 
ReadMe Version 4.6.1 

Metadata Location On the System Director

This is an important reminder to move the metadata after doing an ISIS v4.x software upgrade. 
The upgrade instructions include moving the following files to a new location. 

• Partition0

• Partition1

• PartitionDump.bin

Old v2.x metadata location: D:\Program Files\Avid 
Technology\AvidUnityISISSystem Directorx64

New v4.x metadata location: D:\Program Files\Avid\ISIS System Director

Important Information

Avid recommends that you read all the information in this ReadMe file thoroughly before 
installing software or attempting to use the Avid ISIS system. This ReadMe provides information 
that is not in the other Avid ISIS documentation.

Date 
Revised Release Changes Made

02/13/2014 v4.6.1 Added “New in Avid ISIS v4.6.1” on page 10, merged Final Release support 
information for 4.6 and 4.6.1, corrections/additions to Supported ISIS Client Operating 
Systems table.

12/20/2013 v4.6 Updated to add “ISIS 5500 | 5000 Single Engine Configurations with Routed Clients” 
on page 56.

12/10/2013 v4.6 Updated “New in Avid ISIS v4.6” on page 12.
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This is a common ReadMe used for the ISIS 7500 | 7000, ISIS 5500 | 5000 and ISIS 2000 
infrastructures. Individual ReadMes no longer exist. New installations and upgrades run the 
same Autorun.exe file in the kit for installing the ISIS 7500 | 7000 System Director, ISIS 2000 
System Director, and ISIS 5500 | 5000 System Director or Engine, ISIS File Gateway, and 
Windows client software. The installer automatically detects any previously installed software 
and defaults to the appropriate software update. 

References to ISIS 5500 in this documentation apply to both ISIS 5500 and ISIS 5000 with the 
exception of the following:

• ISIS 5500-64. There was not an ISIS 5000-64.

• ISIS 5500-16 has an installed 10 Gb Myricom board. In the ISIS 5000-16, the Myricom 
board was not installed with a shipping system. The Myricom board was an optional board 
in the ISIS 5000-16. 

n Search the Avid Knowledge Base for the most up-to-date ReadMe file, which contains the latest 
information that might have become available after the documentation was published. To view 
the online version, visit the Knowledge Base at www.avid.com/support.

This document provides hardware and software requirements, a hardware overview, and other 
important information. This document also lists limitations and known issues. Physical 
connection of the system and loading of the system and client software is explained in the 
appropriate Avid ISIS Setup Guide. You can access the documentation in the top-level 
AvidISISDocumentation folder on the Avid ISIS software installer kit. 

c Avid recommends that you purchase installation services with your Avid ISIS system. 

http://www.avid.com/support
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If You Need Help
If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was 
published.

New information is provided in the ReadMe file supplied on your Avid software kit as a PDF 
document and is also available online.

You should always check online for the most up-to-date release notes or ReadMe 
because the online version is updated whenever new information becomes available. To 
view the online versions, visit the Knowledge Base at www.avid.com/US/support.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/US/support. Online services are 
available 24 hours per day, 7 days per week. Search this online Knowledge Base to find 
answers, to view error messages, to access troubleshooting tips, to download updates, and to 
read or join online message-board discussions.

Accessing the Online Documentation

The Avid ISIS documentation is accessible in PDF format from the Help menu in the Avid ISIS 
Management Console browser window as well as on the top-level AvidISISDocumentation 
folder on the Avid ISIS software installer kit. 

n The documentation describes the features and hardware of all models. Therefore, your system 
might not contain certain features and hardware that are covered in the documentation.

To access the online documentation from the installer kit:

1. Load the Avid ISIS software installer kit onto your computer.

2. Navigate to the [drive]:\AvidISISDocumentation folder, and double-click the PDF file 
for the document you want to view.

http://www.avid.com/US/support
http://www.avid.com/US/support
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Avid Training Services
Avid makes lifelong learning, career advancement, and personal development easy and 
convenient. Avid understands that the knowledge you need to differentiate yourself is always 
changing, and Avid continually updates course content and offers new training delivery methods 
that accommodate your pressured and competitive work environment.

For information on courses/schedules, training centers, certifications, courseware, and books, 
please visit www.avid.com/support and follow the Training links, or call Avid Sales at 
800-949-AVID (800-949-2843).

Product Terminology

The following three sections give new users a brief description of ISIS component names.

ISIS 7500 | 7000 Terminology

The major components used to create the Avid ISIS 7500 | 7000 shared storage network are: a 
System Director, an engine containing ISIS Integrated Switch (ISS), ISIS Integrated Expansion 
Switch (IXS), ISIS Storage Blade (ISB), and one or more clients. 

Avid ISIS 7500 | 7000 Shared Storage Network Hardware

System Director front view

Rear view Front view

ISIS Integrated Switch (ISS)

ISIS Integrated Expansion Switch (IXS)

ISIS Storage Blade (ISB)

Power supply

Engine

ID

http://www.avid.com/support
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If you are unfamiliar with the names of the Avid ISIS 7500 | 7000 components, the following 
table provides the terms used in this and other Avid ISIS 7500 | 7000 documents.

Product Nomenclature

Product name Term used and description

Avid ISIS storage blade 
(labeled i500, i1000, i2000, i4000, i8000)

ISIS Storage Blade (ISB)

This hot swappable sled is accessible from the front of the 
ISIS engine and contains two SATA drives. 

Avid ISIS Integrated Ethernet switch 
blade

ISIS Integrated Switch (ISS) 

This hot swappable switch is accessible from the rear of the 
ISIS engine and connects 1 Gb and 10 Gb clients. The 
ISS2000 indicates second generation hardware; first 
generation hardware is labeled ISS1000.

Avid ISIS Integrated Expansion Ethernet 
switch blade

ISIS Expansion Switch (IXS) 

This hot swappable switch is accessible from the rear of the 
ISIS engine is used to stack multiple ISIS Engines. The IXS 
switches are only found in configurations with three or more 
Engines. The IXS2000 indicates second generation hardware; 
first generation hardware is labeled IXS1000.

Integrated power supply and cooling fans Power supplies

Three hot swappable power supplies are accessible from the 
rear of the ISIS engine.Two power supplies are required to 
power the ISIS Engines.

Avid ISIS engine Sometimes called Chassis in the Management Console 
interface

Contains the ISBs, ISSs, IXSs, power supplies, and an internal 
midplane.

Avid ISIS System Director (Active and 
standby)

System Director: a server connected to the ISIS engine to 
manage the file system and portions of the metadata

Avid ISIS client Client, defined as a user’s workstation or server with Avid 
ISIS client software installed that allows that system to mount 
workspaces

Avid ISIS shared storage network System or shared network storage environment

The Avid ISIS consist of the hardware, Avid software, and 
other hardware supplied by the customer, such as external 
Ethernet switches. 
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ISIS 5500 Terminology

A single Avid ISIS chassis provides System Director and Engine (Storage Server) functionality. 
Each Avid ISIS Engine is comprised of 16 media storage drives, two mirrored system drives, 
RAID controller, 10 Gigabit Ethernet interface, four 1 Gb Ethernet interfaces, plus redundant 
power supplies and fans. 

Avid ISIS 5500 Engines are available in three configurations;

• ISIS 5500-16 — 16, 1 TB drives

• ISIS 5500-32 — 16, 2 TB drives

• ISIS 5500-64 — 16, 4 TB drives, includes 10 Gigabit Ethernet interface installed

Either configuration supports an optional four port 1 Gb Ethernet Network Interface Card (NIC), 
which can be added to provide up to eight 1 Gb Ethernet interfaces (four built in plus four port 
NIC on a single engine configuration). Up to six Engines are supported in the ISIS 5500, with 
4 TB media storage drives can be combined to deliver 384 TB of shared storage. The first ISIS 
Engine provides System Director and Management Console functionality in addition to media 
storage.

Engine connections are summarized in the following list. 

• Direct Connect Clients — Four or eight 1 Gb Ethernet clients and one 10 Gb client connect 
directly into the System Director. Each client must be on a separate subnet and use a 
common subnet mask. 

• Single Engine with 1 Gb Connection to the Switch — If you are using the four 1 Gb 
Ethernet connections from the System Director to a switch, each 1 Gb port on the System 
Director uses an IP address on the same subnet and a common subnet mask. 

• Single Engine with 10 Gb Connection to the Switch — If you are using the 10 Gb 
Ethernet connection from the System Director to a switch, the System Director uses one IP 
address. 

• Multi-Engine Connection to the Switch (10 Gb) — If you are connecting multiple 
Engines, you must use the 10 Gb Ethernet connection from the Avid ISIS System Director 
and expansion engines to the switch. Each Engine uses one IP address. 

Zone 1, Zone 2, Zone 3, and Zone 4 
Configurations

These are Avid-defined client configurations that connect the 
client to the Avid ISIS system. A complete explanation can be 
found in the Avid ISIS 7500 | 7000 Setup Guide.

Product Nomenclature (Continued)

Product name Term used and description
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ISIS 2000 Terminology

An Avid ISIS 2000 uses an external AS3000 System Director similar to the ISIS 7500 | 7000 (see 
ISIS 7500 | 7000 Terminology). Although the ISIS 2000 System Director is similar to the 
ISIS 7500 | 7000 System Director, it is not the same System Director. Depending on your Avid 
ISIS 2000 Engine configuration, the Engine includes 82 or 42 media drives, an Engine controller 
with 10 Gb Ethernet connections, plus redundant power and cooling modules. 

Avid ISIS 2000 Engine

Up to five Engines with 3 TB media storage drives are supported in the ISIS 2000 environment 
providing 1.2 petabyte (PB) of raw storage (960 TB usable storage). Avid ISIS 2000 Engines are 
available in two configurations:

• ISIS 2000-240 — 82, 3 TB drives, providing 240 TB of raw storage which equates to 
192 TB of usable storage

• ISIS 2000-120 — 42, 3 TB drives, providing 120 TB of raw storage which equates to 96 TB 
of usable storage

The ISIS 2000 System Director connects to an ISIS qualified switch using either a 1 Gb or 10 Gb 
connection. The ISIS 2000 Engine connects to that same switch using a 10 Gb connection. Both 
models of Avid ISIS 2000 Engines are populated with 3 terabyte (TB) SAS drives. These media 
drives are configured for redundant array of independent disks (RAID) 6 storage protection. 
Clients access any combination of ISIS online systems (ISIS 5500 and ISIS 7500 | 7000) and 
ISIS nearline systems (ISIS 2000) through external switch connections. The ISIS 2000 
Management Console provides the same workspace and user functionality offered in all ISIS 
environments.

Engine Controller Cooling module (x5)

Power supply unit (x2)
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The ISIS 2000 nearline system workflows provides basic video playback of low bit rate media 
and high-speed file transfers to online ISIS systems. 

New in Avid ISIS v4.6.1
Integrity Hardening

The ISIS v4.6.1 patch kit offers improvements in data protection when a Storage Manager 
cannot write to its peer and becomes unresponsive to the rest of the system.

Auto-Rectify Option

The ISIS v4.6.1 patch kit includes a new option in the Management Console. You can now 
enable Auto-Rectify, which automatically reconciles the actual amount of used space and the 
reported amount of used space on a system.

To enable Auto-Rectify, click Preferences under the Advanced heading. Click the check box, and 
then click Save Preferences.

The following figure shows the location of the Auto-Rectify check box: 

Final Supported Release Stream for Some Avid Products

The v4.6.x release stream is the last to officially support the following products:

• AirSpeed Classic

• Final Cut Pro 7.x

• Media Composer 5.5.x and 6.0.x

• NewsCutter 9.5.x and 10.0.x
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• Symphony 5.5.x and 6.0.x

• Windows Vista 32 and 64

• Windows XP (AirSpeed Multi Stream will still be supported)

Fixed in This Release

The following issues were fixed in v4.6.1.

➤ If the scratch drive in Final Cut Pro was set to an ISIS Workspace and any video or audio effect 
was rendered, “error: not found” was displayed when the render completed. This was caused 
by a change in how the Finder Info is used for rendered media files between Final Cut Pro 6 and 
7. ISIS now allows rendering to an ISIS workspace for both FCP 6 and FCP 7. Older FCP 6 
projects may need to re-render effects if the rendered files reside in an ISIS workspace.

➤ Media write issue on the Mac client, seen when doing AS11 exports from Media Composer. The 
exported file had inconsistencies and AMA-linking displayed an error message saying the 
plug-in does not support the file.

➤ Issue on ISIS client installation of AirSpeed5000. Under some circumstances, the Performance 
Monitor database in the registry got corrupted, causing the installation of the ISIS Performance 
Monitor counters to fail.

➤ Removing an ISIS7000 blade and unbinding it before redistribution completed resulted in hung 
clients.

➤ Microsoft hotfix available for ISIS 5500 | 5000 systems. The v4.6.1 Autorun installer contains 
Microsoft hotfix KB2685007, which corrects an issue with ISIS 5500 | 5000 systems running 
Windows Storage Server R2. For details about the hotfix, see the following URL: 
http://support.microsoft.com/kb/2685007/EN-US.

➤ During board replacement, an ISB incorrectly advertised itself as an i500. Now the ISB displays 
a generic type until the metadata has been read and the actual ISB type is known to the system.

➤ Could not access all data on an ISIS 7500 | 7000 with one failed drive. In v4.6.1 and later, if the 
Storage Manager is bound, it is allowed to run with only the one good drive (in the active but 
disk failed state) so that data can be retrieved from it.

➤ Upgrading a half-populated ISIS 2000 fails to complete the file system metadata conversion. 
This occurs when upgrading from v4.2 to v4.5 or v4.6.

➤ ISIS client hang introduced in ISIS v4.6. The hang occurred on both Mac and Windows clients 
while doing consolidates, transcodes, and playback, especially variable speed playback. In v4.6, 
to clear the error you had to reboot the system. This issue has been fixed.
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➤ Could not perform Send-To-Playback operation on a sequence containing media being ingested. 
Job was static for several minutes then failed with “Transfer Cancelled” error message. This 
issue was found in v4.6 and fixed in v4.6.1.

New in Avid ISIS v4.6

The ISIS v4.6 software kit includes updates for the ISIS 7500 | 7000, ISIS 5500 | 5000, and ISIS 
2000 System Directors, Engines, and clients. Once you update your infrastructure to ISIS v4.6, 
you cannot revert the infrastructure back to a previous release. Avid ISIS v4.6 Client Manager 
software is supported in the following infrastructures:

• ISIS 7500 | 7000 v4.0.1, v4.0.3, v4.0.4, v4.5 and v4.6

• ISIS 5500 | 5000 v4.0.1, v4.0.3, and v4.5, and v4.6

• ISIS 2000 v4.1, v4.2, v4.5 and v6

The following is a list of what’s new in the Avid ISIS v4.6 release.

• This release supports the ISIS 7500 128TB Engine.

• Avid has added support for Windows v8.1 and Mac OSX v10.9.x

n If you are running Windows v8.1, a new driver is required for configurations running with an 
Intel 1Gb Network adapter. This driver v18.6 is included in the ISIS Installation Kit: 
\Drivers\ISIS Client. Note: Currently, the v18.6 driver has only been qualified with Windows 
v8.1.

• The Login Dialog. The login dialog has changed to eliminate the need to manually type in 
the protocol and port. The application will automatically figure out the connection settings 
based on the host name and type of application.

• Storage Manager Log Viewer: The Storage Manager Log Viewer is now incorporated into 
the ISIS Toolbox application. It is no longer a standalone application. As part of the 
Toolbox, you no longer have to log in to every single blade to view the log. All the logs for 
the blades within the ISIS system can be managed from this one location.
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Software Installation Instructions

Avid ISIS 7500 | 7000 v4.6, ISIS 5500 | 5000 v4.6, and ISIS 2000 v4.6 infrastructure software 
requires Avid ISIS v4.6 and later Client Manager software. The following is a summarized 
version of the procedure. The Avid ISIS Setup Guide contains complete instructions for loading 
the software onto the system. You can access the documentation in the top-level 
AvidISISDocumentation folder on the Avid ISIS software installer kit. 

• ISIS 7500 | 7000 Software Installation on New Systems

• ISIS 7500 | 7000 Upgrades

• Avid ISIS 5500 | 5000 Software Installation

• Avid ISIS 2000 Software Installation

• Avid ISIS Client Software Installation

The clients are defined as follows:

• Avid editing applications (see “Avid ISIS Client Software Installation” on page 32)

• Interplay Assist and Instinct

• Interplay Access

• Avid Approved Applications Initiative such as Pro Tools and Final Cut Pro

The infrastructure is defined as follows:

• ISIS 7500 | 7000 System Directors — System Director software and upgrade Storage Blades 
(ISBs) and Switch Blades (ISS/IXSs) in the Avid ISIS Engines to the latest firmware

• ISIS 5500 | 5000 Engines — System Director and additional Engines

• ISIS 2000 System Directors — System Director software and upgrade Storage Managers in 
the Avid ISIS Engines to the latest code

• Interplay servers — Interplay Engine, Interplay Media Indexer, Interplay Transfer, and 
CaptureManager

• Capture devices — AirSpeed 5000, AirSpeed Multi Stream, and AirSpeed

Avid ISIS 7500 | 7000 Software Installation

To upgrade to this release, run the Autorun.exe installer to install Avid ISIS 7500 | 7000 software 
on the System Director and Upgrade Storage Blades (ISBs) and Switch Blades (ISS/IXSs) in the 
Avid engines. The Avid ISIS clients must be running ISIS v4.x. 
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n When installing the Avid ISIS 7500 | 7000 software, you no longer need to open the Windows 
Control Panel on the System Director to uninstall the earlier version of the Avid ISIS System 
Director software. All of the previous Avid ISIS software is automatically uninstalled when 
installing a newer version. 

Component Requirements From Previous ISIS 7500 | 7000 Releases

The following is a list of items outside the ISIS software that you might need to update 
depending on the current version of your ISIS software. If you are on a version prior to 4.0, Avid 
recommends that you update your System Director Storage Blades (ISBs) and switches (ISS's 
and IXS's) to v4.2.x prior to updating to v4.6. If you are setting up a new ISIS system or updating 
an ISIS environment that is already at v4.0, continue with ISIS 7500 | 7000 Upgrades.

• If updating from ISIS v2.4 – v4.0 — update the ISIS 7000 System Director software before 
Installing this release of ISIS 7000 software. See Avid ISIS v4.0 ReadMe.

n Remember to copy your metadata to the new v4.x location; see ISIS 7500 | 7000 Upgrades.

• If updating from ISIS v2.0 – v2.0.6 to v2.4 — update the System Director Intel system BIOS 
on the 64-bit System Director (SR2500). See Avid ISIS v2.2.2 ReadMe.

• If updating from ISIS v2.0 – v2.0.6 to v2.4 — update the Intel RAID controller driver and 
registry key on the 64-bit System Director. See Avid ISIS v2.2.2 ReadMe.

• If updating from ISIS v2.0 – v2.0.3 to v2.4 — update the System Director to allow Windows 
Updates,. See Avid ISIS v2.2.2 ReadMe.

• If updating from ISIS v2.0 – v2.0.1 to v2.4 — update the System Director application key 
(dongle). See Avid ISIS v2.2.2 ReadMe.

• If updating from ISIS v1.4 – v2.0.1 to v2.4 — you must first upgrade to Avid ISIS v2.1.1 
before upgrading to v2.4, For instructions. See Avid ISIS v2.1.1 ReadMe.

ISIS 7500 | 7000 Software Installation on New Systems

Avid ISIS Systems ship with one blank 8GB USB Drive that is intended to be used for storing 
the ISIS Software Kit. Download the ISIS software kit from the download center 
(www.avid.com/US/support/downloads) to your System Director using the software USB flash 
drive included with your Avid ISIS. 

The Avid ISIS 7500 | 7000 Setup Guide contains complete instructions for loading the software 
onto the system. You can access the documentation in the top-level AvidISISDocumentation 
folder on the Avid ISIS software installer kit. The following is a summarized version of the 
procedure. 

http://www.avid.com/US/support/downloads
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n In the past Avid has instructed you stop the Standby System director, upgrade the Standby, and 
restart the Standby. Once the Standby was running you were instructed to update the Active 
System Director. 

Avid has revised the upgrade process to stop the Standby System Director and upgrade the Active 
System Director first, then upgrade the Standby System Director. This process avoids replicating 
metadata between ISIS software versions.

To install your ISIS 7500 | 7000 software on new systems:

1. Log in to the Avid ISIS 7500 | 7000 System Director as Administrator (default password: 
is-admin). 

2. Make a folder for the software kit on your root directory (C:\) of your Active System 
Director.

3. Insert the software USB flash drive into any USB port on your Active System Director.

n You can run the software installer from the USB flash drive. The advantage of copying the 
software kit to the Avid ISIS 7500 | 7000 is that you have easy access to kit files if you need them 
later.

If the USB flash drive does not automatically display:

a. Double-click the computer icon on the desktop. 

b. Double-click the USB flash drive icon in the window and copy the software kit into the 
new folder you created on the Avid ISIS 7500 | 7000 system. 

4. Double-click the Autorun.exe file in the root directory of software kit.

The installer detects the existing version of the installed software (if any) and displays the 
components that need to be upgraded in the splash screen. 

n If the Package Selection menu does not allow you to select the software, click Quit and run 
Autorun.exe again.

5. Select ISIS 7500 | 7000 System Director from the “Select Software Package” menu. 

The File Gateway selection is used when loading the Avid File Gateway server. The File 
Gateway software cannot be installed on the same server as the System Director software.

6. Click Apply.

7. Follow the screen prompts accepting the defaults and License agreement.

8. Once the installation is complete, click Finish.

9. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > Avid 
License Control and activate your Avid ISIS license. For detailed license activation 
instructions, see the Avid ISIS 7500 | 7000 Setup Guide. 
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You will need the System ID and Activation ID card included with your new System 
Director.

10. Run the Product Recovery tool to create a Product Recovery USB flash drive. 

n For information on creating the Product Recovery USB flash drive, see the Avid ISIS 7500 | 
7000 Setup Guide, Avid ISIS 2000 Setup Guide or Avid ISIS 5500 | 5000 Setup Guide. To open 
and use the ISIS Control Panel and Management Console see the Avid ISIS Administration 
Guide.

11. Open the ISIS Control Panel. 

a. Click Stop System Director.

b. Click Configure File System.

c. Select Create Active File System and click OK.

12. Open the Management Console. 

Log in using the Administrator user name and leave the password field blank.

a. Load the ISBs and ISS/IXSs firmware. Using the ISIS Management Console > Engines 
page, select all the Engines and click Upgrade Blades and then select all your ISS/IXSs 
and click Upgrade Switches. ISB and ISS/IXS upgrades can run at the same time. For 
more information, see the Avid ISIS 7000 Setup Guide.

You can watch the upgrade progress in your Monitoring tool.

b. Bind the ISBs. Using the ISIS Management Console > Storage Managers page, select 
your ISIS Storage Mangers in the list and click Bind.

c. Create a Storage Group, Workspaces, and add Users in the Management Console.

13. Install your Avid ISIS client software. For information, see Avid ISIS Client Software 
Installation or the Avid ISIS Client Guide.

ISIS 7500 | 7000 Upgrades

The following process summarizes the upgrade process to v4.6. Avid ISIS 7500 | 7000 v4.6 
infrastructure software requires Avid ISIS v4.6 or later Client Manager software. 

n If you have a 32-bit System Director, you must upgrade to a 64-bit System Director before 
loading your new ISIS v4.x software. 

n If you are upgrading from a version earlier than Avid ISIS v4.0, you must first perform the 
updates documented in “Component Requirements From Previous ISIS 7500 | 7000 Releases” 
on page 14 before upgrading to v4.6 and later.
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Review the following general comments on upgrading System Directors and the ISIS file system 
metadata: 

• The preferred method of upgrading the file system metadata is using Partition0 and 
Partition1. These are copies of the in-memory file system and the most accurate accounting 
of the ISIS. 

• The PartitionDump.bin file is a very different representation of what Avid believes to be the 
important parts of the file system that should persist. Do not be tempted to just import 
PartitionDump.bin, although this may be necessary if problems are seen with loading both 
Partition0 and Partition1. Since only the active System Director writes out 
PartitionDump.bin any PartitionDump.bin on the standby is out of date. Never use the 
PartitionDump.bin from the standby System Director in an upgrade.

• Sometimes one of the Partition files fails to load but the other succeeds. This is considered a 
successful upgrade and is still the preferred method of upgrading.

• There have been cases of loading old PartitionDump.bin files and losing data. Always 
contact your support team before attempting to import PartitionDump.bin.

• There is a bug in ISIS versions 3.1 through 4.5 where the tie breakers are deleted when 
importing PartitionDump.bin. When importing PartitionDump.bin it is important to 
manually record the tie breakers before beginning the upgrade and restore them after the 
upgrade completes.

Depending on what version you are upgrading from or to there are different steps required. This 
guide contains common setup and finishing steps but different intermediate steps based on the 
upgrade. Read through once and identify your upgrade before beginning.

Common Setup Steps

1. Download the ISIS v4.6 software kit from the Avid Download Center 
(www.avid.com/US/support/downloads) to your System Director.

2. Create a new “test” workspace in a storage group. (You will use this later to verify that the 
upgrade completed successfully.)

3. Log into Administrator account on the Standby System Director and open the System 
Director Control Panel. Wait for the indication that metadata changes have been received 
and saved. Allow this to happen twice. Stop the Standby System Director using the System 
Director Control Panel.

4. Log into active System Director and do the following:

a. Open the System Director Log Viewer.

b. Stop the System Director using the System Director Control Panel.

c If there are any errors, stop and contact your support team.

http://www.avid.com/US/support/downloads


Software Installation Instructions

18

5. Check the modify date time of the files Partition0, Partition1 and PartitionDump.bin. The 
Date Modified times should be identical or up to a maximum of one minute different. If the 
times differ by more than a minute, stop and contact your support team. These times 
should also be very close to the current date and time. If they are more than a few minutes 
old, stop and contact your support team.

To upgrade from v2.4 to v4.2.1 on the same hardware:

1. Follow the steps in “Common Setup Steps” on page 17.

2. Load the ISIS v4.x software kit on the Active System Director.

3. Double-click Autorun.exe.

n If the Package Selection menu does not allow you to select the software, click Quit and run 
Autorun.exe again.

4. When the installation completes, open the System Director Control Panel and stop the 
System Director.

5. Copy (not move) the following files from the v2.x folder to the v4.x folder:

Partition0 and Partition1

Old v2.x metadata location 
D:\Program Files\Avid Technology\AvidUnityISISSystemDirectorx64

New v4.x metadata location 
D:\Program Files\Avid\ISIS System Director

6. Open the System Director Log viewer.

7. In the System Director Control Panel select “Start System Director.” If there are problems 
with the upgrade of the Partition file, stop and contact your support team.

8. When the reconfigure completes the active System Director will be up and running. Proceed 
to “Completing the Upgrade” on page 20.

To upgrade from 2.4 to v4.X and from an SR2400/SR2500 to an AS3000:

1. Determine if you are moving from a 32-bit System Director:

In this upgrade you must move the file system metadata files from the SR2400 or SR2500 to 
the AS3000, using either a network folder or memory stick. In v4.0, the folder where the 
System Director software resides was changed. You must copy the Partition files manually, 
which requires knowing whether the System Director is 32 bit or 64 bit. All SR2400 System 
Directors are 32 bit. Some SR2500 System Directors were configured as 32 bit; check yours 
to make sure. The following are the folder names and where they are located:

- From v2.X metadata location for a 32 bit System Director

- D:\Program Files\Avid Technology\AvidUnityISISSystemDirector



Software Installation Instructions

19

- From v2.X metadata location for a 64 bit System Director

- D:\Program Files\Avid Technology\AvidUnityISISSystemDirector64Bit

- To v4.X metadata location

- D:\Program Files\Avid\ISIS System Director (This folder is created on installation 
of the 4.x kit)

2. Follow the steps in “Common Setup Steps” on page 17.

3. Copy the following files from the v2.x folder to the network folder or memory stick.

a. Partition0 

b. Partition1

c. PartitionDump.bin

4. Load the ISIS v4.x software kit on the new AS3000 Active System Director.

a. Double click the Autorun.exe.

5. Once the install completes open the System Director Control Panel and stop the System 
Director.

6. Copy the following files from the network folder or memory stick to the v4.x folder:

a. Partition0 

b. Partition1

7. Open the System Director Log viewer.

8. In the System Director, from the System Director Control Panel select Start System Director. 
If there are problems with the upgrade of the Partition file, stop and contact your 
support team.

9. Since the memory footprint for the System Director in v 4.6 is larger than before, on the 
AS3000 the System Director Control Panel shows a status of either “Reconfiguration 
possible” or “Reconfiguration required.” To reconfigure use the following steps:

a. Stop the System Director.

b. Select Configure File System.

c. In the File System Configuration dialog select Reconfigure File System. If there are 
problems with the upgrade of the Partition file, stop and contact your support team.

10. After the reconfigure completes the active System Director will be up and running. Proceed 
to “Completing the Upgrade” on page 20.
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To upgrade from a 4.x to a newer v4.X:

1. Create a new folder on the D: drive and copy the following files to the new folder prior to 
installing the v4.x kit:

a. Partition0 

b. Partition1

c. PartitionDump.bin (PartitionDump.bin is for use in case the normal Partition files fail to 
load)

2. Load the ISIS v4.x software kit on the Active System Director.

a. Double-click Autorun.exe.

3. After the kit install completes, open the System Director Log Viewer. If there are problems 
upgrading the metadata, stop and contact your support team.

Completing the Upgrade

1. After the new Active System Director has started, log into the management console and 
make sure the “test” workspace exists on the Workspaces page. If it does not, stop the 
System Director and contact your support team.

2. Upgrade the Standby System Director. Make sure that there are no Partition files in the v4.x 
directory. If you are upgrading on the same system, move these files to a temporary folder 
and do the following:

a. Load the ISIS v4.x software kit on Standby System Director.

b. Double-click Autorun.exe in the software kit.

c. Open the System Director Log Viewer.

d. Open the System Director Control Panel and stop the System Director.

e. Select Configure File System.

f. In the File System Configuration dialog select Create Standby System Director. If there 
are problems creating the new Standby, contact your support team.

g. Once the new Standby System Director starts it will receive a complete copy of the 
metadata from the Active Director.

3. The first replication between the active and standby System Directors copies the entire heap 
over and can take several minutes. The active System Director Log Viewer might display the 
message: “Remote meta data save did not complete.” This is normal and does not indicate a 
problem with the upgrade. The System Director Control Panel on each system will indicate 
that the replication is in progress.

4. After the initial replication between the System Directors is complete you can close the 
System Director Log Viewer on both System Directors.
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Avid ISIS 5500 | 5000 Software Installation

Avid ISIS Systems ship with one blank 8GB USB Drive that is intended to be used for storing 
the ISIS Software Kit. Download the ISIS software kit from the download center 
(www.avid.com/US/support/downloads) to your System Director using the software USB flash 
drive included with your Avid ISIS. 

n When you initially install the Avid ISIS software, the RAID set is initialized automatically. With 
no client traffic on the system, this will take approximately 27 hours for the ISIS 5500-32 and 14 
hours for the ISIS 5500-16. During this initialization, the system is functional and able to 
support a limited amount of client traffic. An Avid ISIS Engine during initialization should be 
able to support full bandwidth to one client. This allows sufficient bandwidth to test the system 
before the initialization is complete by working with one client at a time. During initialization, 
keep client bandwidth to a minimum. Failure to do so can significantly increase the initialization 
time. 

The following sections include general instructions for new installations and upgrades. Avid 
ISIS 5500 | 5000 v4.6 infrastructure software requires Avid ISIS v4.6 Client Manager software.

c Do not download and run the AvidISISStorageManager64.msi file shown in the 
Management Console Installer window to upgrade your Engines. Important configuration 
files are not included in the .msi file. The complete installation is only available in the ISIS 
installer splash screen.

To install your Avid ISIS 5500 | 5000 software on new systems:

1. Load the new software kit (new version) on the System Director from the USB flash drive.

2. Double-click the Autorun.exe file in the software kit.

n If the Package Selection menu does not allow you to select the software, click Quit and run the 
Autorun.exe again.

3. Select the appropriate installer from the Software Package menu (Engine/System Director or 
Engine only) for the enclosure you are installing on.

4. Click Apply.

n The installer automatically stops the System Director and Storage Manager services and 
uninstalls the earlier version of software.

n Direct Connect configurations need at least one client connected before the Storage Manager 
recognizes a valid configuration. With no clients connected, the status is invalid and displays 
“Not Connected.” When you connect an operational client, all disk offline errors are cleared.

5. On new installations a Network Configuration Tool appears asking you to provide the IP 
Address of the Ethernet connections.

http://www.avid.com/US/support/downloads
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n The Network Configuration Tool displays the supported 1 Gb ports or the 10 Gb port if it is 
being used.

c You must use the Network Configuration Tool in the ISIS Launch Pad to set the Ethernet 
ports on the System Director. This tool sets the IP addresses in the registry. Manually 
setting the IP addresses on the System Director without using the Network Configuration 
Tool is not supported. You can set the Gateways for each network connection using 
Windows (outside of the Network Configuration Tool), but only in a routed environment.

6. Once the software is installed, the System Director service starts up. Verify this in the 
System Director Control Panel.

7. Open the Avid License Control tool (click Start > Programs > Avid > Utilities > Avid 
License Control) and activate your Avid ISIS license. For detailed license activation 
instructions, see the Avid ISIS 5500 Setup Guide. 

Locate the System ID and Activation ID card included with your new System Director.

8. Repeat step 1 through 7 if installing software on additional Engines. Do not install the 
System Director software on the additional Engines unless planning a System Director 
Resiliency configuration, in which case, repeat step 1 through 7 (selecting Create Standby 
System Director in the File System Configuration dialog box) if you are setting up a Standby 
System Director. For detailed information, see the Avid ISIS 5500 Setup Guide.

9. Exit the software installer screen and restart the Engine to make sure the new or updated 
network drivers and configuration are applied. 

10. (New installs) Run the Product Recovery tool to create a Product Recovery USB flash drive.

11. Click Control Panel from the ISIS Launch Pad.

a. Click Stop System Director.

b. Click Configure File System.

c. Select Create Active File System and click OK.

12. Click Management Console from the ISIS Launch Pad.

a. Log in using the Administrator user name and leave the password field blank.

b. Click the Storage Managers icon.

c. Select your ISIS Engines in the list and click Bind.

d. Create a Storage Group, Workspaces, and add Users in the Management Console.

13. (Option) If using a Force10 S25 switch, enable Flow Control on that switch. For instructions 
on turning on Flow Control in the Force10 S25 switch, see Turning on Flow Control in the 
Force10 S25 Switch.

14. Install your Avid ISIS client software. For information, see Avid ISIS Client Software 
Installation or the Avid ISIS Client Guide.
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ISIS 5500 | 5000 Upgrades

The following process summarizes the upgrade process to v4.6. For additional information, see 
the Avid ISIS 5500 | 5000 Setup Guide. Avid ISIS 5500 | 5000 v4.6 infrastructure software 
requires Avid ISIS v4.6 or later Client Manager software. 

n The minimum supported version for this upgrade is v4.0. If you are on a build earlier than v4.0, 
update to v4.0.1, 4.0.3, or 4.0.4 before proceeding.

To upgrade ISIS 5500 | 5000:

1. Download the ISIS v4.6 software kit from the Avid Download Center 
(www.avid.com/US/support/downloads) to your System Director.

2. When running a System Director Resiliency configuration, stop the Standby System 
Director using the ISIS Control Panel and upgrade the Active System Director first. 

Update additional Engines after your Active and Standby System Directors are updated.

3. Stop the Active System Director using the ISIS Control Panel.

4. Make a copy of your current metadata files. The following are the file names and where they 
are located: 

Metadata location 
D:\Program Files\Avid\ISIS System Director

- Partition0

- Partition1

- PartitionDump.bin

5. Load the new software kit (new version) on the System Director (or Engine) from the USB 
flash drive. 

6. Double-click the Autorun.exe file in the software kit.

The installer detects the existing version of the installed software and displays the 
components that need to be upgraded in the splash screen. 

n If the Package Selection menu does not allow you to select the software, click Quit and run the 
Autorun.exe again.

7. Click Apply.

n The installer automatically stops the System Director and Storage Manager services and 
uninstalls the earlier version of software.

http://www.avid.com/US/support/downloads
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n Direct Connect configurations need at least one client connected before the Storage Manager 
recognizes a valid configuration. With no clients connected, the status is invalid and displays 
“Not Connected.” As soon as you connect an operational client, all disk offline errors are 
cleared.

8. Follow the screen prompts accepting the defaults and License agreement.

9. Once the installation is complete, click Finish.

10. (If applicable) Update your Standby System Director and other Engines repeating steps 1 
through 9. Load the new software kit (new version) on the System Director (or Engine) from 
the USB flash drive. to Once the installation is complete, click Finish.

11. (ISIS v3.0 or v3.1 update) If you are upgrading from ISIS v3.0 or v3.1, check to see if you 
have any corrupted files, see “Running the Node Analysis Tool” on page 27. 

12. Install your Avid ISIS client software. For information, see Avid ISIS Client Software 
Installation or the Avid ISIS Client Guide.

Turning on Flow Control in the Force10 S25 Switch

The Avid default Force10 S25N and S25P (fiber) switch configurations do not have Flow 
Control turned on. Flow Control is needed to support ISIS 10 Gb clients, servers and Engines. 
Use the following procedure to turn on Flow Control in the Force10 switch. 

n Avid is turning rx and tx on in the Force10 S25 switch, but the Force10 S60 and S4810 switches 
have rx on with tx off in the Avid default configuration.

To turn on Flow Control:

1. Log into the switch using Telnet or HyperTerminal.

2. Type en.

3. At the password prompt, type avid.

4. Type conf.

5. Type Int range tengigabitethernet 0/25 - 28.

In addition, depending on your Force10 S25 switch module options, enter one or more one 
of the following commands:

t Left 10 Gb module installed (numbered right to left, facing rear) Int range 
tengigabitethernet 0/27 - 28.

t Right 10 Gb module installed (numbered right to left, facing rear) Int range 
tengigabitethernet 0/25 - 26.

t Right stacking module installed (numbered right to left, facing rear) Int range 
tengigabitethernet 1/25 - 26.
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6. Type flowcontrol rx on tx on threshold 1024 1024 1054.

n The following steps turn the port off and back on so the end node renegotiates. Make sure this 
isn't an interface from which you are gaining remote access because you will be disconnected.

7. Type shut.

8. Type no shut.

9. Type exit.

10. Type exit.

11. Type wr mem.

12. Type exit.

To confirm the setting change, look for the “Flowcontrol rx on tx on” entry:

1. Type en.

2. At the password prompt, type avid.

3. Type sho int tengigabitethernet 0/25 (port number depends on optional modules).
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Information similar to the following is displayed. Verify Flowcontrol rx on tx on 
(shown below in bold) is included in the configuration:

TenGigabitEthernet 0/25 is up, line protocol is up

Hardware is Force10Eth, address is 00:01:e8:d6:84:7b

    Current address is 00:01:e8:d6:84:7b

Pluggable media present, XFP type is 10GBASE-SR

    Medium is MultiRate, Wavelength is 850.00nm

    XFP receive power reading is -4.0994dBm

Interface index is 40436228

Internet address is not set

MTU 1554 bytes, IP MTU 1500 bytes

LineSpeed 10000 Mbit

Flowcontrol rx on tx on 

ARP type: ARPA, ARP Timeout 04:00:00

Last clearing of “show interface” counters 4w5d1h

Queueing strategy: fifo

Input Statistics:

     4372398864 packets, 5575634120385 bytes

     645279553 64-byte pkts, 15320069 over 64-byte pkts, 30588757 over 
127-byte pkts

     7206136 over 255-byte pkts, 59117205 over 511-byte pkts, 3614887144 
over 10 23-byte pkts

     693485 Multicasts, 34501 Broadcasts

     0 runts, 0 giants, 682022 throttles

     0 CRC, 0 overrun, 0 discarded

Output Statistics:

     8393098546 packets, 12349453356270 bytes, 0 underruns

     155227351 64-byte pkts, 26414194 over 64-byte pkts, 54970467 over 
127-byte pkts

     47132113 over 255-byte pkts, 8010284 over 511-byte pkts, 8101344137 
over 10 23-byte pkts

     151510 Multicasts, 283941 Broadcasts, 8392663095 Unicasts

     0 throttles, 0 discarded, 0 collisions

Rate info (interval 299 seconds):
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     Input 00.00 Mbits/sec,          0 packets/sec, 0.00% of line-rate

     Output 00.00 Mbits/sec,          1 packets/sec, 0.00% of line-rate

Running the Node Analysis Tool

If you are upgrading your Avid ISIS 5000 from v3.0 or v3.1, Avid recommends that you run the 
Node Analysis Tool immediately after upgrading to ISIS v3.2 or later. This tool analyzes the data 
drives for a spot on your drive that could have corrupted data when written to, using v3.0 or v3.1. 
This tool only needs to be run once. Whether or not files are identified, this issue does not exist 
when new data is written using ISIS v3.2 or later releases. 

n This tool should be run immediately after upgrading from ISIS 5000 v3.0 or v3.1. If it is not, 
there is potential that some files returned by the NodeAnalysisTool as “suspect” may not have 
anything wrong with them. The NodeAnalysisTool returns a list of files located at the known bad 
locations, regardless of what version of ISIS was in place when the file was created. If a file was 
created after ISIS v3.2 was installed and it was written to the known bad location, it would still 
be reported by the NodeAnalysisTool. Only files located in the known bad location that were 
created prior to ISIS v3.2 would be corrupted. 

The extent of corrupted data is up to three files per Engine. If the corrupted file is a DNx220 
video clip, the corrupted data is equivalent to about a single frame. You could play the video up 
to and after the corrupted frame without issue. 

To run the Node Analysis Tool:

1. Copy the NodeAnalysisTool.exe file to any Avid ISIS Window client. 

The Node Analysis Tool can be found on the Avid ISIS 5000 software kit in the 
\AvidISISUtilities\ folder.

2. Double-click the NodeAnalysisTool.exe file.

A Command window opens.

3. When prompted for the “ISIS name,” type in the virtual name of your ISIS 5000 System 
Director and press Enter. 

The default name is AvidISIS.

4. When prompted for the “Admin password,” type in the Administrator password used to log 
into your ISIS 5000 Management Console and press Enter. 

The default password is blank (no password).

The tool runs and displays the following possible results:

- Wrong ISIS Name specified

asStatus = “AS_UNKNOWN_SYSTEM_ID” (42)

- Bad Password specified
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asStatus = “AS_ACCESS_DENIED” (50)

- Unable to reach one or more Storage Managers in the system

asStatus = “AS_TIMEOUT” (65)

- No nodes found

asStatus = “AS_NO_MORE_ITEMS” (21)

Found 0 corrupt nodes on ISIS AvidISIS

n If messages appear similar to the following, you have a corrupted data block that could affect 
one of your saved files. Make a note of the file name. 

- If nodes are found, each Engine could have 3 messages, for example:

//AvidISIS/workspace1/temp/FSR_full_02740

//AvidISIS/workspace1/temp/FSR_full_02739

//AvidISIS/workspace1/temp/FSR_full_02741

//AvidISIS/workspace2/temp/FSR_full_02537

//AvidISIS/workspace2/temp/FSR_full_02612

//AvidISIS/workspace2/temp/FSR_full_02554

Found 6 corrupt nodes on ISIS AvidISIS

n These would only be corrupt if they were written prior to ISIS v3.2.

5. Press Enter to quit the tool.

Updating the 10 Gb Myricom Board Driver on Engines

The Avid ISIS v4.6 software release includes a driver update for the 10 Gb Myricom Ethernet 
adapter board installed in all Engines. The Myricom 10 Gb adapter board driver and settings are 
configured for you when you install the Avid ISIS software on the System Director and Engines. 
For more information see the Avid ISIS Setup Guide.

n If you have made a change to the Myricom settings and want to set them back to the Avid 
defaults, re-run the ISIS software installer (autorun.exe) and the Avid network settings are 
re-applied. If the network setting are not set to the Avid defaults, a message is displayed in the 
ISIS Management Console.
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Avid ISIS 2000 Software Installation

Avid ISIS Systems ship with one blank 8GB USB Drive that is intended to be used for storing 
the ISIS Software Kit. Download the ISIS software kit from the download center 
(www.avid.com/US/support/downloads) to the USB flash drive included with your Avid ISIS. 

The Avid ISIS 2000 Setup Guide contains complete instructions for loading the software onto the 
system. You can access the documentation in the top-level AvidISISDocumentation folder on the 
Avid ISIS software installer kit. The following is a summarized version of the procedure. 

To install your ISIS 2000 software on new systems:

1. Log in to the Avid ISIS 2000 System Director as Administrator (default password: 
is-admin). 

2. Make a folder for the software kit on your root directory (C:\) of your System Director.

3. Insert the software USB flash drive into any of USB ports on your System Director.

n You can run the software installer from the USB flash drive. The advantage of copying the 
software kit to the Avid ISIS 2000 is that you have easy access to kit files if you should ever them 
in the future.

If the USB flash drive does not automatically display:

a. Double-click the computer icon on the desktop. 

b. Double-click the USB flash drive icon in the window and copy the software kit into the 
new folder you created on the Avid ISIS 2000 system. 

4. Double-click the Autorun.exe file in the root directory of software kit.

The installer detects the existing version of the installed software (if any) and displays the 
components that need to be upgraded in the splash screen. 

n If the Package Selection menu does not allow you to select the software, click Quit and run the 
Autorun.exe again.

5. Select ISIS 2000 System Director from the “Select Software Package” menu. 

6. Click Apply.

7. Follow the screen prompts accepting the defaults and License agreement.

n When uninstalling or upgrading the ISIS 2000 software, you might get prompted to confirm the 
removal of the File Gateway software. Type Y to confirm the removal.

8. Once the installation is complete, click Finish.

9. After the ISIS 2000 software is installed, you must restart the System Director.

http://www.avid.com/US/support/downloads
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10. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > Avid 
License Control and activate your Avid ISIS license. For detailed license activation 
instructions, see the Avid ISIS 2000 Setup Guide. 

You will need the System ID and Activation ID card included with your new System 
Director.

11. Open the ISIS Control Panel. 

n To open and use the ISIS Control Panel and Management Console see the Avid ISIS 
Administration Guide.

12. Click Stop System Director.

13. Click Configure File System.

14. Open the Management Console. 

Log in using the Administrator user name and the default password is blank.

15. Select Create Active File System and click OK.

16. Load the drive firmware. Using the ISIS Management Console > Storage Manager page, 
select all the Storage Managers and click Upgrade. For more information, see the Avid 
ISIS 2000 Setup Guide.

17. Bind the Storage Managers. Using the ISIS Management Console > Storage Manager page, 
select your ISIS Storage Managers in the list and click Bind.

n When setting up the System Director to the switch, you must use a static IP address. The 
ISIS 2000 System Director will not bind the Storage Manager if using DHCP.

18. Create a Storage Group, Workspaces, and add Users in the Management Console.

19. Install your Avid ISIS client software. For information, see Avid ISIS Client Software 
Installation or the Avid ISIS Client Guide.

ISIS 2000 Upgrades

The following process summarizes the upgrade process to v4.6. For additional information, see 
the Avid ISIS 2000 Setup Guide. Avid ISIS 2000 v4.6 infrastructure software requires Avid ISIS 
v4.6 or later Client Manager software. 

To upgrade ISIS 2000 v4.2 and earlier to v4.6:

1. Download the ISIS software kit from the Avid Download Center 
(www.avid.com/US/support/downloads) to your System Director.

2. (If applicable) Log into Administrator account on the Standby System Director and Stop the 
Standby System Director using the ISIS Control Panel. 

http://www.avid.com/US/support/downloads
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3. Make a copy of your current metadata files. The following are the file names and where they 
are located: 

Metadata location 
D:\Program Files\Avid\ISIS System Director

- Partition0

- Partition1

- PartitionDump.bin

4. Load the ISIS software kit on the System Director. 

5. Double-click the Autorun.exe file in the software kit.

The installer detects the existing version of the installed software (if any) and displays the 
components that need to be upgraded in the splash screen. 

n If the Package Selection menu does not allow you to select the software, click Quit and run the 
Autorun.exe again.

6. If not already selected, select ISIS 2000 System Director from the “Select Software 
Package” menu. 

7. Click Apply.

8. Follow the screen prompts accepting the defaults and License agreement.

n When uninstalling or upgrading the ISIS 2000 software, you might get prompted to confirm the 
removal of the File Gateway software. Type Y to confirm the removal and continue with the 
upgrade.

9. Once the installation is complete, click Finish.

You are prompted now to restart the System Director. After the System Director has 
restarted, continue with the next step.

10. Upgrade your Storage Manager, using the ISIS Management Console > Storage Managers. 
Select the original Storage Manager (typically labeled SM000) and click Upgrade. 

The Upgrade Storage Managers window opens.

11. Select the .zip file for the new release, and click Upgrade.

If you have an ISIS 2000-120 configuration your upgrade is finished. Continue with this 
procedure if you have an ISIS 2000-240 configuration.

12. (ISIS 2000-240) Select the Storage Manager from the list and click Details.

The Status for the upgrade is shown in the Details pane at the right of the window. Click the 
Refresh button whenever you want the updated Status. When the Status displays “Data 
Conversion Mode,” continue with the next step.
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13. (ISIS 2000-240) Double-click the IP address of the original Storage Manager in the Details 
pane to open ISIS 2000 Storage Manager Agent Web page. 

14. (ISIS 2000-240) You are asked for the password. Type se-admin.

The ISIS 2000 Storage Manager Agent page appears.

15. (ISIS 2000-240) Click Network in the left pane of the System tab. 

16. (ISIS 2000-240) Enter an IP address in the gx0:1 and Netmask text boxes in the Data 
Interfaces section. 

Starting with the ISIS v4.5 release, the Engine Controller in the ISIS 2000 Engine requires 
dual IP addresses for ISIS 2000-240 systems. This new IP Address must be in the same 
subnet as the original IP address. Consult your network administrator to obtain an unused IP 
address.

n A second physical cable is not needed, both IP address are handled through the existing 10 Gb 
connection between Engine Controller and the switch. 

17. (ISIS 2000-240) Click Submit.

a. A dialog box appears warning you a Engine reboot is required; click the Reboot button.

b. A second dialog box appears, type se-admin. in the password box and click Reboot. 

18. (ISIS 2000-240) When the Engine has restarted, open the Storage Manager page in the 
Management Console.

n When you upgrade from v4.2 and earlier to v4.5 and later, you will notice there are now two 
Storage Managers in the Storage Managers page displaying half the capacity that was previous 
listed and the Status column displays “Data Conversion Mode.” This is a normal one-time 
behavior when you upgrade from v4.2 and earlier to v4.5 and later.

c Do not add any new ISIS 2000 Engines to this existing Storage Group until the ISIS v4.6 
upgrade data conversion redistribution has completed.

19. Install your Avid ISIS client software. For information, see Avid ISIS Client Software 
Installation or the Avid ISIS Client Guide.

Avid ISIS Client Software Installation

This section contains information about installing or upgrading the client software on your 
system. A user account with Administrator privileges is required to install Avid ISIS client 
software on your workstations.
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The Avid ISIS Client Guide contains complete instructions for loading the client software onto 
the system. You can access the documentation in the top-level AvidISISDocumentation folder on 
the Avid ISIS software installer kit. The following is a summarized version for installing the 
client software. 

The clients are defined as follows:

• Avid editing applications (see “Hardware and Software Requirements” on page 35.)

• Interplay Assist and Instinct

• Interplay Access

• Avid Approved Applications Initiative such as Pro Tools

To install your Avid ISIS Windows client software from the software kit:

1. Log into your Windows client system as a user with Administrative privileges.

2. Load the new software kit on you Windows client system.

3. Double-click the Autorun.exe file in the software kit.

The installer detects the existing version of the installed client software (if any) and displays 
the components that need to be upgraded in the splash screen. 

n If the Package Selection menu does not allow you to select the software, click Quit and run the 
Autorun.exe again.

4. Select the “ISIS Windows Client” installer from the Select Software Package menu.

5. Click Apply.

n The installer automatically uninstalls an earlier version of software.

6. Update the Intel Pro driver on your client system, see Loading or Updating the Intel Pro 
Driver on Windows Clients.

7. Repeat this procedure on each Avid ISIS Windows client.

n You can manually copy the client installers to a USB flash drive. The installers are in the Avid 
ISIS software kit located on [drive]:\AvidISISClientInstallers. You can also log into the 
Management Console and access the Installers link and download the appropriate client 
installer.

To install your Avid ISIS Macintosh client software:

1. Copy and save the new AvidISISClient_MacOSX_x.x.x.dmg file from the:

t \AvidISISClientInstallers folder in software kit to your Macintosh client system.

t Management Console > Installer page to your Macintosh client system. 
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2. Double-click the AvidISISClient_MacOSX_x.x.x.dmg file. 

3. Double-click the AvidISISClient.mpkg file to run the installer.

Follow the on-screen instructions.

n The installer replaces earlier versions of the software (if any).

4. Repeat this procedure on each Avid ISIS Macintosh client.

n You can manually copy the client installers to a USB flash drive. 

c The Macintosh client software installs an uninstaller application located at Applications 
> Avid_Uninstallers > AvidISIS. Use this application only when you want all Avid 
client files removed; including Client Manager preferences.

To install ISIS Linux client software:

1. Copy and save the new AvidISISClient_el6.x86_x.x.x.bin file from the:

t \AvidISISClientInstallers folder in software kit to the user’s home directory of 
your Linux client system.

t Management Console > Installer page to the user's home directory of your Linux client 
system. 

2. Open the Terminal application: Application > System Tools > Terminal on your 
Linux client.

n When using the Terminal program, file names and paths are case sensitive.

3. Type cd [user’s home directory] and press Enter.

4. Do one of the following.

t If you are not the root user, type sudo ./AvidISISClient_el6.x86_x.x.x.bin and 
press Enter. Enter your password.

t If you are the root user, type ./AvidISISClient_el6.x86_x.x.x.bin and press 
Enter.

n The installer replaces earlier versions of the software (if any).

n You can manually copy the client installers to a USB flash drive. 

5. Restart the Linux client.
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Hardware and Software Requirements

To meet the stringent needs of media applications the ISIS family of storage solutions is built 
using patented intellectual property in ISIS software running on Avid ISIS hardware. Avid tests 
and qualifies configurations of Avid ISIS software deployed on Avid ISIS hardware. The ISIS 
System Director is designed to allow the binding of Avid ISIS storage only. Avid has not 
published its ISIS file system specifications, protocols, or ISIS file system API’s used among the 
components of the file system (ISIS System Director, ISIS client, ISIS storage expansion 
engines) and these are subject to change without notice. Therefore, any connection of third party 
storage as part of an ISIS file system is not a licensed, approved or supported configuration.

The following table provides a list of product clients and infrastructure component software 
versions needed to work with Avid ISIS.

n Most Windows editing clients require the 1-Gb Intel Pro 1000 Ethernet board to connect to the 
Avid ISIS system. Macintosh clients and some Windows clients have been qualified to use the 
on-board 1-Gb ports. For instructions on installing the board and software, see for Avid ISIS 
Client Guide. 

Avid ISIS v4.6 Qualified Clients

Software
ISIS 2000 
Workspaces

ISIS 5500 
Workspaces

ISIS 7000 
Mirrored 
Workspaces

ISIS 7000 RAID 
Workspacesa

Media Composer v5.5.x, v6.x, v6.5.x, 
v7.0.x

v5.5.x, v6.x, v6.5.x, 
v7.0.x

v5.5.x, v6.x, v6.5.x, 
v7.0.x

v5.5.x, v6.x, v6.5.x, 
v7.0.x

Media Composer 
10-Gb clientb

v5.5.x, v6.x, v6.5.x, 
v7.0.x

v5.5.x, v6.x, v6.5.x, 
v7.0.x

v5.5.x, v6.x, v6.5.x, 
v7.0.x

v5.5.x, v6.x, v6.5.x, 
v7.0.x

Avid Symphony v5.5.x, v6.x, v6.5.x, 
v7.0.x

v5.5.x, v6.x, v6.5.x, 
v7.0.x

v5.5.x, v6.x, v6.5.x, 
v7.0.x

v5.5.x, v6.x, v6.5.x, 
v7.0.x 

Avid Symphony 
10-Gb clientc

v5.5.x, v6.x, v6.5.x, 
v7.0.x

v5.5.x, v6.x, v6.5.x, 
v7.0.x

v5.5.x, v6.x, v6.5.x, 
v7.0.x

v5.5.x, v6.x, v6.5.x, 
v7.0.x

NewsCutter v9.5.x, v10.x, 
v10.5.x, v11.0.x

v9.5.x, v10.x, 
v10.5.x, v11.0.x

v9.5.x, v10.x, 
v10.5.x, v11.0.x

v9.5.x, v10.x, 
v10.5.x, v11.0.x

NewsCutter 
10-Gb clientc

v9.5.x, v10.x, 
v10.5.x, v11.0.x

v9.5.x, v10.x, 
v10.5.x, v11.0.x

v9.5.x, v10.x, 
v10.5.x, v11.0.x

v9.5.x, v10.x, 
v10.5.x, v11.0.x

Avid DS No real-time 
support (push/pull 
only)

v11.1 v11.1 Not supported
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Avid DS
10-Gb client

No real-time 
support (push/pull 
only)

v11.1 v11.1 Not supported

Avid Interplay 
Common Services 
(ICS)

v1.7 with 
v4.6 ISIS client

v1.7 with 
v4.6 ISIS client

v1.7 with 
v4.6 ISIS client

v1.7 with 
v4.6 ISIS client

Avid Interplay
with Assist

v2.6, v2.7 v2.6, v2.7 v2.6, v2.7 v2.6, v2.7

Avid Interplay 
Low-Res Encode

Not supported Not supported v2.6, v2.7 v2.6, v2.7

Avid Instinct v2.7, v3.0, v3.0.5 v2.7, v3.0, v3.0.5 v2.7, v3.0, v3.0.5 v2.7, v3.0, v3.0.5

AirSpeed 5000 v2.5.x, v2.6 v2.5.x, v2.6 v2.5.x, v2.6 v2.5.x, v2.6

AirSpeed Multi 
Stream

v1.8.12 v1.8.12 v1.8.12 v1.8.12

AirSpeed v2.7.12 v2.7.12 v2.7.12 v2.7.12

Pro Tools v10.x, v11.0 No 
real-time support 
(push/pull only)

v10.x, v11.0 
Real-time

v8.1.x, v9.0.x
No real-time 
support (push/pull 
only)

v10.x, v11.0 
Real-time

v8.1.x, v9.0.x
Windows — 
Real-time 
streaming

Macintosh — No 
real-time support 
(push/pull only)

v8.1.x, v9.0.x, v10.x, 
v11.0 
No real-time support 
(push/pull only)

a. ISIS 7000 RAID 6 Workspaces support only resolutions that draw 16 MB/s (50 Mb/s) or less. 
b. Ultra High Resolution Clients can mount RAID workspaces although, only resolutions that draw 16 MB/s 

(50 Mb/s) or less are supported. 

Avid ISIS v4.6 Qualified Clients (Continued)

Software
ISIS 2000 
Workspaces

ISIS 5500 
Workspaces

ISIS 7000 
Mirrored 
Workspaces

ISIS 7000 RAID 
Workspacesa
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Supported ISIS 7000 System Directors

The following System Director servers are supported in Avid ISIS 7000 v4.x:

• AS3000 (Window Storage Server 2008 or Window Storage Server 2008 R2)

• SR2500 (Window Storage Server 2003)

n Avid ISIS v2.4 was the last release with support for the Intel SR2400 System Directors. If you 
have SR2400 System Directors, plan for System Director replacements before upgrading to this 
release.

Supported ISIS Client Operating Systems

The following table list the operating systems and Avid client software that are supported in Avid 
ISIS v4.6.

Supported Software Client Operating Systems and Service Packs  

Operating System Version

Windows 8.1 No Service Pack

Windows 8 (64-bit) No Service Pack

Windows 7 (64-bit) Service Pack 1

Windows Vista (64-bit) Service Pack 2

Windows XP (32-bit) Service Pack 3

Windows Storage Server 2008 R2 (64-bit) Service Pack 2

Windows Storage Server 2008 (64-bit) Service Pack 2

Windows Storage Server 2003 (64-bit) Service Pack 2

Windows Server 2003 (64-bit) Service Pack 2

Mac OS X Mountain Lion (64-bit kernel) 10.8.x and 10.9.x

Mac OS X Mountain Lion (32-bit kernel) v10.8.x

Mac OS X Lion (64-bit kernel) v10.7.5

Mac OS X Lion (32-bit kernel) v10.7.x

Red Hat Enterprise Linux (64-bit kernel) v6.2
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The following table lists the 10 Gb Avid clients that are supported in Avid ISIS.

Supported Browsers in an ISIS Environment

The following are the browsers qualified in ISIS v4.6. These browsers were qualified with the 
client operating systems supported in the current release.

Supported Operating Systems with 10 Gigabit Ethernet Network Interface Cards  

10-Gb Ethernet Network Interface Card Supported Operating System

Myricom Windows XP 32-bit, Windows Vista 64-bit, 
Windows Storage Server 2008, Windows 7 64-bit, 
Windows 8 64-bit, and dual quad-core MacPro 
workstations running Mac OS v10.7.x (Lion) and 
Mac OS v10.8.x (Mountain Lion), and Linux 
Red Hat v6.2

Chelsio — Chelsio cards are only supported in the 
Interplay Copy/Move services in an ISIS 7000 
environment. 

n Editing clients with the 10-Gb Chelsio card 
are not supported in ISIS v4.5 and later.

Windows XP 32-bit, Windows Vista 64-bit, 
Windows Server 2003

Supported Client Browser per Operating System  

Browser Operating System 

Internet Explorer 9 and
Internet Explorer 10

Windows

Safari Macintosh

Mozilla Firefox Windows, Macintosh, and Linux

n If you plan to use the Firefox browser for FTP connections via the 
File Gateway, use the following format in your browser: 
username: virtual host name|ftpuser

Google Chrome Windows and Macintosh

n If you plan to use the Chrome browser for FTP connections via the 
File Gateway, use the following format in your browser:
ftp://ftpuser@virtual host name:password@ alias.domain.com
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Intel Ethernet Drivers

Intel Pro Ethernet adapter boards are recommended for most Windows based editing systems 
that connect to the Avid ISIS system.” The Intel Pro 1000 PT and Intel i350 T2 are a copper 
interface and the Intel Pro 1000 PF is an optical interface. The Intel driver qualified in this 
release is included in the Avid ISIS software installer kit (\Drivers\ISIS 
xxxx\Intel_Pro1000 folder). Check the driver version listed in the Windows Control Panel on 
your Windows clients and ISIS System Directors. If you are not running the Intel Pro v17.4 
driver (v18.6 is required for Windows 8.1), run the Intel_17.4_Winxxxx_xx.exe installer file. 

c Do not update the Intel drivers on Avid Interplay Engine cluster unless instructed to do so 
by the Interplay ReadMe or by Customer Support. Doing so could compromise the 
integrity of the cluster. 

Loading or Updating the Intel Pro Driver on Windows Clients

To load the Intel Pro driver on a Windows system:

1. Copy the file titled Intel_xx.x driver to your system; found on the Avid ISIS software kit in 
(clients) \Drivers\ISIS Client\Intel_Pro1000\ folder.

2. Double-click the .exe file to expand the compressed file and run the installer.

3. Accept the default settings to install the driver.

n The default Intel transmit and receive descriptors are set to 256 however, when loading the Avid 
ISIS client software the transmit and receive descriptors are set to 1024. For more information, 
see Avid ISIS Client Guide.

Intel Network Driver Per Operating System

Operating System Driver installer

Windows 8 (64-bit) Intel_17.4_Win2K8-8-7-Vista_64.exe

Windows 7 (64-bit) Intel_17.4_Win2K8-8-7-Vista_64.exe

Windows Vista (64-bit) Intel_17.4_Win2K8-8-7-Vista_64.exe

Windows XP (32-bit) Intel_17.4_Win2K3-XP_32.exe

Windows Storage Server 2008 R2 (64-bit) Intel_17.4_Win2K8-8-7-Vista_64.exe

Windows Storage Server 2008 (64-bit) Intel_17.4_Win2K8-8-7-Vista_64.exe

Windows Storage Server 2003 (64-bit) Intel_17.4_Win2K3-XP_64.exe

Windows Server 2003 (64-bit) Intel_17.4_Win2K3-XP_64.exe
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4. After the Intel driver is installed, restart the Windows system.

Intel Pro Driver on ISIS 5500 Engines

The Intel driver is automatically updated and configured on the ISIS 5500 System Director and 
Engines when you install the ISIS 5500 Software. 

HP Z820 Integrated Network Port Not Supported

The integrated 82759LM port is marked with the letters AMT in the HP Z820 Workstation is not 
supported as an ISIS client connection. The other integrated Ethernet port that is not labeled is 
qualified for an ISIS client a connection. To use a dual 1 Gb connection with the HP Z820 
Workstation, you must install an Intel Pro 1000 PT, Intel i350 T2 or Intel Pro 1000 PF for the 
second port.

HP Z400, HP Z420, and HP Z800 Integrated Network Port Not Supported

The integrated Gigabit Ethernet controller in the HP Z400, HP Z420, and HP Z800 Workstations 
are not supported as an ISIS client connection. The HP Z400, HP Z420, and HP Z800 require the 
installation of the Intel Pro 1000 PT, Intel i350 T2 or Intel Pro 1000 PF. 

HP Z200 and Z210 Integrated Network Port Is Supported

The integrated Intel 82578 Gigabit Ethernet controller in HP Z200 and Z210 Workstations are 
supported as an ISIS client connection. The Z200 Z210 were qualified for use with Avid Assist, 
Avid Instinct, and software-only Avid editing clients. The current Intel driver supported in this 
release is required. For specific details on Z200 and Z210 support on the Avid editing systems, 
see the Avid editor ReadMe and Avid Knowledge Base.

HP xw8600 ISIS Client Support

The Intel Pro 1000 board slot in HP xw8600 with has changed in ISIS v3.2. The previous slot for 
the Intel Pro 1000 was slot 6; the new slot requirement is slot 5. For details on the slot location, 
search the Avid Knowledge Base for the “Avid Configuration Guidelines and Slot 
Configurations” at www.avid.com/US/support. 

The Intel driver for the Intel Pro 1000 board in slot 5 also requires Intel driver v14.7. This is the 
same version as previously supported. Do not update the Intel Pro 1000 driver to v17.4 as 
required for all other supported Windows clients. The Intel driver qualified in this release is 
included in the Avid ISIS software installer kit (\Drivers\ISIS Client\Intel_Pro1000 
folder). 

http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=269631&Hilite=configuration
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Small Tree Optical Adapters for Macintosh Clients

Avid has also qualified the Small Tree PEG1F single port or PEG2F dual port optical adapters in 
the slot 2 of a Macintosh Pro Nehalem system (2.66 GHz or 2.93 GHz) to be used in the Force10 
S24P optical (fibre) switch.

Qualified and Approved ISIS Switches

The following tables provide a summary of what switches have been qualified or approved for 
use in the Avid Production Network (APN) of the indicated ISIS Shared Storage Environment. 
The tables also identifies the qualified external switches (EXS) for linking the Management 
Domains two stack ISIS 7000 configurations. For information on configuring the ISIS switches, 
see the Avid Network and Switch Setup Guide in the documentation folder of the Avid ISIS 
software kit [drive]:\AvidISISDocumentation. 

Qualified and approved switches are defined as follows:

• Qualified — tested with each major software release.

• Approved — tested once with no subsequent re-testing.

APN Switches Qualified for the ISIS Environment  

Switch ISIS 7000

ISIS 7000 
External 
Expansion 
Switches (EXS) ISIS 5500 ISIS 2000

Cisco Catalyst 4948E ✓ ✓

Cisco Catalyst 
4948-10GE

✓ ✓

Cisco Catalyst 4900M ✓ ✓ ✓ ✓

Force10 S25N and S25P ✓

Force10 S60 ✓ ✓

Force10 S4810 ✓ ✓ ✓

Foundry/Brocade 
FESX424 and FESX624 ✓ ✓
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Most Windows editing clients must use the 1 Gb Intel Pro 1000 PT, Intel i350 T2 or Intel Pro 
1000 PF Ethernet board to connect to all Avid ISIS system. Macintosh clients can use the built-in 
Ethernet port or Small Tree PEG1F or PEG2F optical adapters.

n All Force10 switches ship from Avid preconfigured for an Avid ISIS 5500 environment. You 
should upgrade your switch to the latest configuration file found in the ISIS software kit. For 
information on configuring the switches, see the Avid Network and Switch Setup Guide in the 
documentation folder of the Avid ISIS software kit [drive]:\AvidISISDocumentation. 

n When connecting 10 Gb clients on Force10 S25 switches, you must enable flow control TX and 
RX on the 10 Gb switch ports for the ISIS clients, servers, and Engines, see Turning on Flow 
Control in the Force10 S25 Switch.

Cascaded Switches

Limited cascaded switch configurations are supported in ISIS environments. For information on 
supported configurations, see the Avid Network and Switch Setup Guide in the documentation 
folder of the Avid ISIS software kit [drive]:\AvidISISDocumentation. 

APN Switches Approved for the ISIS Environment  

Switch ISIS 7000

ISIS 7000 
External 
Expansion 
Switches (EXS) ISIS 5500 ISIS 2000

Arista Networks 
7048T-A

✓ ✓

Cisco Nexus 7000 series ✓ ✓ ✓

Cisco Catalyst 4500-X ✓ ✓ ✓ ✓

Cisco Catalyst 6500-E 
series

✓ ✓ ✓

Foundry/Brocade 
SuperX

✓ ✓ ✓

Foundry/Brocade 
FESX448 and FESX648

✓ ✓
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Gold Disk Qualification

The following Avid ISIS systems comply with US Defense Information Systems Agency (DISA) 
Gold Disk requirements for network devices:

• Avid ISIS 7000 v4.x AS3000 System Director with the Window Storage Server 2008 
operating system or the Window Storage Server 2008 R2 operating system

• Avid ISIS 5500 v4.x System Director with the Window Storage Server 2008 operating 
system or the Window Storage Server 2008 R2 operating system

• Avid ISIS 2000 v4.5 AS3000 System Director with Window Storage Server 2008 R2 
operating system

n Only Windows 8, Windows 7, and Windows Vista (64-bit) clients were qualified the Gold Disk 
environment. Macintosh and Linux clients are not supported.

The following requirements apply in a Gold Disk environment.

Software Installation

To install the ISIS software in a Gold Disk environment:

1. Remove the System Director from the Active Directory Domain.

2. Log into the local Administrator account, created prior to adding the System Director to the 
Active Directory Domain (note that Administrator is disabled).

3. Install the ISIS software (System Director, switch, storage blades and Engine upgrades).

4. Once completed, add the System Director back into the Active Directory Domain.

ISIS Control Panel Functions

In a Gold Disk environment you must open the System Director Control Panel from the 
Programs menu.

To use the ISIS Control Panel in a Gold Disk environment:

1. Click Start > Programs > Avid > ISIS System Director > Control Panel. 

2. When prompted, select “Run as Administrator.”

This enables you to Start and Stop the System Director, as well as set or modify other 
configurations. 
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Compatibility with Internet Explorer

To turn on compatibility mode in Internet Explorer:

1. Click the Tools menu and select Compatibility View Settings in your Internet Explorer 
browser.

2. Type in the IP address of your Storage Manager and click Add.

3. Close the open browser dialog box.

Add Storage Manager as a Trusted Site

To add Storage Manager as a trusted site:

1. Click the Tools menu and select Internet Options in your Internet Explorer browser.

2. Click the security tab.

3. Click Trusted sites.

4. Click the Sites button.

5. Type in the IP address of your Storage Manager and click Add.

6. Close the two open browser dialog boxes.

Special Notes (ISIS 7500 | 7000, 5500 | 5000, and 
2000)

This section contains important information about the Avid ISIS environment.

Delete Logging Setting

Turning delete logging on or off while files are actively being deleted from the ISIS file system 
will cause the ISIS System Director to crash. Avid recommends that you do not change the delete 
logging setting during normal operation of your ISIS system. This setting should only be 
changed during a maintenance window to minimize any disruption.

User Permissions

A user account with Administrator privileges is required to install Avid ISIS client software on 
your workstations.
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Flash Player Software

To use the ISIS Management Console, make sure the Adobe Flash Player (v11.x and later) 
installed on your system. If you encounter problems with the ISIS Management Console display, 
you might have an outdated version or multiple versions of the Flash Player installed. Uninstall 
any previous versions of Flash Player and install the Flash Player included on the Avid ISIS 
Management Console > Installers page. 

Avid Interplay Authentication

Avid Interplay Authentication requires the Avid ISIS System Director to use a virtual name. The 
System Director’s virtual name must not match the actual host name and must be entered in the 
General Configuration Options dialog box. For instructions on adding the virtual name, search 
the Avid ISIS Administration Guide for General Configuration Options.

Avid Interplay Copy Service and Move Service in Zone 3

The Avid Interplay Copy Service and Move Service using an AS3000 or the SR2500 Interplay 
Copy/Move server with a single 10 Gb Myricom board installed has been qualified in Zone 3 of 
the ISIS 7000 and ISIS 5500 environments. This qualification requires the ISIS 7000 v2.4, 
ISIS 5000 v3.2, or ISIS v4.x infrastructures with ISIS v3.5 and later client software.

The Avid Interplay Copy Service and Move Service on the SR2500 server with the Chelsio 
10 Gb network adapter is only qualified in Zone 1 of the ISIS 7000 environment. 

 Illegal Characters in File, User, and Workspace Names

You must use Unicode characters in workspace names. The following is a list of 17 illegal 
characters you should not use in workspace names, workgroup names, filenames, user names, 
device names, and storage group names: \ / = @ [ ] % * ? + | : " ; , < >. You also should not use a 
period (.) as either the first or last character in the names you create, and you should not include 
a space in workspace names when in an Avid Interplay environment. Some of these characters 
might appear to be safe to use, but in mixed environments with Macintosh, Windows, and 
various other clients and operating systems, these characters have resulted in unexpected 
behavior. 

n The System Director does not support viewing regional language characters in the Management 
Console.
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LDAP Requires Unicode User Names and Passwords

The Avid implementation of LDAP (Lightweight Directory Access Protocol) requires that you 
restrict LDAP user names and passwords to ASCII. The LDAP/ISIS Account Synchronizer 
searches for groups and their users on an LDAP server and synchronizes (reconciles) user and 
group accounts by adding or removing users and/or groups from ISIS, 

Fast User Switching Not Supported

Fast User Switching is a Windows feature that allows multiple user accounts to log on to a 
computer simultaneously. Fast User Switching is enabled by default in Windows computers. The 
Fast User Switching feature and multiple concurrent logged on user modes are not supported in 
the Avid ISIS environment. The ISIS software does not distinguish the different drive letters 
mapped to the same workspaces on the same computer. Conflicts appear in the following two 
scenarios:

• When one user maps a drive letter to one workspace and another user maps the same drive 
letter to a different workspace

•  When one user maps a workspace to one drive letter, and another user maps a different drive 
letter for the same workspace.

Avid ISIS Firewall

Avid ISIS ships with the Windows Firewall turned off. For a list of the ports used in the Avid 
ISIS, see the Avid Network and Switch Guide. This guide is available from the installer 
Documentation link, the Management Console Help link, and the \AvidISISDocumentation 
folder in the ISIS software kit.

Multiple ISIS Systems

If you are setting up multiple ISIS shared storage systems, make sure that each system is on a 
separate network.

Macintosh Resource Files and Windows Clients

If Macintosh files are copied to a Windows system with the Macintosh resource fork files, the 
resource fork files cannot be copied to mounted workspaces from a Windows client. Avid ISIS 
does not accept Macintosh resource fork files from Windows clients. Appropriate “properties” 
error messages are displayed if this is attempted.
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Adobe Premiere Pro Software Approved

Avid has tested Adobe Premiere Pro as a client in the Avid ISIS 7000 and ISIS 5500 shared 
storage environments. The ISIS 2000 only supports Adobe Premiere Pro in push/pull workflows. 
The following guidelines and restrictions apply to Adobe Premiere clients. 

• Adobe Premiere was qualified on Windows 7 64-bit and Macintosh v10.7.3 64-bit operating 
systems.

• Adobe Premiere 10 Gb clients are not supported.

• Avid ISIS supports Adobe Premiere Pro clients in Zones 1, 2, and 3.

• Media from both Adobe Premier and Avid Media Composer are able to co-exist in the same 
Storage Group. Although for optimal performance, you should not mix Avid and Adobe 
Premier editors in the same Storage Group.

• Adobe Premiere clients follow the same guidelines as for Avid editors in regards to the Avid 
ISIS Client Manager Preference settings. The default Client Type setting is set to Medium 
Resolution (limited to resolutions that draw 16 MB/s or less). Use the High Resolution 
setting when working with High Definition media (resolutions that draw higher than 
16 MB/s). There are some HD resolutions that draw less than 16 MB/s for a single stream, 
but you should still use the High Resolution setting (for example, XDCAMHD 50). For 
information on how many streams were qualified per client at various resolutions, see the 
Avid ISIS Performance Guide on the Knowledge Base at www.avid.com/support. 

Final Cut Pro Software Approved

Avid has tested Final Cut Pro version 7 as a client in the Avid ISIS 7500 | 7000 and ISIS 
5500 | 5000 shared storage environments. The ISIS 2000 only supports Final Cut Pro in 
push/pull workflows. Testing was done with Final Cut Pro v7.0.3 with Mac OSX v10.6.8 and 
v10.7.x (32-bit). Final Cut Pro X has not been qualified. There is no Avid restriction on the 
QuickTime version. Use the QuickTime version recommended in the Final Cut Pro application. 
Avid ISIS supports Final Cut Pro v7.x Macintosh clients in Zones 1, 2, and 3. For information on 
how many streams were qualified per client at various resolutions, see the Avid ISIS Performance 
Guide on the Knowledge Base at www.avid.com/support. 

n Avid Interplay Access supports the Mac OSX platform, and through this application Final Cut 
Pro QuickTime files and projects can be checked into Interplay. Any Interplay workstation can 
search for these files and edit their Interplay metadata, though there is currently no tightly 
integrated workflow between Avid Media Composer and Final Cut Pro within Interplay.

http://www.avid.com/support
http://www.avid.com/support
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Power Saving Modes

Do not use power saving modes on Avid ISIS clients. Your power saving options should be set to 
never go into low power mode and should be set to “Always On” (Windows) or High 
Performance (Macintosh). Is it critical that each client in a Direct Connect environment have the 
network board option “reduce link speed during standby power saving” disabled. 

Virus Protection

Windows updates are not installed automatically on the System Director. If you are connected to 
the Internet, Avid recommends you manually select your Windows updates and install them 
during a scheduled maintenance intervals. Some updates require that you restart the System 
Director. In addition, anti-virus programs that contain autoscanning features (for example File 
System Auto-protect or scanning files on network drives) are not supported.

Access the Knowledge Base at www.avid.com/securityupdate and review the Microsoft Security 
Bulletin Addendum document. This link also includes anti-virus software support on Avid 
products which can be found in the Avid Security Guidelines and Best Practices document.

c Virus protection software and Windows updates will result in workflow interruptions, and 
should be performed during a scheduled maintenance interval.

Uninterruptible Power Supply

Avid highly recommends using an Uninterruptible Power Supply (UPS) with all Avid ISIS 
components. 

Without a UPS if you lose power while capturing media, some data loss for newly captured 
media will likely occur. The recently written data in the RAID controller that has not been 
written out to the data drives would be lost. 

Avid ISIS 7500 | 7000 Special Notes

The following is a list of features for should keep in mind with Avid ISIS 7500 | 7000 
infrastructures:

Upgrading Unstacked Switches

If you need to upgrade switches that are not yet stacked, the Avid ISIS software kit includes the 
Avid ISIS Upgrade Utility. This stand-alone application allows field engineers to start and 
monitor the installation of switch and ISB upgrades from a laptop connected to Avid ISIS switch 
through the management port. This utility does not replace the current upgrade process. Its 

http://www.avid.com/securityupdate
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primary function is for upgrading a switch or a pair of switches that is incompatible with an 
existing stacked network. Insertion of these switches into the network before the upgrade could 
disrupt or compromise the network’s operation. For instruction on using the utility, see the Avid 
ISIS 7000 Setup Guide.

The Avid ISIS Upgrade Utility (AvidUnityISISTools.msi) can be found on the Avid ISIS 
software kit in the \ISISUtilities\ISIS 7000 folder.

ISIS 7500 | 7000 System Director

The Avid ISIS System Director uses an Avid AS3000 server or Intel SR2500 server with 9 GB of 
memory and a 64-bit Window operating system. The new 64-bit System Director provides the 
following support:

• 64-bit System Director — 10 million files

• 64-bit System Director — 500,000 folders (25,000 files per folder)

• 5638 users

• 1000 groups — a user can be in 15 groups

ISIS 7000 Client Connections

Starting with ISIS v4.0, Avid ISIS 7000 automatically supports up to 330 ISIS client licenses. 

Storage Group Size

Storage Managers are combined to create Storage Groups in the ISIS file system. These Storage 
Groups can be configured to operate using either 512 KB (default) or 256 KB chunk sizes. 
Earlier Avid ISIS releases used 256 KB chunk sizes. For more information about setting the 
chunk size, see the Avid ISIS Administration Guide.

n Avid ISIS switch hardware shipped with v1.x (ISS1000 and IXS1000) does not support 512 KB 
chunk sizes. If you have Avid ISIS v2.x software running on v1.x switches, you must select the 
256 KB chunk size when adding Storage Managers to the file system to create Storage Groups.

You cannot change the chunk size of a Storage Group once the Storage Group has been created. 
To change the chunk size of an existing Storage Group, you must delete the Storage Group and 
create a new Storage Group with the desired chunk size. The chunk size selection is only 
available when adding the Storage Managers. 
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Chunk Size Support With ISB

All ISBs (i500, i1000, i2000, i4000 and i8000) support the 512 KB chunk size, although you 
must have v2.x switch hardware (ISS2000 and IXS2000) to use the 512 KB chunk size. Only 
i500 and i1000 ISBs support 256 KB chunk sizes.

10 Gb Client Support in ISIS 7000

The following are guidelines as to the number of clients that are supported in Zone 1 (directly 
connected to an ISS in an ISIS 7000 Engine). When a 10 Gb device is connected to your ISS, 
some of the 1 Gb ports cannot be used:

• High Resolution 1 Gb clients — four or less with one Ultra High Resolution 10 Gb client

• Medium Resolution 1 Gb clients — five or less with one Ultra High Resolution 10 Gb client

RAID-6 Storage Groups, Single ISB Failure

When there is a single ISB failure in an ISIS Storage Group configured with RAID protection, 
the Storage Group continues to function normally at a lower bandwidth. For mirrored Storage 
Groups, see “Mirrored Storage Groups, Single ISB Failure” on page 51.

After confirming the failure of an ISB, Avid highly recommends that you initiate the remove 
redistribution process of the failed ISB immediately. There are two benefits to doing this: 

• Immediately upon initiation of the remove redistribution, all new writes to the Storage 
Group have the full benefit of RAID-6 protection (dual-parity protection). 

• Upon completion of the remove redistribution process, existing data in the Storage Group is 
once again fully protected. Prior to completion, if another ISB were to fail, the Storage 
Group would be in an unprotected state (though no data would be lost).

RAID-6 Storage Groups, Dual ISB Failure

An “unprotected state” exists if a RAID-6 Storage Group has two failed ISBs. In an unprotected 
state with no additional failures, read operations continue to function normally at a lower 
bandwidth. 

However, in an unprotected state, due to the distributed architecture of the ISIS file system 
(optimized for real-time performance), under certain circumstances the system cannot correctly 
update the parity information when writing new data. As a result, the file system could return a 
failure status when writing. While the failure rate percentage on the total number of write 
operations is low, heavy workloads on the system would result in enough write failures to disrupt 
operations.
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This issue only applies when the Storage Group is in an unprotected state and the remove 
redistribution process on the failed ISBs has not been initiated. Therefore, it is highly 
recommended that the remove redistribution process is initiated immediately upon confirmation 
of any ISB failure. This ensures immediate protection (RAID or mirroring) of new data being 
written, and full protection of all stored data at the earliest possible time.

Mirrored Storage Groups, Single ISB Failure

An “unprotected state” exists if a single ISB fails in a mirrored Storage Group. In an unprotected 
state with no additional failures, read operations continue to function normally.

However, in an unprotected state a subsequent or infrastructure failure will cause operational 
issues which could result in failures when writing new data or prevent you from accessing data in 
the Storage Group. An additional ISB failure creates a situation in which data accessibility has 
been compromised. Networking issues, on the other hand, will not cause accessibility issues on 
previously written data but might prevent the successful completion of the active write operation.

This issue only applies when the Storage Group is in an unprotected state and the remove 
redistribution process on the failed ISBs has not been initiated. Therefore, it is highly 
recommended that the remove redistribution process is initiated immediately upon confirmation 
of any ISB failure. This ensures immediate protection (RAID or mirroring) of new data being 
written, and full protection of all stored data at the earliest possible time.

Adding or Removing ISBs (Mirrored or RAID-6)

When permanently adding or removing ISBs from an ISIS Storage Group (for example, adding 
or removing an engine to the storage stack), Avid recommends performing a full redistribution 
for all workspaces in the Storage Group, after the ISB add or remove is complete.

The full redistribution makes sure all blocks in the Storage Group are optimally distributed based 
on the new permanent configuration, and minimizes the potential for problems if a full 
redistribution is required in the future; for example, storage blades getting full during a full 
redistribution and requiring the user to delete files to allow the redistribution to complete.

This recommendation does not apply to the case of removing and then replacing failed storage 
blades. For other examples of symmetric and non-symmetric redistributions, see the Avid ISIS 
Performance and Redistribution Guide on the Knowledge Base at www.avid.com/US/support. 

Adding a Storage Manager (ISB) to the File System

If you add an Storage Manager (displays as an unbound Storage Manager) to your file system, 
make sure you match the Chunk Size of the new Storage Manager to the Chunk Size of the 
existing Storage Group. New Storage Managers are added with a default chunk size of 512 KB 
on mirrored Storage Groups (256 KB with i1000 ISBs). You cannot mix Chunk Sizes within a 

http://www.avid.com/US/support
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Storage Group. To change the Chunk Size of an Storage Manager, you must remove the new 
Storage Manager from the file system and add the Storage Manager again and select the same 
Chunk Size of the existing Storage Group.

Zone 1 Switches

The ISIS v2.x generation IXS and ISS switches install in the same Engines as earlier releases. 
However, all the switches in the Engines must be of the same generation. The two new switches 
are labeled IXS2000 and ISS2000. The new switches cannot be mixed in ISIS Engines with 
earlier versions of the switches (labeled IXS1000 and ISS1000). If your IXS and ISS switches 
are not labeled, consider them the earlier versions. The ISS2000 switches are required for 10-Gb 
clients and 512 KB chunk size; see “Storage Group Size” on page 49.

The Avid ISIS documentation refers to IXS2000 and ISS2000 switches as v2.x hardware and 
IXS1000 and ISS1000 switches as v1.x hardware. 

Full Redistribution

After updating the Avid ISIS server software, and the ISIS software on all the clients, Avid 
recommends you do a full redistribution (one-time full remapping redistribution) at your earliest 
convenience to take advantage of the performance optimization introduced with Avid ISIS v2.x. 
After the full remapping redistribution, full redistributions that might have taken several hours in 
earlier releases can be performed in a matter of minutes, depending on the system load. 

c Once you do a full redistribution with v2.x, v1.x clients cannot read from, or write to, those 
workspaces. For more details, see “Software Installation Instructions” on page 13.

The faster full redistributions only apply to workspaces that have had symmetric configuration 
changes; for example, if you removed and then added the same number of ISBs to a storage 
group in a single configuration change. For examples of symmetric configuration changes search 
the Avid Knowledge Base for the Avid ISIS Performance and Redistribution Guide. As with all 
full redistributions, select all workspaces in the storage group for the full redistribution.

A full redistribution is still recommended at 10 configuration changes. At 32 configuration 
changes the Avid ISIS software automatically performs a full redistribution. 

Automatic Redistribution on Disk Failure

Avid ISIS performs an automatic redistribution on Disk Failure notification. Storage Elements 
continuously monitors disk status and sends a “Disk Failed” notification to the System Director 
upon determination that a disk is not usable. The System Director then removes the Storage 
Element from its associated Storage Group. The removal of the Storage Element from the 
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Storage Group initiates redistributions on all workspaces associated with that Storage Group. 
The System Director then prevents the Storage Element that reported the disk failure from being 
added to a Storage Group.

The Automatic Removal feature is controlled by a system preference, called “Auto Remove 
Redistribution on Disk Failure,” that is configured using the ISIS Management Console 
Preferences tool. The default setting is “enabled.” The Storage Element is removed from the 
Storage Group, but not unbound from the ISIS Systems for the following reasons:

• The Storage Element participates in the removal redistribution. This is required to prevent 
data loss when full redundancy has not been attained for all data blocks.

• The Storage Element continues to report status, such as physically replacing the blade.

Auto-removal status is reported in the System Event Log. A sequence of event log entries is 
generated for the initial report of the failure, the decision to remove the Storage Element, and 
subsequent success or failure. Events are also logged for the start and stop of all the workspace 
redistributions.

When using Automatic Redistribution: 

• Keep at least 7% of your Storage Group unused at all times. Failure to do so can cause the 
system to run out of space after an automatic redistribution has initiated and cause a client 
outage. For more information, see “Minimum ISIS 7000 Storage Space Requirement” on 
page 55.

• If an automatic redistribution of a Storage Group is started during a critical time the overall 
system performance can degrade significantly and be disruptive. For more information on 
understanding the performance characteristics during remove redistribution, see the Avid 
ISIS Performance and Redistribution Guide.

• An automatic redistribution removes the Storage Element from the Storage Group but not 
from the file system. Once an automatic redistribution has completed, remove the Storage 
Element from the file system with the software and then physically replace it. Adding a 
replacement ISB to the file system and then to the Storage Group triggers another 
redistribution. 

• If unmirrored workspaces are in use, the data will be damaged on those workspaces in that 
Storage Group.
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Firmware Upgrade During a Redistribution

Do not perform an ISB firmware upgrade while a Redistribution is in process. Make sure all 
firmware upgrades are completed before starting any redistribution. The following events trigger 
redistribution:

• Moving a Workspace

• Clicking “Full Redistribution” on a Workspace

• Adding a Storage Element to a Storage Group

• Removing a Storage Element from a Storage Group

• Changing the state of a Workspace to mirrored or unmirrored 

If a firmware upgrade must be done and a redistribution in progress, do the following:

1. Suspend the active redistribution using the Advanced Commands in Workspace window.

2. Verify that the Workspace displays “redistribution suspended” in the Status column and all 
other workspaces do not have “redistribution in progress” displayed.

3. Perform the firmware upgrade on the ISB(s) that must be upgraded.

4. Wait until the firmware upgrade is completed successfully.

5. Resume the redistribution using the Workspace window.

Avid Interplay Authentication

Avid Interplay Authentication requires the Avid ISIS System Director to use a virtual name. The 
System Director’s virtual name must not match the actual host name and must be entered in the 
General Configuration Options dialog box even if your Avid ISIS system configuration only has 
one System Director. For instructions on adding the virtual name, search the Avid ISIS 
Administration Guide for General Configuration Options.

Workspace Names

You must use Unicode characters in workspace names. You cannot use the following 16 illegal 
characters in workspace names, workgroup names, filenames, user names, device names, and 
storage group names: \ / = @ [ ] % * ? + | : " ; , < >. In addition, do not use a period (.) as either 
the first or last character in the names you create, and do not include a space in workspace names 
in an Avid Interplay environment.

n The System Director does not support viewing regional language characters in the Management 
Console.
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Workspace names beginning or ending with a period are no longer valid in Avid ISIS v1.4 and 
later. If you already have workspace names with periods and upgrade to Avid ISIS v1.4, the 
original issues continue to exist as outlined below: 

• Windows — Data is preserved and intact with display issues. A filename or directory with a 
period at the end is invalid in Windows. As a result the Avid ISIS client is trying to interpret 
a period at the end of a workspace into something Windows can understand. This 
interpretation appears as a graphic instead of a period.

• Macintosh — Data is preserved and intact, but any workspace with a name that starts with a 
period is treated as a hidden directory by Mac OS X. By default such a workspace cannot be 
accessed via the Desktop and cannot be seen in the “/Volumes” folder in the Finder. 

To access the contents of the Macintosh workspace:

t Click Go > Go to Folder… menu in the Finder and type the path “/Volumes/” followed by 
the workspace name (for example, “/Volumes/.MyWorkspace”). 

A window opens showing the contents of the workspace and makes the workspace 
temporarily visible as a subdirectory of “/Volumes.”

Network Connections

The ISIS network topology uses two separate domains, with one domain represented by the ISSs 
on the left side of the ISIS Engine and the second domain represented by the ISSs on the right 
side. The default network IP address configuration is shown in the following table:

For more addressing information, see “IP Addressing Overview” in the Avid ISIS 7000 Setup 
Guide. 

Avid ISIS does not support Zone 1, 10/100 BASE-T network interface connections. 10/100 
BASE-T clients must be attached as a Zone 2 or 3 client. 

Minimum ISIS 7000 Storage Space Requirement

Avid recommends that you maintain 7% of free space in each Storage Group. In other words, 
you should not fill a Storage Group more than 93% full. Exceeding 93% used space can produce 
severe performance issues in some situations. 

Default Network Addresses for Avid ISIS Engines

Location Network IP Addresses Subnet Mask

Left side of engine 192.168.10.0 255.255.255.0

Right side of engine 192.168.20.0 255.255.255.0
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To calculate the right amount of free space, log into the ISIS management Console and navigate 
to the Storage Group window. For each Storage Group, take the Effective number and multiply 
by 0.07. This will be your recommended free space in GBs. To make sure that your Storage 
Group never exceeds the recommended space, create a new workspace in this Storage Group 
with the same size and label it “Headroom” and do not give anyone access to this workspace. 

Enabling the Distributed File System on Windows Vista

Avid ISIS v2.0.4 and earlier disabled the Windows Vista Distributed File System (DFS) on 
Windows Vista clients. DFS was disabled because Avid ISIS clients running Windows Vista 
were experiencing delays when opening files over the shared storage network with DFS enabled. 
Windows Vista service pack 2 (SP2) corrects the delays experienced with DFS enabled. Avid 
ISIS v2.0.5 and later client software detects the service pack version installed on the Windows 
Vista client and leaves DFS enabled if using Windows Vista SP2. If you have Windows Vista 
SP1 installed, DFS is disabled. To run DFS on your Windows Vista client, perform the Windows 
Vista update to installs SP2 and reinstall the Avid ISIS v2.0.5 and later client software.

Spanning Tree PortFast Required with Dual Network Client Ports

If Spanning Tree PortFast is disabled when your system is recovering from a link failure using a 
dual network client port, a “semaphore time-out” error message appears.

Avid ISIS 5500 | 5000 Special Notes

The following list applies to Avid ISIS 5500 infrastructures:

ISIS 5500 | 5000 Single Engine Configurations with Routed Clients

For single engine ISIS 5500 | 5000 configurations that include routed clients (Layer 3 to the ISIS 
5500 | 5000), the Engine can be connected to the switch using either 10 Gb or 4 x 1Gb.

ISIS 5500 System Director

The Avid ISIS Engine System Director provides the following support:

• System Director — 8 million files and folders (combined total)

• 5638 users

• 1000 groups — a user can be in 15 groups
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Up to Six Engines on ISIS 5500

The initial release of Avid ISIS 5000 supported one or two Engines. Avid ISIS 5000 v3.1 
included support for four Engines; starting in ISIS v3.2 six Engines are supported. New Engines 
can be configured as separate Storage Groups or be added to existing Storage Groups. If you 
choose to add the new Engines to an existing Storage Group, a redistribution of the existing data 
is initiated to spread the data evenly across all drives in the storage group (see “Redistributing 
Data on ISIS 5500” on page 58). For instructions on adding new Engines, see the Avid ISIS 5500 
Setup Guide. 

n You can mix both 1 TB, 2 TB and 4 TB Engines in the same Storage Group, but 2 TB drives are 
restricted to the same capacity as 1 TB drives.

You can add unassigned storage Engines to a Storage Group to increase its storage capacity and 
bandwidth. This is typically done when adding a new Engine to your Avid ISIS system. 
Redistribution is an operation that ensures all files on a Workspace are balanced evenly across 
the Storage Elements in the Storage Group to provide optimal file system performance. For more 
information, see “Redistributing Data” in the Avid ISIS Administration Guide.

When redistributing files in a Storage Group, the redistribution applies to all Workspaces in that 
Storage Group.

ISIS 5500 Client Connections

Starting with ISIS v4.0, Avid ISIS 5000 supports up to 90 ISIS client licenses. Direct Connect 
configurations to support up to 9 clients. The ISIS 5500 connections are summarized in ISIS 
5500 Terminology. 

10 Gb Client Support in ISIS 5500

You can have one 10 Gb client per ISIS 5500 Engine. For example, in a six Engine configuration 
you can have six 10 Gb clients. These 10-Gb clients connect into a 10-Gb port on a qualified 
switch or can connect directly into the ISIS 5500 System Director 10-Gb port on a switch-less 
configuration. 

Initialize RAID Set on ISIS 5000

Avid ISIS 5000 v3.1 provided an alternative method of initializing the RAID set. You can 
initialize the RAID set on the 16 data drives without installing the ISIS 5500 | 5000 software. 
This might be helpful if you want to create the RAID set before setting up the ISIS 5500 | 5000 
shared storage network. An “Initialize Raidset” link has been added to the software installer 
splash screen. 
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n If you click the Initialize Raidset link and your RAID set is already configured, a “Raidset 
created” message is displayed.

When you initially install the Avid ISIS software, the RAID set is initialized automatically. With 
no client traffic on the system, this will take up to approximately 54 hours. During this 
initialization, the system is functional and able to support a limited amount of client traffic. An 
Avid ISIS 5000 Engine can support full bandwidth to one client during initialization. This allows 
sufficient bandwidth to test the system before the initialization is complete by working with one 
client at a time. During initialization, keep Client bandwidth to a minimum. Failure to do so can 
significantly increase the initialization time. 

To initializing the RAID set:

1. Do one of the following:

t Double-click the Autorun.exe file in Avid ISIS 5500 | 5000 software kit.

t Click the “Initialize Raidset” link on the lower right-side of the splash screen.

Redistributing Data on ISIS 5500

You can add unassigned Storage Elements to a Storage Group to increase its storage capacity 
and bandwidth. When adding a new Engine to the ISIS system, a redistribution is required if 
adding the new Engine to an existing Storage Group. If adding a new Engine and creating a new 
Storage Group, no redistribution is performed. Redistribution is an operation that ensures all files 
on a Workspace are balanced evenly across the Storage Elements in the Storage Group to 
provide optimal file system performance. For more information, see “Redistributing Data” in the 
Avid ISIS Administration Guide.

ISIS 5000 v4.0 and ISIS 5500 | 5000 v4.5 and later supports removing Storage Managers from a 
Storage Group.

n When redistributing files in a Storage Group, the redistribution applies to all Workspaces in that 
Storage Group.

c When a Workspace is deleted, a redistribution is initiated. If you start the delete during 
high client usage, it might cause a negative performance impact on your clients. This can 
include dropped frames, underruns, and failed captures. Delete Workspaces during 
periods of light client activity. 

Minimum ISIS 5500 | 5000 Storage Space Requirement

Avid recommends that you maintain 5% of free space in each Storage Group. In other words, 
you should not fill Storage Group more than 95% full. Exceeding 95% used space can produce 
severe performance issues in some situations. 
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To calculate the right amount of free space, log into the ISIS management Console and navigate 
to the Storage Group page. For each Storage Group, multiply the Effective number by 0.05. This 
is your recommended free space in GBs. To make sure that your Storage Group never exceeds 
the recommended space, create a new workspace in this Storage Group with the same size and 
label it “Headroom” and do not give anyone access to this workspace. 

Avid ISIS 2000 Special Notes

The following list applies to Avid ISIS 2000 infrastructures:

ISIS 2000 System Director

The Avid ISIS 2000 System Director uses an AS3000 server with 24 GB of memory and a 64-bit 
Window Storage Server 2008 R2 operating system. The ISIS 2000 System Director provides the 
following support:

• 64-bit System Director — 10 million files

• 64-bit System Director — 500,000 folders (25,000 files per folder)

• 5638 users

• 1000 groups — a user can be in 15 groups

Up to Five ISIS 2000 Engines

The initial release of Avid ISIS 2000 supported one Engine; ISIS v4.5 added support for up to 
five ISIS 2000 Engines. New Engines can be configured as separate Storage Groups or be added 
to existing Storage Groups. For instructions on adding new Engines, see the Avid ISIS 2000 
Setup Guide. 

You can add unassigned storage Engines to a Storage Group to increase its storage capacity and 
bandwidth. This is typically done when adding a new Engine to your Avid ISIS system. 

Redistribution is an operation that ensures all files on a Workspace are balanced evenly across 
the Storage Elements in the Storage Group to provide optimal file system performance. For more 
information, see “Redistributing Data” in the Avid ISIS Administration Guide. When 
redistributing files in a Storage Group, the redistribution applies to all Workspaces in that 
Storage Group. ISIS 2000 clients are permitted to read and write during an “Add” redistribution. 
ISIS 2000 does not support “Full” or “Remove” redistributions.
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Initialize RAID Set

When you initially install the Avid ISIS 2000 system and initialize the RAID set, it takes 
approximately 72 hours regardless of the Engine configuration. During this initialization, the 
system is functional and able to support a limited amount of client traffic. Client traffic can 
significantly increase the initialization time. For more information about the initialization time, 
see the Avid ISIS Performance Guides.

Minimum ISIS 2000 Storage Space Requirement

Avid recommends that you maintain 5% of free space in each Storage Group. In other words, 
you should not fill Storage Group more than 95% full. Exceeding 95% used space can produce 
severe performance issues in some situations. 

To calculate the right amount of free space, log into the ISIS management Console and navigate 
to the Storage Group page. For each Storage Group, multiply the Effective number by 0.05. This 
is your recommended free space in GBs. To make sure that your Storage Group never exceeds 
the recommended space, create a new workspace in this Storage Group with the same size and 
label it “Headroom” and do not give anyone access to this workspace. 

ISIS 2000 Client Connections

Avid ISIS 2000 systems support 200 ISIS clients using either 1 Gb, dual 1 Gb, and 10 Gb 
connections at any client Type setting. ISIS 2000 clients must connect through a Zone 2 or 
Zone 3 switch network segment port. 

The ISIS 2000 includes a File Gateway function that allows an unlimited number of clients to 
push and pull data to and from the ISIS 2000 through a Common Internet File System (CIFS) or 
FTP connection without the ISIS Client Manager software. 

n When the File Gateway is configured as a CIFS server, workspaces are mapped to drive letters 
on the File Gateway. Depending on the number of drives in the File Gateway, the maximum 
number of workspaces that can be shared out as a CIFS share is 22 workspaces.

ISIS 2000 Switches 

Avid has qualified the Force10 S4810 and Cisco 4900M switches. The ISIS 2000 nearline 
storage is designed for workflows with your ISIS 7000 and ISIS 5500 online environments. 
Sample ISIS 7000 and ISIS 5500 configurations files are included in the software installer kit, 
see the Qualified and Approved ISIS Switches. 



Avid ISIS 2000 Special Notes

61

ISIS 2000 Engine

Starting in ISIS v4.5, five Engines are supported in an ISIS 2000 configuration. New Engines can 
be configured as separate Storage Groups or be added to existing Storage Groups. If you add the 
new Engines to an existing Storage Group, a redistribution of the existing data is initiated to 
spread the data evenly across all drives in the Storage Group. For instructions on adding new 
Engines, see the Avid ISIS 2000 Setup Guide. 

n You can mix both ISIS 2000-120 TB and ISIS 2000-240 TB Engines in the same Storage Group.

The ISIS 2000 is not intended to be used for real time editing of high resolution material, 
although real time playback of resolutions of up to 3 Mb/s or less is supported. 

Moving ISIS 2000 Workspaces

The following sections list the supported methods for moving data between online (ISIS 7000 
and ISIS 5500 | 5000) and nearline (ISIS 2000) Workspaces.

Interplay Workflows

Avid Interplay v2.6 and v2.7 have been qualified in the Avid ISIS v4.5 ISIS environments. You 
can move assets from one ISIS system to another using Interplay workflows. The Interplay 
Media Services is required. Interplay workgroups with a single IP Database for multiple ISIS 
configurations can use the Interplay Transcode and Interplay Move services to move media. To 
move media between Interplay workgroup configurations, use Interplay Copy, Interplay 
Delivery, and Interplay Transfer. 

AirSpeed Workflows

Avid AirSpeed 5000 v2.1, AirSpeed Multi Stream v1.8.6 and AirSpeed v2.7.12 have been 
qualified in the Avid ISIS v4.5 ISIS environments. The AirSpeed 5000 can capture high 
resolution to online environments, and proxy to nearline environments (or proxy to online and 
high resolution on nearline). This allows you place material directly to where you need it and not 
have to move it. 

Editor Workflows

Editors can move clips and sequences between ISIS workspaces using the 
Consolidate/Transcode feature. In addition, with online and nearline workspaces mounted on a 
single client, you can drag files from one workspace to another.

c Moving files in an Interplay shared storage environment from a client at the file system 
level could be detrimental to system operations. Use Interplay Media Services applications 
when moving files in an Interplay shared storage environment.
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Data Migration Utility Workflows

The Data Migration Utility can be used to move complete Workspaces between ISIS 
infrastructures. You can use the Data Migration utility to move Workspaces between any 
combination of ISIS 7500 | 7000, ISIS 5500 | 5000, and ISIS 2000 systems; this includes 
mirrored, RAID 6, HW RAID (ISIS 5500 RAID 5), SW RAID (ISIS 2000 RAID 6), and 
unprotected Workspace. For instructions on setting up and using the Data Migration Utility see 
the Avid ISIS Client Guide.

When Workspaces are migrated, the protection type is inherited from the ISIS system. For 
example, Workspaces migrated to ISIS 5500 inherits RAID 5 protection. Workspaces migrated 
to ISIS 2000 inherits RAID 6 protection. Workspaces migrated to ISIS 7500 | 7000 inherits 
mirrored protection by default. 

RichCopy Workflows

RichCopy is a free computer utility program developed by Microsoft to copy file directories. It 
performs faster than conventional copy and paste commands in the Windows operating system. 

Known Issues

The following are known issues with the Avid ISIS software. 

Client Issues

The following are known issues with the Avid ISIS v4.x client software. When a workaround 
exists, it appears in the paragraph directly following the issue description. The ISIS 
infrastructure issues are documented in the individual sections. 

➤ On a Linux OS, right-clicking to access a context menu in the Management Console window 
does not work properly. The context menu does not stay open when you right-click and release 
the mouse button.

Workaround:  Keep the right-click button applied while scrolling through the menu options.

➤ When installing the Client Manager on an Mac OS X v10.9 you might receive the following 
message: “Kernel Extension is not from an identified developer.” The Client Manager will install 
successfully if you continue through the install process.

➤ There is currently an issue with handling Final Cut Pro rendered media files. Until this issue is 
resolved, Avid recommends that you render to a local volume.
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➤ After updating your Windows ISIS client software, your client might not find your ISIS 
infrastructure and display “Failed to open key 
SYSTEM\CurrentControlSet\Services\AvidFosFS\Parameters\FwProfiles” in the Logs portion 
of the Client Manager window. 

Workaround:  Uninstall your ISIS Client software (either thought the Windows Control Panel > 
Programs > Programs and Features or Autorun.exe “Remove ISIS Software” selection in the 
menu) and reinstall the ISIS Client software again.

➤ The Client Manager application only supports ASCII characters in user passwords. 

➤ If using Client Manager with a Macintosh Client on any language setting other than English, you 
must use the Cancel button to cancel an uninstall. Do not click the red “x” to close the client 
software uninstaller window. (The client software uninstaller application is located at 
Applications > Avid_Uninstallers > AvidISIS).

➤ If you select the ISIS System Director or Engine software option from the ISIS software installer 
splash screen, on a Windows Vista 64 client workstation, an error indicating an application has 
failed might appear. This error can be safely ignored.

Workaround:  Avoid selecting these install options on client workstations.

➤ When you Enable or Disable the Network Interface (the check box in the first column), and then 
click Apply, it forces a refresh. If you change the setting and click Apply several times in a 
minute, it might introduce a client system error.

Workaround:  Restart the client by powering off the system to clear the condition. 

➤ When using Nautilus (the default browser included with Red Hat Enterprise Linux v6.2), clients 
might experience long wait times browsing folders containing files that do not have a file 
extension. 

Workaround:  If using files without extensions, limit the number of files per folder. 

➤ If Avid ISIS Windows clients assign a drive letter to a workspace in the Client Manager, an Avid 
Interplay client or virus protection software (programs running in the background) could obscure 
the displayed drive letter in the Client Manager window. The assigned drive letters are still 
mounted and fully accessible to the system, but are hidden from Client Manager's workspace list 
by the displayed UNC path.

If the UNC path is removed by the program running in background, your assigned drive letter 
re-appears.
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Workaround:  You can verify the workspace is mounted to a drive letter by confirming its 
presence in the My Computer window. You can also unmount the drive through the My 
Computer window by right clicking it and selecting Disconnect.

➤ If you attempt to initiate several file copies from workspace to workspace in parallel on a single 
client, you might experience “can not read and write” or “delayed write failure” error messages.

Workaround:  A maximum of two parallel file copies from workspace to workspace per client 
is supported. Any number of files can be in a single copy.

➤ Windows Vista 64-bit clients with SP2 might experience a 10 to 20 second delay when accessing 
workspaces from Windows Explorer.

Workaround:  Disabling the WebClient service removes the delay.

To change the WebClient service setting:

1. Right click My Computer and select Manage.

2. Expand Services and Applications in the left pane and click Services.

3. Right-click WebClient in the right pane and select Properties.

4. In the General tab of the WebClient window, click Stop. 

5. Select Disabled in the Start-up type menu.

6. Click Apply.

7. Click OK.

n You do not need to restart the client after this change.

➤ If one workspace in Client Manager is mounted by Mapping a Network drive in Windows, when 
you unmount the workspace and then mount a different workspace in Client Manager manually 
using the same drive letter, Windows Explorer displays the previous workspace name instead of 
the new workspace name. 

➤ The estimated amount of space available (usually measured in an amount of time at a particular 
resolution) might differ between what Avid ISIS calculates and what the Avid editing system 
calculates.

Avid ISIS accurately reports the amount of space available for file storage.

The Avid editing application accounts for overhead in formatting of the media and is more 
conservative in reporting how much space is available.
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➤ When the Final Cut Pro Scratch Disk is saved to an ISIS workspace using the Autosave Vault 
feature, the copies of the project in Autosave Vault folder cannot be opened with Final Cut Pro. 
An error message is displayed stating “File error: Wrong type.”

➤ When the Final Cut Pro Scratch Disk is saved to an ISIS workspace using the Autosave Vault 
feature, more copies are automatically saved than is set in the Autosave Vault setting.

➤ The Final Cut Pro “Modify > Make Offline > Move them to the Trash” option is not supported 
with Avid ISIS workspaces. 

➤ Final Cut Pro v6.0.5 sometimes stops functioning if you Eject the ISIS workspace using the 
Final Cut Pro Open menu. When you are done using the ISIS workspace unmount the workspace 
using the Client Manager window. 

➤ The Avid ISIS client bandwidth allocation feature is not supported with Final Cut Pro.

➤ The Macintosh Finder might display the Avid ISIS folder contents incorrectly, such as the 
contents of folders containing items whose name includes a pound sign (#) followed by numeric 
characters. For example, “project # 12” might be erroneously displayed with some items 
duplicated and some items missing. 

Workaround:  Avid recommends avoiding the use of names that include a pound sign (#) 
followed by numeric characters.

➤ Your Avid ISIS Macintosh Lion (v10.7.x) client might experience a kernel panic while 
attempting to uninstall the ISIS client software. 

Workaround:   Force the Macintosh client to restart by pressing and holding the power button 
until the Macintosh client powers down. Restart the Macintosh client and attempt to uninstall the 
client software again. 

➤ If your Avid ISIS 10 Gb Macintosh Lion (v10.7.x) clients suddenly starts to experience delayed 
write failures, the Myricom driver might have switched the MTU size to 9000 or to Jumbo 
Frames. 

Workaround: Verify the Myricom driver MTU setting is configured as “Standard 1500,” check 
the setting on the Macintosh client as follows: 

1. On your Macintosh 10-Gb client, click Apple > System Preferences.

2. In the Internet & Wireless section, click Network.

3. In the left pane, select the Myricom entry and click Advanced.

4. Click the Hardware tab.
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5. Select “Manually” from the Configure drop-down box to enable the MTU drop-down box.

6. Select “Standard 1500” in the MTU setting.

➤ If your Avid ISIS Macintosh Lion (v10.7.x) client has a Workspace mounted, the client Disk Log 
open, and the ISIS 5500 is restarted, you could experience a kernel panic once the ISIS 5500 is 
back running and you attempt to access the Disk Log. 

Workaround:   Force the Macintosh client to restart by pressing and holding the power button 
until the Macintosh client powers down. Restart the Macintosh client and you can continue to 
working where you left off. 

➤  Do not disconnect the PCI interface cable from either a Nitris DX or Mojo DX while it is 
powered up on the Macintosh editing system. If Avid ISIS is running on this system and the 
cable is removed, the Macintosh produces a kernel panic and reports ISIS as the problem. You 
must power down Macintosh before removing the PCI interface cable between the Macintosh 
and the Nitris DX or Mojo DX. The only way to power down the Nitris DX or Mojo DX system 
is to shut down the client connected to it. 

➤ If playing two streams of media during a non-symmetrical full redistribution on an Avid editor 
with a Nitris DX or Mojo DX attached, you will drop frames.

Workaround:  You have the following options.

• Work with your media after the redistribution is finished.

• Start the Management Console Tool and suspend the redistribution. Finish working with 
your media and then resume the redistribution.

n  Do not leave the redistribution in a suspended state for an extended period of time.

➤ The Path Diagnostics customized setting for Posix tests does not work correctly on the 
Macintosh clients. 

Workaround:  Use the default option to automatically select the File Access Method instead.

Common ISIS Infrastructure Issues

The following are known issues that could be experienced in Avid ISIS 7000, ISIS 5500, and 
ISIS 2000 infrastructures. When a workaround exists, it appears in the paragraph directly 
following the issue description.

➤ When accessing the Storage Manager agent using a Chrome browser, you might receive a “This 
web page is not available” message.
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Workaround:  Press the F5 key. The page will reload. At the “Site’s Security certificate is not 
trusted” window click Proceed anyway. 

➤ When attempting to view system log files (/var/log/messages.*.gz) from the Storage Manager > 
Agent page > Logging tab, the Agent page stops functioning if you click View on a *.gz file. Do 
not view any *.gz logs through the Agent pages. 

n To view *.gz files use the Management Console > ISIS Toolbox > Log Aggregator and save the 
logs to your local computer.

Workaround:  Restart the Engine Agent if you have attempted to view *.gz logs through the 
Agent page.

To restart the agent without disrupting clients:

1. Install PUTTY or similar SSH Client on the System Director, any client on the network, or 
on a system connected to the management port.

 http://www.chiark.greenend.org.uk/~sgtatham/putty/

2. Run SSH Client connecting to Storage Manager using an IP address listed in Management 
Console.

3. Login.

Username: root

Password: <local admin password> (Default se-admin)

4. Stop the Storage Manager web agent using the following command: 
/etc/init.d/userveragent stop

5. Wait approximately 30 seconds.

6. Restart the Storage Manager web agent using the following command: 
/etc/init.d/userveragent start

7. Wait approximately 30 seconds.

8. Verify the agent is running again by accessing the Management Console > Storage Manager 
> Agent page.

9. Close the SSH Client.

➤ Chinese and Korean characters are not supported in LDAP Sync Tool.

ISIS 7000 Infrastructure Issues

The following are known issues with the Avid ISIS 7000 infrastructure. When a workaround 
exists, it appears in the paragraph directly following the issue description.

http://www.chiark.greenend.org.uk/~sgtatham/putty/
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➤ Consistency check errors have found when playing back media that has been transcoded while 
on RAID 6 Workspaces. The transcoded media appears to be fine until you attempt to play it 
back. 

Projects and bins should not be shared on a RAID 6 Workspace. To share projects and bins, store 
them on a mirrored Workspace.

Workaround:  To transcode media on a RAID 6 Workspace, close the project, move the project 
and bin files to a local drive, perform the transcode, then move them back to the RAID 6 
Workspace. 

n You cannot share bins and projects when they are saved on a local drive.

➤ When reading media to do a mixdown on a “Westmere” Macintosh client with the Client Type 
set to Low Resolution in the Client Manager > Preferences > General settings, the Macintosh 
client might become unresponsive. 

Workaround:  Switch Client Type setting to Medium Resolution or High Resolution. 

➤ If the ISIS Management Console is opened from the Client Manager, and an Avid ISIS System 
Director failover occurs while the ISIS Management Console is open, the ISIS Management 
Console does not automatically reconnect to the new Active System Director. 

Workaround:  Once the Client Manager reconnects to the new Active System Director, restart 
the ISIS Management Console within the Client Manager to connect to the new Active System 
Director.

➤ ISIS v2.x has a install status of “Downloading” when updating the ISB and switch firmware. 
While in the downloading state, the blade is downloading the firmware package from the FTP 
Publishing service on the System Director. 

If a blade is in the downloading state for more than 15 minutes, it indicates a problem retrieving 
the package or connecting to the FTP service. 

Workaround:  Open the Agent page for the blade and click the Statistics tab and click Network. 
Look for errors on either eth0 of eth1. If there are errors: 

• Select “offline ISB”

• If possible move the ISB to a new engine. If the problem persists, replace the ISB.

• If the ISB cannot be moved to a new engine, move it to a different slot. If the problem 
persists, reseat the switch associated with the network errors (eth0 is associated with the 
right switch, eth1 is associated with the left switch). If the problem persists, replace the ISB.
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If no errors are displayed in the Network view of the Agent page, check cabling between the 
System Director and engine. Verify the FTP Publishing service is running on the System 
Director (right-click My Computer > Manage > Services). 

➤ If a client has a workspace mounted and that workspace is deleted within the Management 
Console and then recreated using the same name, the mounted workspace becomes inaccessible 
to the client, although it displays a green icon within Client Manager indicating that it is still 
accessible.

Workaround:  To access that workspace again, unmount the workspace using the client 
manager and then mount it again.

➤ When attempting to consolidate media from an Avid editing client on a RAID workspace that 
has a failed ISB, the consolidate function in the editing application might fail with an Exception 
error.

Workaround:  If the ISB failure cannot be repaired within your time frame, retry the 
consolidation again. The failure is intermittent.

➤ When the maximum number of licensed users are logged in to the Avid ISIS environment and 
another client attempts to log in, a “User authentication failed” error is displayed.

The message should state that the maximum number of licenses has been reached.

➤ Deleting an ISS from a stack does not clear the engine configuration.

Use the Reset Factory defaults button to clear stack configuration information.

➤ When in the Advanced tab of the Switch Agent page, if you select Switch Blade > “Reset to 
factory defaults” and enter the password to confirm the reset, one of the two switches in the 
engine becomes the master and the other switch keeps restarting. 

Workaround:  Log into the ISS Agent on the new master, click the System tab and select Basic, 
then click Submit in the Chassis Configuration window. 

➤ If a redistribution stops after a Storage Element has failed, it can indicate that the system is trying 
to fix parity blocks that no longer exist. 

Workaround:  Suspend and resume an in-progress redistribution to do a Block Rectify, using 
the Advanced Commands options available on the Workspaces page. The following steps are 
summarized. For detailed instructions, see the Avid ISIS Administration Guide. 

c Do not allow the RAID 6 redistribution to stay suspended for indefinite periods of time. 
Once the rectify completes, immediately resume the redistributions across all Workspaces.
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To suspend a redistribution and rectify blocks:

1. Suspend a redistribution: Management Console > Workspaces > Advanced Commands and 
select Suspend Redistribution.

2. Rectify files: Management Console > Storage Elements > Command and select Initiate 
Block Rectify.

3. Resume the redistribution: Management Console > Workspaces > Advanced Commands and 
select Resume Redistribution.

ISIS 5500 | 5000 Infrastructure Issues

The following are known issues with the Avid ISIS 5500 | 5000 infrastructure. When a 
workaround exists, it appears in the paragraph directly following the issue description.

➤ If your Avid ISIS experiences a fatal error to a blue screen, press and hold the power button until 
the system powers off and then power on the system again.

➤ When you make any changes in the storage group Details pane and click Close, you are asked if 
you would like to save your changes. If you click Yes, your changes are not saved. You must 
re-apply the changes and click Apply before you click Close. 

Workaround:  Always click Apply before you click Close.

➤ If there is a power failure with no spare data drive, an assert error could appear in the Windows 
System Event logs similar to the following. 

Assert Error from .\FScommLayer.cpp MAX_RESPONSE_SIZE

Workaround:  The System Director typically stops and automatically restarts but if it does not, 
power off the System Director and then restart it. 

File Gateway Issues

The following are known issues with the Avid File Gateway. When a workaround exists, it 
appears in the paragraph directly following the issue description.

➤ In the File Gateway Configuration Editor, if you enter a user name that contains a space, the part 
of the user name that follows the space will not be displayed in the User List after saving the 
configuration.

➤ The Avid ISIS File Gateway does not support Macintosh Common Internet File System (CIFS) 
clients that have non-ASCII user names (including Asian and Diacritical characters). An error 
occurs on the Macintosh client indicating you have an incorrect URL.
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➤ Macintosh CIFS Clients connected to the Avid ISIS File Gateway clients using the Terminal 
application hang when attempting to create a filename with invalid characters. Invalid characters 
are as follows:

? * < > | : " \ / 

This hang occurs on Mac OS 10.6.2 and later.

Workaround:  You must force quit or restart the Macintosh Finder to clear the copy dialog box. 

➤ If copying between the Avid ISIS File Gateway and a Macintosh CIFS client and the “share 
name” is renamed in the configuration file (on File Gateway server), the copy operation on the 
Macintosh client gets interrupted with an appropriate error message. Clicking OK closes the 
error message but the copy dialog remains displayed although nothing is being copied. Clicking 
cancel on the copy dialog also does not close the dialog box. The CIFS share cannot be ejected 
since it still appears to be in use.

Workaround:  You must force quit or restart the Macintosh Finder to clear the copy dialog box. 

➤ When ISIS File Gateway clients map ISIS Workspaces to their client systems, the Used and Free 
space values displayed in the Windows Properties window and the Macintosh Get Info window 
are not accurate. 
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/).

Part of the software embedded in this product is gSOAP software. 

Portions created by gSOAP are Copyright (C) 2001-2009 Robert A. van Engelen, Genivia inc. All Rights Reserved. 

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS 
PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR 
PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION 
MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER 
RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is 
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the 
software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or 
publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are 
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and 
use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be 
used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS 
PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

http://www.avid.com/US/about-avid/legal-notices/patent-marking
http://www.openssl.org/
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Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the 
above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting 
documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software 
without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any 
purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire 
notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the 
supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable 
for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of 
reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or 
consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the 
software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, 
knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this 
software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source 
Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are 
subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

http://www.apache.org/
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© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party 
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection 
with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a 
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the 
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, Assistant 
Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid 
DNxHD, Avid DS Assist Station, Avid Ignite, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, Avid Mojo, Avid 
Remote Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, Beat Detective, Beauty 
Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Bruno, C|24, CaptureManager, ChromaCurve, 
ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, Command|24, Command|8, 
Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, D-Command, D-Control, Deko, DekoCast, D-Fi, D-fx, Digi 002, Digi 003, 
DigiBase, Digidesign, Digidesign Audio Engine, Digidesign Development Partners, Digidesign Intelligent Noise Reduction, 
Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, DigiSnake, DigiSystem, Digital 
Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, Do More, DPP-1, D-Show, DSP 
Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, Expander, 
ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame Chase, FXDeko, 
HD Core, HD Process, HDpack, Home-to-Hollywood, HYBRID, HyperSPACE, HyperSPACE HDCAM, iKnowledge, Image 
Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, InGame, Instantwrite, Instinct, Intelligent Content 
Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, Intelli-sat Broadcasting Recording Manager, InterFX, 
Interplay, inTONE, Intraframe, iS Expander, iS9, iS18, iS23, iS36, ISIS, IsoSync, LaunchPad, LeaderPlus, LFX, Lightning, Link & 
Sync, ListSync, LKT-200, Lo-Fi, MachineControl, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, 
MassivePack, Massive Pack Pro, Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMix, Media Reader, Media 
Recorder, MEDIArray, MediaServer, MediaShare, MetaFuze, MetaSync, MIDI I/O, Mix Rack, Moviestar, MultiShell, NaturalMatch, 
NewsCutter, NewsView, NewsVision, Nitris, NL3D, NLP,  NSDOS, NSWIN,  OMF, OMF Interchange, OMM, OnDVD, Open Media 
Framework, Open Media Management,  Painterly Effects, Palladium, Personal Q, PET, Podcast Factory, PowerSwap, PRE, 
ProControl, ProEncode, Profiler, Pro Tools, Pro Tools|HD, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, QuickPunch, 
QuietDrive, Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket 
Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, ScriptSync, 
SecureProductionEnvironment, Serv|GT, Serv|LT,  Shape-to-Shape, ShuttleCase, Sibelius, SimulPlay, SimulRecord, Slightly Rude 
Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, SoundReplacer, SPACE, SPACEShift, SpectraGraph, SpectraMatte, 
SteadyGlide, Streamfactory, Streamgenie, StreamRAID, SubCap, Sundance, Sundance Digital, SurroundScope, Symphony, SYNC 
HD, SYNC I/O, Synchronic, SynchroScope,  Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, TimeLiner, Titansync, Titan, TL 
Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, 
tools for storytellers, Transit, TransJammer, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Video the Web Way, VideoRAID, 
VideoSPACE, VTEM, Work-N-Play, Xdeck, X-Form, Xmon and XPAND! are either registered trademarks or trademarks of Avid 
Technology, Inc. in the United States and/or other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or 
other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Autodesk, 
AutoCAD, HumanIK, Maya, MotionBuilder, Revit, and 3ds Max are registered trademarks or trademarks of Autodesk, Inc., and/or its 
subsidiaries and/or affiliates in the USA and/or other countries. Chelsio Communications and the Chelsio logo, and combinations 
thereof, are trademarks of Chelsio Communications, Inc. Cisco and Catalyst are registered trademarks of Cisco in the United States 
and certain other countries. Dell and Dell Precision are trademarks or registered trademarks of Dell Computer Corporation. Force10 
and Force10 Networks are registered trademarks of Force10 Networks, Inc. HP is a registered trademark of Hewlett-Packard 
Company. Intel is a registered trademark of Intel Corporation. Windows is either a registered trademark or trademark of Microsoft 
Corporation in the United States and/or other countries. All other trademarks contained herein are the property of their respective 
owners. 
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	Important Information
	Important Information
	Avid recommends that you read all the information in this ReadMe file thoroughly before installing software or attempting to use the Avid ISIS system. This ReadMe provides information that is not in the other Avid ISIS documentation.
	This is a common ReadMe used for the ISIS 7500 | 7000, ISIS 5500 | 5000 and ISIS 2000 infrastructures. Individual ReadMes no longer exist. New installations and upgrades run the same Autorun.exe file in the kit for installing the ISIS 7500 | 7000 Sys...
	References to ISIS 5500 in this documentation apply to both ISIS 5500 and ISIS 5000 with the exception of the following:
	• ISIS 5500-64. There was not an ISIS 5000-64.
	• ISIS 5500-64. There was not an ISIS 5000-64.
	• ISIS 5500-64. There was not an ISIS 5000-64.

	• ISIS 5500-16 has an installed 10 Gb Myricom board. In the ISIS 5000-16, the Myricom board was not installed with a shipping system. The Myricom board was an optional board in the ISIS 5000-16. 
	• ISIS 5500-16 has an installed 10 Gb Myricom board. In the ISIS 5000-16, the Myricom board was not installed with a shipping system. The Myricom board was an optional board in the ISIS 5000-16. 


	n Search the Avid Knowledge Base for the most up-to-date ReadMe file, which contains the latest information that might have become available after the documentation was published. To view the online version, visit the Knowledge Base at 
	n Search the Avid Knowledge Base for the most up-to-date ReadMe file, which contains the latest information that might have become available after the documentation was published. To view the online version, visit the Knowledge Base at 
	www.avid.com/support


	This document provides hardware and software requirements, a hardware overview, and other important information. This document also lists limitations and known issues. Physical connection of the system and loading of the system and client software is...
	Avid ISIS Setup Guide

	c Avid recommends that you purchase installation services with your Avid ISIS system. 
	c Avid recommends that you purchase installation services with your Avid ISIS system. 
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	Troubleshooting
	Troubleshooting
	Online support;Avid:online support



	If you are having trouble using your Avid product:
	If you are having trouble using your Avid product:
	If you are having trouble using your Avid product:

	1. Retry the action, carefully following the instructions given for that task in this guide. It is especially important to check each step of your workflow.
	1. Retry the action, carefully following the instructions given for that task in this guide. It is especially important to check each step of your workflow.
	1. Retry the action, carefully following the instructions given for that task in this guide. It is especially important to check each step of your workflow.

	2. Check the latest information that might have become available after the documentation was published.
	2. Check the latest information that might have become available after the documentation was published.
	New information is provided in the ReadMe file supplied on your Avid software kit as a PDF document and is also available online.
	New information is provided in the ReadMe file supplied on your Avid software kit as a PDF document and is also available online.
	You should always check online for the most up-to-date release notes or ReadMe because the online version is updated whenever new information becomes available. To view the online versions, visit the Knowledge Base at 
	You should always check online for the most up-to-date release notes or ReadMe because the online version is updated whenever new information becomes available.
	www.avid.com/US/support



	3. Check the documentation that came with your Avid application or your hardware for maintenance or hardware-related issues.
	3. Check the documentation that came with your Avid application or your hardware for maintenance or hardware-related issues.

	4. Visit the online Knowledge Base at 
	4. Visit the online Knowledge Base at 
	www.avid.com/US/support





	Accessing the Online Documentation
	Accessing the Online Documentation
	The Avid ISIS documentation is accessible in PDF format from the Help menu in the Avid ISIS Management Console browser window as well as on the top-level AvidISISDocumentation folder on the Avid ISIS software installer kit. 
	The Avid ISIS documentation is accessible in PDF format from the Help menu in the Avid ISIS Management Console browser window as well as on the top-level AvidISISDocumentation folder on the Avid ISIS software installer kit. 
	The Avid ISIS documentation is accessible in PDF format from the Help menu in the Avid ISIS Management Console browser window as well as on the top-level AvidISISDocumentation folder on the Avid ISIS software installer kit. 
	n The documentation describes the features and hardware of all models. Therefore, your system might not contain certain features and hardware that are covered in the documentation.
	n The documentation describes the features and hardware of all models. Therefore, your system might not contain certain features and hardware that are covered in the documentation.


	To access the online documentation from the installer kit:
	To access the online documentation from the installer kit:
	1. Load the Avid ISIS software installer kit onto your computer.
	1. Load the Avid ISIS software installer kit onto your computer.

	2. Navigate to the 
	2. Navigate to the 
	[drive]:
	\AvidISISDocumentation
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	Avid Training Services
	Avid:training services;Training services
	Avid:training services;Training services
	Avid:training services;Training services
	Avid:training services;Training services



	Avid makes lifelong learning, career advancement, and personal development easy and convenient. Avid understands that the knowledge you need to differentiate yourself is always changing, and Avid continually updates course content and offers new trai...
	Avid makes lifelong learning, career advancement, and personal development easy and convenient. Avid understands that the knowledge you need to differentiate yourself is always changing, and Avid continually updates course content and offers new trai...
	For information on courses/schedules, training centers, certifications, courseware, and books, please visit
	www.avid.com/support



	Product Terminology
	Product Terminology
	The following three sections give new users a brief description of ISIS component names.
	The following three sections give new users a brief description of ISIS component names.
	The following three sections give new users a brief description of ISIS component names.


	ISIS 7500 | 7000 Terminology
	ISIS 7500 | 7000 Terminology
	The major components used to create the Avid ISIS 7500 | 7000 shared storage network are: a System Director, an engine containing ISIS Integrated Switch (ISS), ISIS Integrated Expansion Switch (IXS), ISIS Storage Blade (ISB), and one or more clients. 
	The major components used to create the Avid ISIS 7500 | 7000 shared storage network are: a System Director, an engine containing ISIS Integrated Switch (ISS), ISIS Integrated Expansion Switch (IXS), ISIS Storage Blade (ISB), and one or more clients. 
	The major components used to create the Avid ISIS 7500 | 7000 shared storage network are: a System Director, an engine containing ISIS Integrated Switch (ISS), ISIS Integrated Expansion Switch (IXS), ISIS Storage Blade (ISB), and one or more clients. 
	Avid ISIS 7500 | 7000 Shared Storage Network Hardware
	<GRAPHIC>
	<GRAPHIC>
	<GRAPHIC>


	If you are unfamiliar with the names of the Avid ISIS 7500 | 7000 components, the following table provides the terms used in this and other Avid ISIS 7500 | 7000 documents.
	<TABLE>
	<TABLE>
	<TABLE HEADING>
	<TABLE ROW>
	Product Nomenclature (Continued)
	Product Nomenclature (Continued)


	<TABLE ROW>
	Product name
	Product 
	Product descriptions


	Term used and description
	Term used and description



	<TABLE BODY>
	<TABLE ROW>
	Avid ISIS storage blade (labeled i500, i1000, i2000, i4000, i8000)
	Avid ISIS storage blade (labeled i500, i1000, i2000, i4000, i8000)

	ISIS Storage Blade (ISB) 
	ISB (ISIS Storage Blade):describedISIS Storage Blade (ISB)
	ISB (ISIS Storage Blade):described

	This hot swappable sled is accessible from the front of the ISIS engine and contains two SATA drives. 


	<TABLE ROW>
	Avid ISIS Integrated Ethernet switch blade
	Avid ISIS Integrated Ethernet switch blade

	ISIS Integrated Switch (ISS) 
	ISS (ISIS Integrated Switch):describedISIS Integrated Switch (ISS) 
	ISS (ISIS Integrated Switch):described

	This hot swappable switch is accessible from the rear of the ISIS engine and connects 1 Gb and 10 Gb clients. The ISS2000 indicates second generation hardware; first generation hardware is labeled ISS1000.


	<TABLE ROW>
	Avid ISIS Integrated Expansion Ethernet switch blade
	Avid ISIS Integrated Expansion Ethernet switch blade

	ISIS Expansion Switch (IXS) 
	IXS (ISIS Expansion Switch):describedISIS Expansion Switch (IXS) 
	IXS (ISIS Expansion Switch):described

	This hot swappable switch is accessible from the rear of the ISIS engine is used to stack multiple ISIS Engines. The IXS switches are only found in configurations with three or more Engines. The IXS2000 indicates second generation hardware; first gen...


	<TABLE ROW>
	Integrated power supply and cooling fans
	Integrated power supply and cooling fans

	Power supplies 
	Power supplies
	Three hot swappable power supplies are accessible from the rear of the ISIS engine.Two power supplies are required to power the ISIS Engines.


	<TABLE ROW>
	Avid ISIS engine
	Avid ISIS engine

	Sometimes called Chassis in the Management Console interface 
	Sometimes called Chassis in the Management Console interface
	Contains the ISBs, ISSs, IXSs, power supplies, and an internal midplane.


	<TABLE ROW>
	Avid ISIS System Director (Active and standby)
	Avid ISIS System Director (Active and standby)

	System Director: a server connected to the ISIS engine to manage the file system and portions of the metadata
	System Director: a server connected to the ISIS engine to manage the file system and portions of the metadata


	<TABLE ROW>
	Avid ISIS client
	Avid ISIS client

	Client, defined as a user’s workstation or server with Avid ISIS client software installed that allows that system to mount workspaces
	Client, defined as a user’s workstation or server with Avid ISIS client software installed that allows that system to mount workspaces


	<TABLE ROW>
	Avid ISIS shared storage network
	Avid ISIS shared storage network

	System or shared network storage environment 
	System or shared network storage environment
	The Avid ISIS consist of the hardware, Avid software, and other hardware supplied by the customer, such as external Ethernet switches. 


	<TABLE ROW>
	Zone 1, Zone 2, Zone 3, and Zone 4 Configurations
	Zone 1, Zone 2, Zone 3, and Zone 4 Configurations

	These are Avid-defined client configurations that connect the client to the Avid ISIS system. A complete explanation can be found in the Avid ISIS 7500 | 7000 Setup Guide.
	These are Avid-defined client configurations that connect the client to the Avid ISIS system. A complete explanation can be found in the 
	Avid ISIS 7500 | 7000 Setup Guide









	ISIS 5500 Terminology
	ISIS 5500 Terminology
	A single Avid ISIS chassis provides System Director and Engine (Storage Server) functionality. Each Avid ISIS Engine is comprised of 16 media storage drives, two mirrored system drives, RAID controller, 10 Gigabit Ethernet interface, four 1 Gb Ethern...
	A single Avid ISIS chassis provides System Director and Engine (Storage Server) functionality. Each Avid ISIS Engine is comprised of 16 media storage drives, two mirrored system drives, RAID controller, 10 Gigabit Ethernet interface, four 1 Gb Ethern...
	A single Avid ISIS chassis provides System Director and Engine (Storage Server) functionality. Each Avid ISIS Engine is comprised of 16 media storage drives, two mirrored system drives, RAID controller, 10 Gigabit Ethernet interface, four 1 Gb Ethern...
	Avid ISIS 5500 Engines are available in three configurations;
	• ISIS 5500-16 — 16, 1 TB drives
	• ISIS 5500-16 — 16, 1 TB drives
	• ISIS 5500-16 — 16, 1 TB drives

	• ISIS 5500-32 — 16, 2 TB drives
	• ISIS 5500-32 — 16, 2 TB drives

	• ISIS 5500-64 — 16, 4 TB drives, includes 10 Gigabit Ethernet interface installed
	• ISIS 5500-64 — 16, 4 TB drives, includes 10 Gigabit Ethernet interface installed


	Either configuration supports an optional four port 1 Gb Ethernet Network Interface Card (NIC), which can be added to provide up to eight 1 Gb Ethernet interfaces (four built in plus four port NIC on a single engine configuration). Up to six Engines ...
	Engine connections are summarized in the following list. 
	• Direct Connect Clients — Four or eight 1 Gb Ethernet clients and one 10 Gb client connect directly into the System Director. Each client must be on a separate subnet and use a common subnet mask. 
	• Direct Connect Clients — Four or eight 1 Gb Ethernet clients and one 10 Gb client connect directly into the System Director. Each client must be on a separate subnet and use a common subnet mask. 
	• Direct Connect Clients — Four or eight 1 Gb Ethernet clients and one 10 Gb client connect directly into the System Director. Each client must be on a separate subnet and use a common subnet mask. 
	• Direct Connect Clients


	• Single Engine with 1 Gb Connection to the Switch — If you are using the four 1 Gb Ethernet connections from the System Director to a switch, each 1 Gb port on the System Director uses an IP address on the same subnet and a common subnet mask. 
	• Single Engine with 1 Gb Connection to the Switch — If you are using the four 1 Gb Ethernet connections from the System Director to a switch, each 1 Gb port on the System Director uses an IP address on the same subnet and a common subnet mask. 
	• Single Engine with 1 Gb Connection to the Switch


	• Single Engine with 10 Gb Connection to the Switch — If you are using the 10 Gb Ethernet connection from the System Director to a switch, the System Director uses one IP address. 
	• Single Engine with 10 Gb Connection to the Switch — If you are using the 10 Gb Ethernet connection from the System Director to a switch, the System Director uses one IP address. 
	• Single Engine with 10 Gb Connection to the Switch


	• Multi-
	• Multi-
	• Multi-
	Engine Connection to the Switch (10 Gb)







	ISIS 2000 Terminology
	ISIS 2000 Terminology
	An Avid ISIS 2000 uses an external AS3000 System Director similar to the ISIS 7500 | 7000 (see 
	An Avid ISIS 2000 uses an external AS3000 System Director similar to the ISIS 7500 | 7000 (see 
	An Avid ISIS 2000 uses an external AS3000 System Director similar to the ISIS 7500 | 7000 (see 
	ISIS 7500 | 7000 Terminology

	Avid ISIS 2000 Engine
	<GRAPHIC>
	<GRAPHIC>
	<GRAPHIC>


	Up to five Engines with 3 TB media storage drives are supported in the ISIS 2000 environment providing 1.2 petabyte (PB) of raw storage (960 TB usable storage). Avid ISIS 2000 Engines are available in two configurations:
	• ISIS 2000-240 — 82, 3 TB drives, providing 240 TB of raw storage which equates to 192 TB of usable storage
	• ISIS 2000-240 — 82, 3 TB drives, providing 240 TB of raw storage which equates to 192 TB of usable storage
	• ISIS 2000-240 — 82, 3 TB drives, providing 240 TB of raw storage which equates to 192 TB of usable storage

	• ISIS 2000-120 — 42, 3 TB drives, providing 120 TB of raw storage which equates to 96 TB of usable storage
	• ISIS 2000-120 — 42, 3 TB drives, providing 120 TB of raw storage which equates to 96 TB of usable storage


	The ISIS 2000 System Director connects to an ISIS qualified switch using either a 1 Gb or 10 Gb connection. The ISIS 2000 Engine connects to that same switch using a 10 Gb connection. Both models of Avid ISIS 2000 Engines are populated with 3 terabyt...
	The ISIS 2000 nearline system workflows provides basic video playback of low bit rate media and high-speed file transfers to online ISIS systems. 




	New in Avid ISIS v4.6.1
	New in Avid ISIS v4.6.1
	Integrity Hardening
	Integrity Hardening
	Integrity Hardening
	The ISIS v4.6.1 patch kit offers improvements in data protection when a Storage Manager cannot write to its peer and becomes unresponsive to the rest of the system.

	Auto-Rectify Option
	Auto-Rectify Option
	The ISIS v4.6.1 patch kit includes a new option in the Management Console. You can now enable Auto-Rectify, which automatically reconciles the actual amount of used space and the reported amount of used space on a system.
	To enable Auto-Rectify, click Preferences under the Advanced heading. Click the check box, and then click Save Preferences.
	The following figure shows the location of the Auto-Rectify check box: 
	<GRAPHIC>
	<GRAPHIC>



	Final Supported Release Stream for Some Avid Products
	Final Supported Release Stream for Some Avid Products
	The v4.6.x release stream is the last to officially support the following products:
	• AirSpeed Classic
	• AirSpeed Classic
	• AirSpeed Classic

	• Final Cut Pro 7.x
	• Final Cut Pro 7.x

	• Media Composer 5.5.x and 6.0.x
	• Media Composer 5.5.x and 6.0.x

	• NewsCutter 9.5.x and 10.0.x
	• NewsCutter 9.5.x and 10.0.x

	• Symphony 5.5.x and 6.0.x
	• Symphony 5.5.x and 6.0.x

	• Windows Vista 32 and 64
	• Windows Vista 32 and 64

	• Windows XP (AirSpeed Multi Stream will still be supported)
	• Windows XP (AirSpeed Multi Stream will still be supported)



	Fixed in This Release
	Fixed in This Release
	The following issues were fixed in v4.6.1.

	If the scratch drive in Final Cut Pro was set to an ISIS Workspace and any video or audio effect was rendered, “
	If the scratch drive in Final Cut Pro was set to an ISIS Workspace and any video or audio effect was rendered, “
	If the scratch drive in Final Cut Pro was set to an ISIS Workspace and any video or audio effect was rendered, “
	error: not found



	Media write issue on the Mac client, seen when doing AS11 exports from Media Composer. The exported file had inconsistencies and AMA-linking displayed an error message saying the plug-in does not support the file.
	Media write issue on the Mac client, seen when doing AS11 exports from Media Composer. The exported file had inconsistencies and AMA-linking displayed an error message saying the plug-in does not support the file.
	Media write issue on the Mac client, seen when doing AS11 exports from Media Composer. The exported file had inconsistencies and AMA-linking displayed an error message saying the plug-in does not support the file.


	Issue on ISIS client installation of AirSpeed5000. Under some circumstances, the Performance Monitor database in the registry got corrupted, causing the installation of the ISIS Performance Monitor counters to fail.
	Issue on ISIS client installation of AirSpeed5000. Under some circumstances, the Performance Monitor database in the registry got corrupted, causing the installation of the ISIS Performance Monitor counters to fail.
	Issue on ISIS client installation of AirSpeed5000. Under some circumstances, the Performance Monitor database in the registry got corrupted, causing the installation of the ISIS Performance Monitor counters to fail.


	Removing an ISIS7000 blade and unbinding it before redistribution completed resulted in hung clients.
	Removing an ISIS7000 blade and unbinding it before redistribution completed resulted in hung clients.
	Removing an ISIS7000 blade and unbinding it before redistribution completed resulted in hung clients.


	Microsoft hotfix available for ISIS 5500 | 5000 systems. The v4.6.1 Autorun installer contains Microsoft hotfix KB2685007, which corrects an issue with ISIS 5500 | 5000 systems running Windows Storage Server R2. For details about the hotfix, see the ...
	Microsoft hotfix available for ISIS 5500 | 5000 systems. The v4.6.1 Autorun installer contains Microsoft hotfix KB2685007, which corrects an issue with ISIS 5500 | 5000 systems running Windows Storage Server R2. For details about the hotfix, see the ...
	Microsoft hotfix available for ISIS 5500 | 5000 systems. The v4.6.1 Autorun installer contains Microsoft hotfix KB2685007, which corrects an issue with ISIS 5500 | 5000 systems running Windows Storage Server R2. For details about the hotfix, see the ...
	http://support.microsoft.com/kb/2685007/EN-US
	http://support.microsoft.com/kb/2685007/EN-US




	During board replacement, an ISB incorrectly advertised itself as an i500. Now the ISB displays a generic type until the metadata has been read and the actual ISB type is known to the system.
	During board replacement, an ISB incorrectly advertised itself as an i500. Now the ISB displays a generic type until the metadata has been read and the actual ISB type is known to the system.
	During board replacement, an ISB incorrectly advertised itself as an i500. Now the ISB displays a generic type until the metadata has been read and the actual ISB type is known to the system.


	Could not access all data on an ISIS 7500 | 7000 with one failed drive. In v4.6.1 and later, if the Storage Manager is bound, it is allowed to run with only the one good drive (in the active but disk failed state) so that data can be retrieved from it.
	Could not access all data on an ISIS 7500 | 7000 with one failed drive. In v4.6.1 and later, if the Storage Manager is bound, it is allowed to run with only the one good drive (in the active but disk failed state) so that data can be retrieved from it.
	Could not access all data on an ISIS 7500 | 7000 with one failed drive. In v4.6.1 and later, if the Storage Manager is bound, it is allowed to run with only the one good drive (in the active but disk failed state) so that data can be retrieved from it.


	Upgrading a half-populated ISIS 2000 fails to complete the file system metadata conversion. This occurs when upgrading from v4.2 to v4.5 or v4.6.
	Upgrading a half-populated ISIS 2000 fails to complete the file system metadata conversion. This occurs when upgrading from v4.2 to v4.5 or v4.6.
	Upgrading a half-populated ISIS 2000 fails to complete the file system metadata conversion. This occurs when upgrading from v4.2 to v4.5 or v4.6.


	ISIS client hang introduced in ISIS v4.6. The hang occurred on both Mac and Windows clients while doing consolidates, transcodes, and playback, especially variable speed playback. In v4.6, to clear the error you had to reboot the system. This issue h...
	ISIS client hang introduced in ISIS v4.6. The hang occurred on both Mac and Windows clients while doing consolidates, transcodes, and playback, especially variable speed playback. In v4.6, to clear the error you had to reboot the system. This issue h...
	ISIS client hang introduced in ISIS v4.6. The hang occurred on both Mac and Windows clients while doing consolidates, transcodes, and playback, especially variable speed playback. In v4.6, to clear the error you had to reboot the system. This issue h...


	Could not perform Send-To-Playback operation on a sequence containing media being ingested. Job was static for several minutes then failed with “Transfer Cancelled” error message. This issue was found in v4.6 and fixed in v4.6.1.
	Could not perform Send-To-Playback operation on a sequence containing media being ingested. Job was static for several minutes then failed with “Transfer Cancelled” error message. This issue was found in v4.6 and fixed in v4.6.1.
	Could not perform Send-To-Playback operation on a sequence containing media being ingested. Job was static for several minutes then failed with “Transfer Cancelled” error message. This issue was found in v4.6 and fixed in v4.6.1.




	New in Avid ISIS v4.6
	New in Avid ISIS v4.6
	The ISIS v4.6 software kit includes updates for the ISIS 7500 | 7000, ISIS 5500 | 5000, and ISIS 2000 System Directors, Engines, and clients. Once you update your infrastructure to ISIS v4.6, you cannot revert the infrastructure back to a previous re...
	The ISIS v4.6 software kit includes updates for the ISIS 7500 | 7000, ISIS 5500 | 5000, and ISIS 2000 System Directors, Engines, and clients. Once you update your infrastructure to ISIS v4.6, you cannot revert the infrastructure back to a previous re...
	• ISIS 7500 | 7000 v4.0.1, v4.0.3, v4.0.4, v4.5 and v4.6
	• ISIS 7500 | 7000 v4.0.1, v4.0.3, v4.0.4, v4.5 and v4.6
	• ISIS 7500 | 7000 v4.0.1, v4.0.3, v4.0.4, v4.5 and v4.6
	• ISIS 7500 | 7000 v4.0.1, v4.0.3, v4.0.4, v4.5 and v4.6

	• ISIS 5500 | 5000 v4.0.1, v4.0.3, and v4.5, and v4.6
	• ISIS 5500 | 5000 v4.0.1, v4.0.3, and v4.5, and v4.6

	• ISIS 2000 v4.1, v4.2, v4.5 and v6
	• ISIS 2000 v4.1, v4.2, v4.5 and v6



	The following is a list of what’s new in the Avid ISIS v4.6 release.
	• This release supports the ISIS 7500 128TB Engine.
	• This release supports the ISIS 7500 128TB Engine.
	• This release supports the ISIS 7500 128TB Engine.


	• Avid has added support for Windows v8.1 and Mac OSX v10.9.x
	• Avid has added support for Windows v8.1 and Mac OSX v10.9.x
	• Avid has added support for Windows v8.1 and Mac OSX v10.9.x
	n If you are running Windows v8.1, a new driver is required for configurations running with an Intel 1Gb Network adapter. This driver v18.6 is included in the ISIS Installation Kit: \Drivers\ISIS Client. Note: Currently, the v18.6 driver has only bee...
	n If you are running Windows v8.1, a new driver is required for configurations running with an Intel 1Gb Network adapter. This driver v18.6 is included in the ISIS Installation Kit: \Drivers\ISIS Client. Note: Currently, the v18.6 driver has only bee...


	• The Login Dialog. The login dialog has changed to eliminate the need to manually type in the protocol and port. The application will automatically figure out the connection settings based on the host name and type of application.
	• The Login Dialog. The login dialog has changed to eliminate the need to manually type in the protocol and port. The application will automatically figure out the connection settings based on the host name and type of application.

	• Storage Manager Log Viewer: The Storage Manager Log Viewer is now incorporated into the ISIS Toolbox application. It is no longer a standalone application. As part of the Toolbox, you no longer have to log in to every single blade to view the log...
	• Storage Manager Log Viewer: The Storage Manager Log Viewer is now incorporated into the ISIS Toolbox application. It is no longer a standalone application. As part of the Toolbox, you no longer have to log in to every single blade to view the log...




	Software Installation Instructions
	Software Installation Instructions
	Avid ISIS 7500 | 7000 v4.6, ISIS 5500 | 5000 v4.6, and ISIS 2000 v4.6 infrastructure software requires Avid ISIS v4.6 and later Client Manager software. The following is a summarized version of the procedure. The 
	Avid ISIS 7500 | 7000 v4.6, ISIS 5500 | 5000 v4.6, and ISIS 2000 v4.6 infrastructure software requires Avid ISIS v4.6 and later Client Manager software. The following is a summarized version of the procedure. The 
	Avid ISIS Setup Guide

	• ISIS 7500 | 7000 Software Installation on New Systems
	• ISIS 7500 | 7000 Software Installation on New Systems
	• ISIS 7500 | 7000 Software Installation on New Systems
	• ISIS 7500 | 7000 Software Installation on New Systems


	• ISIS 7500 | 7000 Upgrades
	• ISIS 7500 | 7000 Upgrades
	• ISIS 7500 | 7000 Upgrades


	• Avid ISIS 5500 | 5000 Software Installation
	• Avid ISIS 5500 | 5000 Software Installation
	• Avid ISIS 5500 | 5000 Software Installation


	• Avid ISIS 2000 Software Installation
	• Avid ISIS 2000 Software Installation
	• Avid ISIS 2000 Software Installation


	• Avid ISIS Client Software Installation
	• Avid ISIS Client Software Installation
	• Avid ISIS Client Software Installation



	The clients are defined as follows:
	• Avid editing applications (see 
	• Avid editing applications (see 
	• Avid editing applications (see 
	“Avid ISIS Client Software Installation” on page 32


	• Interplay Assist and Instinct
	• Interplay Assist and Instinct

	• Interplay Access
	• Interplay Access

	• Avid Approved Applications Initiative such as Pro Tools and Final Cut Pro
	• Avid Approved Applications Initiative such as Pro Tools and Final Cut Pro


	The infrastructure is defined as follows:
	• ISIS 7500 | 7000 System Directors — System Director software and upgrade Storage Blades (ISBs) and Switch Blades (ISS/IXSs) in the Avid ISIS Engines to the latest firmware
	• ISIS 7500 | 7000 System Directors — System Director software and upgrade Storage Blades (ISBs) and Switch Blades (ISS/IXSs) in the Avid ISIS Engines to the latest firmware
	• ISIS 7500 | 7000 System Directors — System Director software and upgrade Storage Blades (ISBs) and Switch Blades (ISS/IXSs) in the Avid ISIS Engines to the latest firmware

	• ISIS 5500 | 5000 Engines — System Director and additional Engines
	• ISIS 5500 | 5000 Engines — System Director and additional Engines

	• ISIS 2000 System Directors — System Director software and upgrade Storage Managers in the Avid ISIS Engines to the latest code
	• ISIS 2000 System Directors — System Director software and upgrade Storage Managers in the Avid ISIS Engines to the latest code

	• Interplay servers — Interplay Engine, Interplay Media Indexer, Interplay Transfer, and CaptureManager
	• Interplay servers — Interplay Engine, Interplay Media Indexer, Interplay Transfer, and CaptureManager

	• Capture devices — AirSpeed 5000, AirSpeed Multi Stream, and AirSpeed
	• Capture devices — AirSpeed 5000, AirSpeed Multi Stream, and AirSpeed



	Avid ISIS 7500 | 7000 Software Installation
	Avid ISIS 7500 | 7000 Software Installation
	To upgrade to this release, run the Autorun.exe installer to install Avid ISIS 7500 | 7000 software on the System Director and Upgrade Storage Blades (ISBs) and Switch Blades (ISS/IXSs) in the Avid engines. The Avid ISIS clients must be running ISIS ...
	To upgrade to this release, run the Autorun.exe installer to install Avid ISIS 7500 | 7000 software on the System Director and Upgrade Storage Blades (ISBs) and Switch Blades (ISS/IXSs) in the Avid engines. The Avid ISIS clients must be running ISIS ...
	n When installing the Avid ISIS 7500 | 7000 software, you no longer need to open the Windows Control Panel on the System Director to uninstall the earlier version of the Avid ISIS System Director software. All of the previous Avid ISIS software is au...
	n When installing the Avid ISIS 7500 | 7000 software, you no longer need to open the Windows Control Panel on the System Director to uninstall the earlier version of the Avid ISIS System Director software. All of the previous Avid ISIS software is au...


	Component Requirements From Previous ISIS 7500 | 7000 Releases
	Component Requirements From Previous ISIS 7500 | 7000 Releases
	The following is a list of items outside the ISIS software that you might need to update depending on the current version of your ISIS software. If you are on a version prior to 4.0, Avid recommends that you update your System Director Storage Blades...
	The following is a list of items outside the ISIS software that you might need to update depending on the current version of your ISIS software. If you are on a version prior to 4.0, Avid recommends that you update your System Director Storage Blades...
	ISIS 7500 | 7000 Upgrades

	• If updating from ISIS v2.4 – v4.0 — update the ISIS 7000 System Director software before Installing this release of ISIS 7000 software. See 
	• If updating from ISIS v2.4 – v4.0 — update the ISIS 7000 System Director software before Installing this release of ISIS 7000 software. See 
	• If updating from ISIS v2.4 – v4.0 — update the ISIS 7000 System Director software before Installing this release of ISIS 7000 software. See 
	Avid ISIS v4.0 ReadMe
	n Remember to copy your metadata to the new v4.x location; see 
	n Remember to copy your metadata to the new v4.x location; see 
	ISIS 7500 | 7000 Upgrades




	• If updating from ISIS v2.0 – v2.0.6 to v2.4 — update the System Director Intel system BIOS on the 64-bit System Director (SR2500). See 
	• If updating from ISIS v2.0 – v2.0.6 to v2.4 — update the System Director Intel system BIOS on the 64-bit System Director (SR2500). See 
	Avid ISIS v2.2.2 ReadMe


	• If updating from ISIS v2.0 – v2.0.6 to v2.4 — update the Intel RAID controller driver and registry key on the 64-bit System Director. See 
	• If updating from ISIS v2.0 – v2.0.6 to v2.4 — update the Intel RAID controller driver and registry key on the 64-bit System Director. See 
	Avid ISIS v2.2.2 ReadMe


	• If updating from ISIS v2.0 – v2.0.3 to v2.4 — update the System Director to allow Windows Updates,. See 
	• If updating from ISIS v2.0 – v2.0.3 to v2.4 — update the System Director to allow Windows Updates,. See 
	Avid ISIS v2.2.2 ReadMe


	• If updating from ISIS v2.0 – v2.0.1 to v2.4 — update the System Director application key (dongle). See 
	• If updating from ISIS v2.0 – v2.0.1 to v2.4 — update the System Director application key (dongle). See 
	Avid ISIS v2.2.2 ReadMe


	• If updating from ISIS v1.4 – v2.0.1 to v2.4 — you must first upgrade to Avid ISIS v2.1.1 before upgrading to v2.4, For instructions. See 
	• If updating from ISIS v1.4 – v2.0.1 to v2.4 — you must first upgrade to Avid ISIS v2.1.1 before upgrading to v2.4, For instructions. See 
	Avid ISIS v2.1.1 ReadMe





	ISIS 7500 | 7000 Software Installation on New Systems
	ISIS 7500 | 7000 Software Installation on New Systems
	Avid ISIS Systems ship with one blank 8GB USB Drive that is intended to be used for storing the ISIS Software Kit. Download the ISIS software kit from the download center (
	Avid ISIS Systems ship with one blank 8GB USB Drive that is intended to be used for storing the ISIS Software Kit. Download the ISIS software kit from the download center (
	Avid ISIS Systems ship with one blank 8GB USB Drive that is intended to be used for storing the ISIS Software Kit. Download the ISIS software kit from the download center (
	www.avid.com/US/support/downloads

	The 
	Avid ISIS 7500 | 7000 Setup Guide

	n In the past Avid has instructed you stop the Standby System director, upgrade the Standby, and restart the Standby. Once the Standby was running you were instructed to update the Active System Director. 
	n In the past Avid has instructed you stop the Standby System director, upgrade the Standby, and restart the Standby. Once the Standby was running you were instructed to update the Active System Director. 
	Avid has revised the upgrade process to stop the Standby System Director and upgrade the Active System Director first, then upgrade the Standby System Director. This process avoids replicating metadata between ISIS software versions.


	To install your ISIS 7500 | 7000 software on new systems:
	To install your ISIS 7500 | 7000 software on new systems:
	1. Log in to the Avid ISIS 7500 | 7000 System Director as Administrator (default password: 
	1. Log in to the Avid ISIS 7500 | 7000 System Director as Administrator (default password: 
	is-admin


	2. Make a folder for the software kit on your root directory (C:\) of your Active System Director.
	2. Make a folder for the software kit on your root directory (C:\) of your Active System Director.

	3. Insert the software USB flash drive into any USB port on your Active System Director.
	3. Insert the software USB flash drive into any USB port on your Active System Director.
	n You can run the software installer from the USB flash drive. The advantage of copying the software kit to the Avid ISIS 7500 | 7000 is that you have easy access to kit files if you need them later.
	n You can run the software installer from the USB flash drive. The advantage of copying the software kit to the Avid ISIS 7500 | 7000 is that you have easy access to kit files if you need them later.
	n You can run the software installer from the USB flash drive. The advantage of copying the software kit to the Avid ISIS 7500 | 7000 is that you have easy access to kit files if you need them later.

	If the USB flash drive does not automatically display:

	a. Double-click the computer icon on the desktop. 
	a. Double-click the computer icon on the desktop. 
	a. Double-click the computer icon on the desktop. 

	b. Double-click the USB flash drive icon in the window and copy the software kit into the new folder you created on the Avid ISIS 7500 | 7000 system. 
	b. Double-click the USB flash drive icon in the window and copy the software kit into the new folder you created on the Avid ISIS 7500 | 7000 system. 



	4. Double-click the Autorun.exe file in the root directory of software kit.
	4. Double-click the Autorun.exe file in the root directory of software kit.
	The installer detects the existing version of the installed software (if any) and displays the components that need to be upgraded in the splash screen. 
	The installer detects the existing version of the installed software (if any) and displays the components that need to be upgraded in the splash screen. 
	n If the Package Selection menu does not allow you to select the software, click Quit and run Autorun.exe again.
	n If the Package Selection menu does not allow you to select the software, click Quit and run Autorun.exe again.



	5. Select ISIS 7500 | 7000 System Director from the “Select Software Package” menu. 
	5. Select ISIS 7500 | 7000 System Director from the “Select Software Package” menu. 
	The File Gateway selection is used when loading the Avid File Gateway server. The File Gateway software cannot be installed on the same server as the System Director software.
	The File Gateway selection is used when loading the Avid File Gateway server. The File Gateway software cannot be installed on the same server as the System Director software.


	6. Click Apply.
	6. Click Apply.

	7. Follow the screen prompts accepting the defaults and License agreement.
	7. Follow the screen prompts accepting the defaults and License agreement.

	8. Once the installation is complete, click Finish.
	8. Once the installation is complete, click Finish.

	9. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > Avid License Control and activate your Avid ISIS license. For detailed license activation instructions, see the 
	9. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > Avid License Control and activate your Avid ISIS license. For detailed license activation instructions, see the 
	Avid ISIS 7500 | 7000 Setup Guide

	You will need the System ID and Activation ID card included with your new System Director.
	You will need the System ID and Activation ID card included with your new System Director.


	10. Run the Product Recovery tool to create a Product Recovery USB flash drive. 
	10. Run the Product Recovery tool to create a Product Recovery USB flash drive. 
	n For information on creating the Product Recovery USB flash drive, see the 
	n For information on creating the Product Recovery USB flash drive, see the 
	n For information on creating the Product Recovery USB flash drive, see the 
	Avid ISIS 7500 | 7000 Setup Guide, Avid ISIS 2000 Setup Guide or Avid ISIS 5500 | 5000 Setup Guide
	Avid ISIS Administration Guide




	11. Open the ISIS Control Panel. 
	11. Open the ISIS Control Panel. 
	a. Click Stop System Director.
	a. Click Stop System Director.
	a. Click Stop System Director.

	b. Click Configure File System.
	b. Click Configure File System.

	c. Select Create Active File System and click OK.
	c. Select Create Active File System and click OK.



	12. Open the Management Console. 
	12. Open the Management Console. 
	Log in using the Administrator user name and leave the password field blank.
	Log in using the Administrator user name and leave the password field blank.

	a. Load the ISBs and ISS/IXSs firmware. Using the ISIS Management Console > Engines page, select all the Engines and click Upgrade Blades and then select all your ISS/IXSs and click Upgrade Switches. ISB and ISS/IXS upgrades can run at the same time....
	a. Load the ISBs and ISS/IXSs firmware. Using the ISIS Management Console > Engines page, select all the Engines and click Upgrade Blades and then select all your ISS/IXSs and click Upgrade Switches. ISB and ISS/IXS upgrades can run at the same time....
	a. Load the ISBs and ISS/IXSs firmware. Using the ISIS Management Console > Engines page, select all the Engines and click Upgrade Blades and then select all your ISS/IXSs and click Upgrade Switches. ISB and ISS/IXS upgrades can run at the same time....
	Avid ISIS 7000 Setup Guide

	You can watch the upgrade progress in your Monitoring tool.
	You can watch the upgrade progress in your Monitoring tool.


	b. Bind the ISBs. Using the ISIS Management Console > Storage Managers page, select your ISIS Storage Mangers in the list and click Bind.
	b. Bind the ISBs. Using the ISIS Management Console > Storage Managers page, select your ISIS Storage Mangers in the list and click Bind.

	c. Create a Storage Group, Workspaces, and add Users in the Management Console.
	c. Create a Storage Group, Workspaces, and add Users in the Management Console.



	13. Install your Avid ISIS client software. For information, see 
	13. Install your Avid ISIS client software. For information, see 
	Avid ISIS Client Software Installation
	Avid ISIS Client Guide





	ISIS 7500 | 7000 Upgrades
	ISIS 7500 | 7000 Upgrades
	The following process summarizes the upgrade process to v4.6. Avid ISIS 7500 | 7000 v4.6 infrastructure software requires Avid ISIS v4.6 or later Client Manager software. 
	The following process summarizes the upgrade process to v4.6. Avid ISIS 7500 | 7000 v4.6 infrastructure software requires Avid ISIS v4.6 or later Client Manager software. 
	The following process summarizes the upgrade process to v4.6. Avid ISIS 7500 | 7000 v4.6 infrastructure software requires Avid ISIS v4.6 or later Client Manager software. 
	n If you have a 32-bit System Director, you must upgrade to a 64-bit System Director before loading your new ISIS v4.x software. 
	n If you have a 32-bit System Director, you must upgrade to a 64-bit System Director before loading your new ISIS v4.x software. 

	n If you are upgrading from a version earlier than Avid ISIS v4.0, you must first perform the updates documented in 
	n If you are upgrading from a version earlier than Avid ISIS v4.0, you must first perform the updates documented in 
	“Component Requirements From Previous ISIS 7500 | 7000 Releases” on page 14


	Review the following general comments on upgrading System Directors and the ISIS file system metadata: 
	• The preferred method of upgrading the file system metadata is using Partition0 and Partition1. These are copies of the in-memory file system and the most accurate accounting of the ISIS. 
	• The preferred method of upgrading the file system metadata is using Partition0 and Partition1. These are copies of the in-memory file system and the most accurate accounting of the ISIS. 
	• The preferred method of upgrading the file system metadata is using Partition0 and Partition1. These are copies of the in-memory file system and the most accurate accounting of the ISIS. 

	• The PartitionDump.bin file is a very different representation of what Avid believes to be the important parts of the file system that should persist. Do not be tempted to just import PartitionDump.bin, although this may be necessary if problems a...
	• The PartitionDump.bin file is a very different representation of what Avid believes to be the important parts of the file system that should persist. Do not be tempted to just import PartitionDump.bin, although this may be necessary if problems a...
	Never use the PartitionDump.bin from the standby System Director in an upgrade.


	• Sometimes one of the Partition files fails to load but the other succeeds. This is considered a successful upgrade and is still the preferred method of upgrading.
	• Sometimes one of the Partition files fails to load but the other succeeds. This is considered a successful upgrade and is still the preferred method of upgrading.

	• There have been cases of loading old PartitionDump.bin files and losing data. Always contact your support team before attempting to import PartitionDump.bin.
	• There have been cases of loading old PartitionDump.bin files and losing data. Always contact your support team before attempting to import PartitionDump.bin.

	• There is a bug in ISIS versions 3.1 through 4.5 where the tie breakers are deleted when importing PartitionDump.bin. When importing PartitionDump.bin it is important to manually record the tie breakers before beginning the upgrade and restore the...
	• There is a bug in ISIS versions 3.1 through 4.5 where the tie breakers are deleted when importing PartitionDump.bin. When importing PartitionDump.bin it is important to manually record the tie breakers before beginning the upgrade and restore the...


	Depending on what version you are upgrading from or to there are different steps required. This guide contains common setup and finishing steps but different intermediate steps based on the upgrade. Read through once and identify your upgrade before ...

	Common Setup Steps
	Common Setup Steps
	1. Download the ISIS v4.6 software kit from the Avid Download Center (
	1. Download the ISIS v4.6 software kit from the Avid Download Center (
	www.avid.com/US/support/downloads


	2. Create a new “test” workspace in a storage group. (You will use this later to verify that the upgrade completed successfully.)
	2. Create a new “test” workspace in a storage group. (You will use this later to verify that the upgrade completed successfully.)

	3. Log into Administrator account on the Standby System Director and open the System Director Control Panel. Wait for the indication that metadata changes have been received and saved. Allow this to happen twice. Stop the Standby System Director usin...
	3. Log into Administrator account on the Standby System Director and open the System Director Control Panel. Wait for the indication that metadata changes have been received and saved. Allow this to happen twice. Stop the Standby System Director usin...

	4. Log into active System Director and do the following:
	4. Log into active System Director and do the following:
	a. Open the System Director Log Viewer.
	a. Open the System Director Log Viewer.
	a. Open the System Director Log Viewer.

	b. Stop the System Director using the System Director Control Panel.
	b. Stop the System Director using the System Director Control Panel.
	c If there are any errors, stop and contact your support team.
	c If there are any errors, stop and contact your support team.
	c If there are any errors, stop and contact your support team.





	5. Check the modify date time of the files Partition0, Partition1 and PartitionDump.bin. The Date Modified times should be identical or up to a maximum of one minute different. 
	5. Check the modify date time of the files Partition0, Partition1 and PartitionDump.bin. The Date Modified times should be identical or up to a maximum of one minute different. 
	If the times differ by more than a minute, stop and contact your support team
	If they are more than a few minutes old, stop and contact your support team



	To upgrade from v2.4 to v4.2.1 on the same hardware:
	To upgrade from v2.4 to v4.2.1 on the same hardware:
	1. Follow the steps in 
	1. Follow the steps in 
	“Common Setup Steps” on page 17


	2. Load the ISIS v4.x software kit on the Active System Director.
	2. Load the ISIS v4.x software kit on the Active System Director.

	3. Double-click Autorun.exe.
	3. Double-click Autorun.exe.
	n If the Package Selection menu does not allow you to select the software, click Quit and run Autorun.exe again.
	n If the Package Selection menu does not allow you to select the software, click Quit and run Autorun.exe again.
	n If the Package Selection menu does not allow you to select the software, click Quit and run Autorun.exe again.



	4. When the installation completes, open the System Director Control Panel and stop the System Director.
	4. When the installation completes, open the System Director Control Panel and stop the System Director.

	5. Copy (not move) the following files from the v2.x folder to the v4.x folder:
	5. Copy (not move) the following files from the v2.x folder to the v4.x folder:
	Partition0 and Partition1
	Partition0 and Partition1
	Old v2.
	x
	D:\Program Files\Avid Technology\AvidUnityISISSystemDirector

	New v4.
	x
	D:\Program Files\Avid\ISIS System Director



	6. Open the System Director Log viewer.
	6. Open the System Director Log viewer.

	7. In the System Director Control Panel select “Start System Director.” If there are problems with the upgrade of the Partition file, stop and contact your support team.
	7. In the System Director Control Panel select “Start System Director.” If there are problems with the upgrade of the Partition file, stop and contact your support team.

	8. When the reconfigure completes the active System Director will be up and running. Proceed to 
	8. When the reconfigure completes the active System Director will be up and running. Proceed to 
	“Completing the Upgrade” on page 20



	To upgrade from 2.4 to v4.X and from an SR2400/SR2500 to an AS3000:
	To upgrade from 2.4 to v4.X and from an SR2400/SR2500 to an AS3000:
	1. Determine if you are moving from a 32-bit System Director:
	1. Determine if you are moving from a 32-bit System Director:
	In this upgrade you must move the file system metadata files from the SR2400 or SR2500 to the AS3000, using either a network folder or memory stick. In v4.0, the folder where the System Director software resides was changed. You must copy the Partiti...
	In this upgrade you must move the file system metadata files from the SR2400 or SR2500 to the AS3000, using either a network folder or memory stick. In v4.0, the folder where the System Director software resides was changed. You must copy the Partiti...
	- From v2.X metadata location for a 32 bit System Director
	- From v2.X metadata location for a 32 bit System Director
	- From v2.X metadata location for a 32 bit System Director
	- D:\Program Files\Avid Technology\AvidUnityISISSystemDirector
	- D:\Program Files\Avid Technology\AvidUnityISISSystemDirector
	- D:\Program Files\Avid Technology\AvidUnityISISSystemDirector



	- From v2.X metadata location for a 64 bit System Director
	- From v2.X metadata location for a 64 bit System Director
	- D:\Program Files\Avid Technology\AvidUnityISISSystemDirector64Bit
	- D:\Program Files\Avid Technology\AvidUnityISISSystemDirector64Bit
	- D:\Program Files\Avid Technology\AvidUnityISISSystemDirector64Bit



	- To v4.X metadata location
	- To v4.X metadata location
	- D:\Program Files\Avid\ISIS System Director (This folder is created on installation of the 4.x kit)
	- D:\Program Files\Avid\ISIS System Director (This folder is created on installation of the 4.x kit)
	- D:\Program Files\Avid\ISIS System Director (This folder is created on installation of the 4.x kit)






	2. Follow the steps in 
	2. Follow the steps in 
	“Common Setup Steps” on page 17


	3. Copy the following files from the v2.x folder to the network folder or memory stick.
	3. Copy the following files from the v2.x folder to the network folder or memory stick.
	a. Partition0 
	a. Partition0 
	a. Partition0 

	b. Partition1
	b. Partition1

	c. PartitionDump.bin
	c. PartitionDump.bin



	4. Load the ISIS v4.x software kit on the new AS3000 Active System Director.
	4. Load the ISIS v4.x software kit on the new AS3000 Active System Director.
	a. Double click the Autorun.exe.
	a. Double click the Autorun.exe.
	a. Double click the Autorun.exe.



	5. Once the install completes open the System Director Control Panel and stop the System Director.
	5. Once the install completes open the System Director Control Panel and stop the System Director.

	6. Copy the following files from the network folder or memory stick to the v4.x folder:
	6. Copy the following files from the network folder or memory stick to the v4.x folder:
	a. Partition0 
	a. Partition0 
	a. Partition0 

	b. Partition1
	b. Partition1



	7. Open the System Director Log viewer.
	7. Open the System Director Log viewer.

	8. In the System Director, from the System Director Control Panel select Start System Director. 
	8. In the System Director, from the System Director Control Panel select Start System Director. 
	If there are problems with the upgrade of the Partition file, stop and contact your support team.


	9. Since the memory footprint for the System Director in v 4.6 is larger than before, on the AS3000 the System Director Control Panel shows a status of either “Reconfiguration possible” or “Reconfiguration required.” To reconfigure use the fo...
	9. Since the memory footprint for the System Director in v 4.6 is larger than before, on the AS3000 the System Director Control Panel shows a status of either “Reconfiguration possible” or “Reconfiguration required.” To reconfigure use the fo...
	a. Stop the System Director.
	a. Stop the System Director.
	a. Stop the System Director.

	b. Select Configure File System.
	b. Select Configure File System.

	c. In the File System Configuration dialog select Reconfigure File System. If there are problems with the upgrade of the Partition file, stop and contact your support team.
	c. In the File System Configuration dialog select Reconfigure File System. If there are problems with the upgrade of the Partition file, stop and contact your support team.



	10. After the reconfigure completes the active System Director will be up and running. Proceed to 
	10. After the reconfigure completes the active System Director will be up and running. Proceed to 
	“Completing the Upgrade” on page 20



	To upgrade from a 4.x to a newer v4.X:
	To upgrade from a 4.x to a newer v4.X:
	1. Create a new folder on the D: drive and copy the following files to the new folder prior to installing the v4.x kit:
	1. Create a new folder on the D: drive and copy the following files to the new folder prior to installing the v4.x kit:
	a. Partition0 
	a. Partition0 
	a. Partition0 

	b. Partition1
	b. Partition1

	c. PartitionDump.bin (PartitionDump.bin is for use in case the normal Partition files fail to load)
	c. PartitionDump.bin (PartitionDump.bin is for use in case the normal Partition files fail to load)



	2. Load the ISIS v4.x software kit on the Active System Director.
	2. Load the ISIS v4.x software kit on the Active System Director.
	a. Double-click Autorun.exe.
	a. Double-click Autorun.exe.
	a. Double-click Autorun.exe.



	3. After the kit install completes, open the System Director Log Viewer. 
	3. After the kit install completes, open the System Director Log Viewer. 
	If there are problems upgrading the metadata, stop and contact your support team.



	Completing the Upgrade
	Completing the Upgrade
	1. After the new Active System Director has started, log into the management console and make sure the “test” workspace exists on the Workspaces page.
	1. After the new Active System Director has started, log into the management console and make sure the “test” workspace exists on the Workspaces page.
	If it does not, stop the System Director and contact your support team.


	2. Upgrade the Standby System Director. Make sure that there are no Partition files in the v4.x directory. If you are upgrading on the same system, move these files to a temporary folder and do the following:
	2. Upgrade the Standby System Director. Make sure that there are no Partition files in the v4.x directory. If you are upgrading on the same system, move these files to a temporary folder and do the following:
	a. Load the ISIS v4.x software kit on Standby System Director.
	a. Load the ISIS v4.x software kit on Standby System Director.
	a. Load the ISIS v4.x software kit on Standby System Director.

	b. Double-click Autorun.exe in the software kit.
	b. Double-click Autorun.exe in the software kit.

	c. Open the System Director Log Viewer.
	c. Open the System Director Log Viewer.

	d. Open the System Director Control Panel and stop the System Director.
	d. Open the System Director Control Panel and stop the System Director.

	e. Select Configure File System.
	e. Select Configure File System.

	f. In the File System Configuration dialog select Create Standby System Director. 
	f. In the File System Configuration dialog select Create Standby System Director. 
	If there are problems creating the new Standby, contact your support team.


	g. Once the new Standby System Director starts it will receive a complete copy of the metadata from the Active Director.
	g. Once the new Standby System Director starts it will receive a complete copy of the metadata from the Active Director.



	3. The first replication between the active and standby System Directors copies the entire heap over and can take several minutes. The active System Director Log Viewer might display the message: “Remote meta data save did not complete.” This is ...
	3. The first replication between the active and standby System Directors copies the entire heap over and can take several minutes. The active System Director Log Viewer might display the message: “Remote meta data save did not complete.” This is ...

	4. After the initial replication between the System Directors is complete you can close the System Director Log Viewer on both System Directors.
	4. After the initial replication between the System Directors is complete you can close the System Director Log Viewer on both System Directors.





	Avid ISIS 5500 | 5000 Software Installation
	Avid ISIS 5500 | 5000 Software Installation
	Avid ISIS Systems ship with one blank 8GB USB Drive that is intended to be used for storing the ISIS Software Kit. Download the ISIS software kit from the download center (
	Avid ISIS Systems ship with one blank 8GB USB Drive that is intended to be used for storing the ISIS Software Kit. Download the ISIS software kit from the download center (
	Avid ISIS Systems ship with one blank 8GB USB Drive that is intended to be used for storing the ISIS Software Kit. Download the ISIS software kit from the download center (
	www.avid.com/US/support/downloads

	n When you initially install the Avid ISIS software, the RAID set is initialized automatically. With no client traffic on the system, this will take approximately 27 hours for the ISIS 5500-32 and 14 hours for the ISIS 5500-16. During this initializa...
	n When you initially install the Avid ISIS software, the RAID set is initialized automatically. With no client traffic on the system, this will take approximately 27 hours for the ISIS 5500-32 and 14 hours for the ISIS 5500-16. During this initializa...

	The following sections include general instructions for new installations and upgrades. Avid ISIS 5500 | 5000 v4.6 infrastructure software requires Avid ISIS v4.6 Client Manager software.
	c Do not download and run the AvidISISStorageManager64.msi file shown in the Management Console Installer window to upgrade your Engines. Important configuration files are not included in the .msi file. The complete installation is only available in ...
	c Do not download and run the AvidISISStorageManager64.msi file shown in the Management Console Installer window to upgrade your Engines. Important configuration files are not included in the .msi file. The complete installation is only available in ...


	To install your Avid ISIS 5500 | 5000 software on new systems:
	To install your Avid ISIS 5500 | 5000 software on new systems:
	1. Load the new software kit (new version) on the System Director from the USB flash drive.
	1. Load the new software kit (new version) on the System Director from the USB flash drive.

	2. Double-click the Autorun.exe file in the software kit.
	2. Double-click the Autorun.exe file in the software kit.
	n If the Package Selection menu does not allow you to select the software, click Quit and run the Autorun.exe again.
	n If the Package Selection menu does not allow you to select the software, click Quit and run the Autorun.exe again.
	n If the Package Selection menu does not allow you to select the software, click Quit and run the Autorun.exe again.



	3. Select the appropriate installer from the Software Package menu (Engine/System Director or Engine only) for the enclosure you are installing on.
	3. Select the appropriate installer from the Software Package menu (Engine/System Director or Engine only) for the enclosure you are installing on.

	4. Click Apply.
	4. Click Apply.
	n The installer automatically stops the System Director and Storage Manager services and uninstalls the earlier version of software.
	n The installer automatically stops the System Director and Storage Manager services and uninstalls the earlier version of software.
	n The installer automatically stops the System Director and Storage Manager services and uninstalls the earlier version of software.

	n Direct Connect configurations need at least one client connected before the Storage Manager recognizes a valid configuration. With no clients connected, the status is invalid and displays “Not Connected.” When you connect an operational client,...
	n Direct Connect configurations need at least one client connected before the Storage Manager recognizes a valid configuration. With no clients connected, the status is invalid and displays “Not Connected.” When you connect an operational client,...



	5. On new installations a Network Configuration Tool appears asking you to provide the IP Address of the Ethernet connections.
	5. On new installations a Network Configuration Tool appears asking you to provide the IP Address of the Ethernet connections.
	n The Network Configuration Tool displays the supported 1 Gb ports or the 10 Gb port if it is being used.
	n The Network Configuration Tool displays the supported 1 Gb ports or the 10 Gb port if it is being used.
	n The Network Configuration Tool displays the supported 1 Gb ports or the 10 Gb port if it is being used.

	c You must use the Network Configuration Tool in the ISIS Launch Pad to set the Ethernet ports on the System Director. This tool sets the IP addresses in the registry. Manually setting the IP addresses on the System Director without using the Network...
	c You must use the Network Configuration Tool in the ISIS Launch Pad to set the Ethernet ports on the System Director. This tool sets the IP addresses in the registry. Manually setting the IP addresses on the System Director without using the Network...



	6. Once the software is installed, the System Director service starts up. Verify this in the System Director Control Panel.
	6. Once the software is installed, the System Director service starts up. Verify this in the System Director Control Panel.

	7. Open the Avid License Control tool (click Start > Programs > Avid > Utilities > Avid License Control) and activate your Avid ISIS license. For detailed license activation instructions, see the 
	7. Open the Avid License Control tool (click Start > Programs > Avid > Utilities > Avid License Control) and activate your Avid ISIS license. For detailed license activation instructions, see the 
	Avid ISIS 5500 Setup Guide

	Locate the System ID and Activation ID card included with your new System Director.
	Locate the System ID and Activation ID card included with your new System Director.


	8. Repeat step 
	8. Repeat step 
	1
	7
	1
	7
	Avid ISIS 5500 Setup Guide


	9. Exit the software installer screen and restart the Engine to make sure the new or updated network drivers and configuration are applied. 
	9. Exit the software installer screen and restart the Engine to make sure the new or updated network drivers and configuration are applied. 

	10. (New installs) Run the Product Recovery tool to create a Product Recovery USB flash drive.
	10. (New installs) Run the Product Recovery tool to create a Product Recovery USB flash drive.

	11. Click Control Panel from the ISIS Launch Pad.
	11. Click Control Panel from the ISIS Launch Pad.
	a. Click Stop System Director.
	a. Click Stop System Director.
	a. Click Stop System Director.

	b. Click Configure File System.
	b. Click Configure File System.

	c. Select Create Active File System and click OK.
	c. Select Create Active File System and click OK.



	12. Click Management Console from the ISIS Launch Pad.
	12. Click Management Console from the ISIS Launch Pad.
	a. Log in using the Administrator user name and leave the password field blank.
	a. Log in using the Administrator user name and leave the password field blank.
	a. Log in using the Administrator user name and leave the password field blank.

	b. Click the Storage Managers icon.
	b. Click the Storage Managers icon.

	c. Select your ISIS Engines in the list and click Bind.
	c. Select your ISIS Engines in the list and click Bind.

	d. Create a Storage Group, Workspaces, and add Users in the Management Console.
	d. Create a Storage Group, Workspaces, and add Users in the Management Console.



	13. (Option) If using a Force10 S25 switch, enable Flow Control on that switch. For instructions on turning on Flow Control in the Force10 S25 switch, see 
	13. (Option) If using a Force10 S25 switch, enable Flow Control on that switch. For instructions on turning on Flow Control in the Force10 S25 switch, see 
	Turning on Flow Control in the Force10 S25 Switch


	14. Install your Avid ISIS client software. For information, see 
	14. Install your Avid ISIS client software. For information, see 
	Avid ISIS Client Software Installation
	Avid ISIS Client Guide




	ISIS 5500 | 5000 Upgrades
	ISIS 5500 | 5000 Upgrades
	The following process summarizes the upgrade process to v4.6. For additional information, see the 
	The following process summarizes the upgrade process to v4.6. For additional information, see the 
	The following process summarizes the upgrade process to v4.6. For additional information, see the 
	Avid ISIS 5500 | 5000 Setup Guide

	n The minimum supported version for this upgrade is v4.0. If you are on a build earlier than v4.0, update to v4.0.1, 4.0.3, or 4.0.4 before proceeding.
	n The minimum supported version for this upgrade is v4.0. If you are on a build earlier than v4.0, update to v4.0.1, 4.0.3, or 4.0.4 before proceeding.


	To upgrade ISIS 5500 | 5000:
	To upgrade ISIS 5500 | 5000:
	1. Download the ISIS v4.6 software kit from the Avid Download Center (
	1. Download the ISIS v4.6 software kit from the Avid Download Center (
	www.avid.com/US/support/downloads


	2. When running a System Director Resiliency configuration, stop the Standby System Director using the ISIS Control Panel and upgrade the Active System Director first. 
	2. When running a System Director Resiliency configuration, stop the Standby System Director using the ISIS Control Panel and upgrade the Active System Director first. 
	Update additional Engines after your Active and Standby System Directors are updated.
	Update additional Engines after your Active and Standby System Directors are updated.


	3. Stop the Active System Director using the ISIS Control Panel.
	3. Stop the Active System Director using the ISIS Control Panel.

	4. Make a copy of your current metadata files. The following are the file names and where they are located: 
	4. Make a copy of your current metadata files. The following are the file names and where they are located: 
	Metadata location
	Metadata location
	D:\Program Files\Avid\ISIS System Director


	- Partition0
	- Partition0
	- Partition0
	- Partition0

	- Partition1
	- Partition1

	- PartitionDump.bin
	- PartitionDump.bin




	5. Load the new software kit (new version) on the System Director (or Engine) from the USB flash drive. 
	5. Load the new software kit (new version) on the System Director (or Engine) from the USB flash drive. 

	6. Double-click the Autorun.exe file in the software kit.
	6. Double-click the Autorun.exe file in the software kit.
	The installer detects the existing version of the installed software and displays the components that need to be upgraded in the splash screen. 
	The installer detects the existing version of the installed software and displays the components that need to be upgraded in the splash screen. 
	n If the Package Selection menu does not allow you to select the software, click Quit and run the Autorun.exe again.
	n If the Package Selection menu does not allow you to select the software, click Quit and run the Autorun.exe again.



	7. Click Apply.
	7. Click Apply.
	n The installer automatically stops the System Director and Storage Manager services and uninstalls the earlier version of software.
	n The installer automatically stops the System Director and Storage Manager services and uninstalls the earlier version of software.
	n The installer automatically stops the System Director and Storage Manager services and uninstalls the earlier version of software.

	n Direct Connect configurations need at least one client connected before the Storage Manager recognizes a valid configuration. With no clients connected, the status is invalid and displays “Not Connected.” As soon as you connect an operational c...
	n Direct Connect configurations need at least one client connected before the Storage Manager recognizes a valid configuration. With no clients connected, the status is invalid and displays “Not Connected.” As soon as you connect an operational c...



	8. Follow the screen prompts accepting the defaults and License agreement.
	8. Follow the screen prompts accepting the defaults and License agreement.

	9. Once the installation is complete, click Finish.
	9. Once the installation is complete, click Finish.

	10. (If applicable) Update your Standby System Director and other Engines repeating steps 1 through 9. 
	10. (If applicable) Update your Standby System Director and other Engines repeating steps 1 through 9. 
	Load the new software kit (new version) on the System Director (or Engine) from the USB flash drive.
	Once the installation is complete, click Finish.


	11. (ISIS v3.0 or v3.1 update) If you are upgrading from ISIS v3.0 or v3.1, check to see if you have any corrupted files, see 
	11. (ISIS v3.0 or v3.1 update) If you are upgrading from ISIS v3.0 or v3.1, check to see if you have any corrupted files, see 
	“Running the Node Analysis Tool” on page 27


	12. Install your Avid ISIS client software. For information, see 
	12. Install your Avid ISIS client software. For information, see 
	Avid ISIS Client Software Installation
	Avid ISIS Client Guide





	Turning on Flow Control in the Force10 S25 Switch
	Turning on Flow Control in the Force10 S25 Switch
	The Avid default Force10 S25N and S25P (fiber) switch configurations do not have Flow Control turned on. Flow Control is needed to support ISIS 10 Gb clients, servers and Engines. Use the following procedure to turn on Flow Control in the Force10 swi...
	The Avid default Force10 S25N and S25P (fiber) switch configurations do not have Flow Control turned on. Flow Control is needed to support ISIS 10 Gb clients, servers and Engines. Use the following procedure to turn on Flow Control in the Force10 swi...
	The Avid default Force10 S25N and S25P (fiber) switch configurations do not have Flow Control turned on. Flow Control is needed to support ISIS 10 Gb clients, servers and Engines. Use the following procedure to turn on Flow Control in the Force10 swi...
	n Avid is turning rx and tx 
	n Avid is turning rx and tx 
	on
	on
	off



	To turn on Flow Control:
	To turn on Flow Control:
	1. Log into the switch using Telnet or HyperTerminal.
	1. Log into the switch using Telnet or HyperTerminal.

	2. Type 
	2. Type 
	en


	3. At the password prompt, type 
	3. At the password prompt, type 
	avid


	4. Type 
	4. Type 
	conf


	5. Type 
	5. Type 
	Int range tengigabitethernet 0/25 - 28

	In addition, depending on your Force10 S25 switch module options, enter one or more one of the following commands:
	In addition, depending on your Force10 S25 switch module options, enter one or more one of the following commands:

	t Left 10 Gb module installed (numbered right to left, facing rear) 
	t Left 10 Gb module installed (numbered right to left, facing rear) 
	t Left 10 Gb module installed (numbered right to left, facing rear) 
	Int range tengigabitethernet 0/27 - 28


	t Right 10 Gb module installed (numbered right to left, facing rear) 
	t Right 10 Gb module installed (numbered right to left, facing rear) 
	Int range tengigabitethernet 0/25 - 26


	t Right stacking module installed (numbered right to left, facing rear) 
	t Right stacking module installed (numbered right to left, facing rear) 
	Int range tengigabitethernet 1/25 - 26




	6. Type 
	6. Type 
	flowcontrol rx on tx on threshold 1024 1024 1054

	n The following steps turn the port off and back on so the end node renegotiates. Make sure this isn't an interface from which you are gaining remote access because you will be disconnected.
	n The following steps turn the port off and back on so the end node renegotiates. Make sure this isn't an interface from which you are gaining remote access because you will be disconnected.
	n The following steps turn the port off and back on so the end node renegotiates. Make sure this isn't an interface from which you are gaining remote access because you will be disconnected.



	7. Type 
	7. Type 
	shut


	8. Type 
	8. Type 
	no shut


	9. Type 
	9. Type 
	exit


	10. Type 
	10. Type 
	exit


	11. Type 
	11. Type 
	wr mem


	12. Type 
	12. Type 
	exit



	To confirm the setting change, look for the “Flowcontrol rx on tx on” entry:
	To confirm the setting change, look for the “Flowcontrol rx on tx on” entry:
	1. Type 
	1. Type 
	en


	2. At the password prompt, type 
	2. At the password prompt, type 
	avid


	3. Type 
	3. Type 
	sho int tengigabitethernet 0/25

	Information similar to the following is displayed. Verify 
	Information similar to the following is displayed. Verify 
	Flowcontrol rx on tx on

	TenGigabitEthernet 0/25 is up, line protocol is up 
	Flowcontrol rx on tx on 
	Flowcontrol rx on tx on

	Input Statistics: 
	Output Statistics: 





	Running the Node Analysis Tool
	Running the Node Analysis Tool
	If you are upgrading your Avid ISIS 5000 from v3.0 or v3.1, Avid recommends that you run the Node Analysis Tool immediately after upgrading to ISIS v3.2 or later. This tool analyzes the data drives for a spot on your drive that could have corrupted d...
	If you are upgrading your Avid ISIS 5000 from v3.0 or v3.1, Avid recommends that you run the Node Analysis Tool immediately after upgrading to ISIS v3.2 or later. This tool analyzes the data drives for a spot on your drive that could have corrupted d...
	If you are upgrading your Avid ISIS 5000 from v3.0 or v3.1, Avid recommends that you run the Node Analysis Tool immediately after upgrading to ISIS v3.2 or later. This tool analyzes the data drives for a spot on your drive that could have corrupted d...
	n This tool should be run immediately after upgrading from ISIS 5000 v3.0 or v3.1. If it is not, there is potential that some files returned by the NodeAnalysisTool as “suspect” may not have anything wrong with them. The NodeAnalysisTool returns ...
	n This tool should be run immediately after upgrading from ISIS 5000 v3.0 or v3.1. If it is not, there is potential that some files returned by the NodeAnalysisTool as “suspect” may not have anything wrong with them. The NodeAnalysisTool returns ...

	The extent of corrupted data is up to three files per Engine. If the corrupted file is a DNx220 video clip, the corrupted data is equivalent to about a single frame. You could play the video up to and after the corrupted frame without issue. 

	To run the Node Analysis Tool:
	To run the Node Analysis Tool:
	1. Copy the 
	1. Copy the 
	NodeAnalysisTool.exe

	The Node Analysis Tool can be found on the Avid ISIS 5000 software kit in the 
	The Node Analysis Tool can be found on the Avid ISIS 5000 software kit in the 
	\AvidISISUtilities\



	2. Double-click the 
	2. Double-click the 
	NodeAnalysisTool.exe

	A Command window opens.
	A Command window opens.


	3. When prompted for the “ISIS name,” type in the 
	3. When prompted for the “ISIS name,” type in the 
	virtual name
	Enter

	The default name is AvidISIS.
	The default name is AvidISIS.


	4. When prompted for the “Admin password,” type in the 
	4. When prompted for the “Admin password,” type in the 
	Administrator password
	Enter

	The default password is blank (no password).
	The default password is blank (no password).
	The tool runs and displays the following possible results:
	- Wrong ISIS Name specified
	- Wrong ISIS Name specified
	- Wrong ISIS Name specified
	asStatus = “AS_UNKNOWN_SYSTEM_ID” (42)

	- Bad Password specified
	- Bad Password specified
	asStatus = “AS_ACCESS_DENIED” (50)

	- Unable to reach one or more Storage Managers in the system
	- Unable to reach one or more Storage Managers in the system
	asStatus = “AS_TIMEOUT” (65)

	- No nodes found
	- No nodes found
	asStatus = “AS_NO_MORE_ITEMS” (21)
	Found 0 corrupt nodes on ISIS AvidISIS
	n If messages appear similar to the following, you have a corrupted data block that could affect one of your saved files. Make a note of the file name. 
	n If messages appear similar to the following, you have a corrupted data block that could affect one of your saved files. Make a note of the file name. 


	- If nodes are found, each Engine could have 3 messages, for example:
	- If nodes are found, each Engine could have 3 messages, for example:
	//AvidISIS/workspace1/temp/FSR_full_02740
	//AvidISIS/workspace1/temp/FSR_full_02739
	//AvidISIS/workspace1/temp/FSR_full_02741
	//AvidISIS/workspace2/temp/FSR_full_02537
	//AvidISIS/workspace2/temp/FSR_full_02612
	//AvidISIS/workspace2/temp/FSR_full_02554
	Found 6 corrupt nodes on ISIS AvidISIS
	n These would only be corrupt if they were written prior to ISIS v3.2.
	n These would only be corrupt if they were written prior to ISIS v3.2.





	5. Press 
	5. Press 
	Enter





	Updating the 10 Gb Myricom Board Driver on Engines
	Updating the 10 Gb Myricom Board Driver on Engines
	The Avid ISIS v4.6 software release includes a driver update for the 10 Gb Myricom Ethernet adapter board installed in all Engines. The Myricom 10 Gb adapter board driver and settings are configured for you when you install the Avid ISIS software on ...
	The Avid ISIS v4.6 software release includes a driver update for the 10 Gb Myricom Ethernet adapter board installed in all Engines. The Myricom 10 Gb adapter board driver and settings are configured for you when you install the Avid ISIS software on ...
	Avid ISIS Setup Guide

	n If you have made a change to the Myricom settings and want to set them back to the Avid defaults, re-run the ISIS software installer (autorun.exe) and the Avid network settings are re-applied. If the network setting are not set to the Avid defaults...
	n If you have made a change to the Myricom settings and want to set them back to the Avid defaults, re-run the ISIS software installer (autorun.exe) and the Avid network settings are re-applied. If the network setting are not set to the Avid defaults...




	Avid ISIS 2000 Software Installation
	Avid ISIS 2000 Software Installation
	Avid ISIS Systems ship with one blank 8GB USB Drive that is intended to be used for storing the ISIS Software Kit. Download the ISIS software kit from the download center (
	Avid ISIS Systems ship with one blank 8GB USB Drive that is intended to be used for storing the ISIS Software Kit. Download the ISIS software kit from the download center (
	Avid ISIS Systems ship with one blank 8GB USB Drive that is intended to be used for storing the ISIS Software Kit. Download the ISIS software kit from the download center (
	www.avid.com/US/support/downloads

	The 
	Avid ISIS 2000 Setup Guide


	To install your ISIS 2000 software on new systems:
	To install your ISIS 2000 software on new systems:
	1. Log in to the Avid ISIS 2000 System Director as Administrator (default password: 
	1. Log in to the Avid ISIS 2000 System Director as Administrator (default password: 
	is-admin


	2. Make a folder for the software kit on your root directory (C:\) of your System Director.
	2. Make a folder for the software kit on your root directory (C:\) of your System Director.

	3. Insert the software USB flash drive into any of USB ports on your System Director.
	3. Insert the software USB flash drive into any of USB ports on your System Director.
	n You can run the software installer from the USB flash drive. The advantage of copying the software kit to the Avid ISIS 2000 is that you have easy access to kit files if you should ever them in the future.
	n You can run the software installer from the USB flash drive. The advantage of copying the software kit to the Avid ISIS 2000 is that you have easy access to kit files if you should ever them in the future.
	n You can run the software installer from the USB flash drive. The advantage of copying the software kit to the Avid ISIS 2000 is that you have easy access to kit files if you should ever them in the future.

	If the USB flash drive does not automatically display:

	a. Double-click the computer icon on the desktop. 
	a. Double-click the computer icon on the desktop. 
	a. Double-click the computer icon on the desktop. 

	b. Double-click the USB flash drive icon in the window and copy the software kit into the new folder you created on the Avid ISIS 2000 system. 
	b. Double-click the USB flash drive icon in the window and copy the software kit into the new folder you created on the Avid ISIS 2000 system. 



	4. Double-click the Autorun.exe file in the root directory of software kit.
	4. Double-click the Autorun.exe file in the root directory of software kit.
	The installer detects the existing version of the installed software (if any) and displays the components that need to be upgraded in the splash screen. 
	The installer detects the existing version of the installed software (if any) and displays the components that need to be upgraded in the splash screen. 
	n If the Package Selection menu does not allow you to select the software, click Quit and run the Autorun.exe again.
	n If the Package Selection menu does not allow you to select the software, click Quit and run the Autorun.exe again.



	5. Select ISIS 2000 System Director from the “Select Software Package” menu. 
	5. Select ISIS 2000 System Director from the “Select Software Package” menu. 

	6. Click Apply.
	6. Click Apply.

	7. Follow the screen prompts accepting the defaults and License agreement.
	7. Follow the screen prompts accepting the defaults and License agreement.
	n When uninstalling or upgrading the ISIS 2000 software, you might get prompted to confirm the removal of the File Gateway software. Type Y to confirm the removal.
	n When uninstalling or upgrading the ISIS 2000 software, you might get prompted to confirm the removal of the File Gateway software. Type Y to confirm the removal.
	n When uninstalling or upgrading the ISIS 2000 software, you might get prompted to confirm the removal of the File Gateway software. Type Y to confirm the removal.



	8. Once the installation is complete, click Finish.
	8. Once the installation is complete, click Finish.

	9. After the ISIS 2000 software is installed, you must restart the System Director.
	9. After the ISIS 2000 software is installed, you must restart the System Director.

	10. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > Avid License Control and activate your Avid ISIS license. For detailed license activation instructions, see the 
	10. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > Avid License Control and activate your Avid ISIS license. For detailed license activation instructions, see the 
	Avid ISIS 2000 Setup Guide

	You will need the System ID and Activation ID card included with your new System Director.
	You will need the System ID and Activation ID card included with your new System Director.


	11. Open the ISIS Control Panel. 
	11. Open the ISIS Control Panel. 
	n To open and use the ISIS Control Panel and Management Console see the 
	n To open and use the ISIS Control Panel and Management Console see the 
	n To open and use the ISIS Control Panel and Management Console see the 
	Avid ISIS Administration Guide




	12. Click Stop System Director.
	12. Click Stop System Director.

	13. Click Configure File System.
	13. Click Configure File System.

	14. Open the Management Console. 
	14. Open the Management Console. 
	Log in using the Administrator user name and the default password is blank.
	Log in using the Administrator user name and the default password is blank.


	15. Select Create Active File System and click OK.
	15. Select Create Active File System and click OK.

	16. Load the drive firmware. Using the ISIS Management Console > Storage Manager page, select all the Storage Managers and click Upgrade. For more information, see the 
	16. Load the drive firmware. Using the ISIS Management Console > Storage Manager page, select all the Storage Managers and click Upgrade. For more information, see the 
	Avid ISIS 2000 Setup Guide


	17. Bind the Storage Managers. Using the ISIS Management Console > Storage Manager page, select your ISIS Storage Managers in the list and click Bind.
	17. Bind the Storage Managers. Using the ISIS Management Console > Storage Manager page, select your ISIS Storage Managers in the list and click Bind.
	n When setting up the System Director to the switch, you must use a static IP address. The ISIS 2000 System Director will not bind the Storage Manager if using DHCP.
	n When setting up the System Director to the switch, you must use a static IP address. The ISIS 2000 System Director will not bind the Storage Manager if using DHCP.
	n When setting up the System Director to the switch, you must use a static IP address. The ISIS 2000 System Director will not bind the Storage Manager if using DHCP.



	18. Create a Storage Group, Workspaces, and add Users in the Management Console.
	18. Create a Storage Group, Workspaces, and add Users in the Management Console.

	19. Install your Avid ISIS client software. For information, see 
	19. Install your Avid ISIS client software. For information, see 
	Avid ISIS Client Software Installation
	Avid ISIS Client Guide




	ISIS 2000 Upgrades
	ISIS 2000 Upgrades
	The following process summarizes the upgrade process to v4.6. For additional information, see the 
	The following process summarizes the upgrade process to v4.6. For additional information, see the 
	The following process summarizes the upgrade process to v4.6. For additional information, see the 
	Avid ISIS 2000 Setup Guide


	To upgrade ISIS 2000 v4.2 and earlier to v4.6:
	To upgrade ISIS 2000 v4.2 and earlier to v4.6:
	1. Download the ISIS software kit from the Avid Download Center (
	1. Download the ISIS software kit from the Avid Download Center (
	www.avid.com/US/support/downloads


	2. (If applicable) Log into Administrator account on the Standby System Director and Stop the Standby System Director using the ISIS Control Panel. 
	2. (If applicable) Log into Administrator account on the Standby System Director and Stop the Standby System Director using the ISIS Control Panel. 

	3. Make a copy of your current metadata files. The following are the file names and where they are located: 
	3. Make a copy of your current metadata files. The following are the file names and where they are located: 
	Metadata location
	Metadata location
	D:\Program Files\Avid\ISIS System Director


	- Partition0
	- Partition0
	- Partition0
	- Partition0

	- Partition1
	- Partition1

	- PartitionDump.bin
	- PartitionDump.bin




	4. Load the ISIS software kit on the System Director. 
	4. Load the ISIS software kit on the System Director. 

	5. Double-click the Autorun.exe file in the software kit.
	5. Double-click the Autorun.exe file in the software kit.
	The installer detects the existing version of the installed software (if any) and displays the components that need to be upgraded in the splash screen. 
	The installer detects the existing version of the installed software (if any) and displays the components that need to be upgraded in the splash screen. 
	n If the Package Selection menu does not allow you to select the software, click Quit and run the Autorun.exe again.
	n If the Package Selection menu does not allow you to select the software, click Quit and run the Autorun.exe again.



	6. If not already selected, select ISIS 2000 System Director from the “Select Software Package” menu. 
	6. If not already selected, select ISIS 2000 System Director from the “Select Software Package” menu. 

	7. Click Apply.
	7. Click Apply.

	8. Follow the screen prompts accepting the defaults and License agreement.
	8. Follow the screen prompts accepting the defaults and License agreement.
	n When uninstalling or upgrading the ISIS 2000 software, you might get prompted to confirm the removal of the File Gateway software. Type Y to confirm the removal and continue with the upgrade.
	n When uninstalling or upgrading the ISIS 2000 software, you might get prompted to confirm the removal of the File Gateway software. Type Y to confirm the removal and continue with the upgrade.
	n When uninstalling or upgrading the ISIS 2000 software, you might get prompted to confirm the removal of the File Gateway software. Type Y to confirm the removal and continue with the upgrade.



	9. Once the installation is complete, click Finish.
	9. Once the installation is complete, click Finish.
	You are prompted now to restart the System Director. After the System Director has restarted, continue with the next step.
	You are prompted now to restart the System Director. After the System Director has restarted, continue with the next step.


	10. Upgrade your Storage Manager, using the ISIS Management Console > Storage Managers. Select the original Storage Manager (typically labeled SM000) and click Upgrade. 
	10. Upgrade your Storage Manager, using the ISIS Management Console > Storage Managers. Select the original Storage Manager (typically labeled SM000) and click Upgrade. 
	The Upgrade Storage Managers window opens.
	The Upgrade Storage Managers window opens.


	11. Select the .zip file for the new release, and click Upgrade.
	11. Select the .zip file for the new release, and click Upgrade.
	If you have an ISIS 2000-120 configuration your upgrade is finished. Continue with this procedure if you have an ISIS 2000-240 configuration.
	If you have an ISIS 2000-120 configuration your upgrade is finished. Continue with this procedure if you have an ISIS 2000-240 configuration.


	12. (ISIS 2000-240) Select the Storage Manager from the list and click Details.
	12. (ISIS 2000-240) Select the Storage Manager from the list and click Details.
	The Status for the upgrade is shown in the Details pane at the right of the window. Click the Refresh button whenever you want the updated Status. When the Status displays “Data Conversion Mode,” continue with the next step.
	The Status for the upgrade is shown in the Details pane at the right of the window. Click the Refresh button whenever you want the updated Status. When the Status displays “Data Conversion Mode,” continue with the next step.


	13. (ISIS 2000-240) Double-click the IP address of the original Storage Manager in the Details pane to open ISIS 2000 Storage Manager Agent Web page. 
	13. (ISIS 2000-240) Double-click the IP address of the original Storage Manager in the Details pane to open ISIS 2000 Storage Manager Agent Web page. 

	14. (ISIS 2000-240) You are asked for the password. Type 
	14. (ISIS 2000-240) You are asked for the password. Type 
	se-admin

	The ISIS 2000 Storage Manager Agent page appears.
	The ISIS 2000 Storage Manager Agent page appears.


	15. (ISIS 2000-240) Click Network in the left pane of the System tab. 
	15. (ISIS 2000-240) Click Network in the left pane of the System tab. 

	16. (ISIS 2000-240) Enter an IP address in the gx0:1 and Netmask text boxes in the Data Interfaces section. 
	16. (ISIS 2000-240) Enter an IP address in the gx0:1 and Netmask text boxes in the Data Interfaces section. 
	Starting with the ISIS v4.5 release, the Engine Controller in the ISIS 2000 Engine requires dual IP addresses for ISIS 2000-240 systems. This new IP Address must be in the same subnet as the original IP address. Consult your network administrator to ...
	Starting with the ISIS v4.5 release, the Engine Controller in the ISIS 2000 Engine requires dual IP addresses for ISIS 2000-240 systems. This new IP Address must be in the same subnet as the original IP address. Consult your network administrator to ...
	n A second physical cable is not needed, both IP address are handled through the existing 10 Gb connection between Engine Controller and the switch. 
	n A second physical cable is not needed, both IP address are handled through the existing 10 Gb connection between Engine Controller and the switch. 



	17. (ISIS 2000-240) Click Submit.
	17. (ISIS 2000-240) Click Submit.
	a. A dialog box appears warning you a Engine reboot is required; click the Reboot button.
	a. A dialog box appears warning you a Engine reboot is required; click the Reboot button.
	a. A dialog box appears warning you a Engine reboot is required; click the Reboot button.

	b. A second dialog box appears, type 
	b. A second dialog box appears, type 
	se-admin




	18. (ISIS 2000-240) When the Engine has restarted, open the Storage Manager page in the Management Console.
	18. (ISIS 2000-240) When the Engine has restarted, open the Storage Manager page in the Management Console.
	n When you upgrade from v4.2 and earlier to v4.5 and later, you will notice there are now two Storage Managers in the Storage Managers page displaying half the capacity that was previous listed and the Status column displays “Data Conversion Mode....
	n When you upgrade from v4.2 and earlier to v4.5 and later, you will notice there are now two Storage Managers in the Storage Managers page displaying half the capacity that was previous listed and the Status column displays “Data Conversion Mode....
	n When you upgrade from v4.2 and earlier to v4.5 and later, you will notice there are now two Storage Managers in the Storage Managers page displaying half the capacity that was previous listed and the Status column displays “Data Conversion Mode....

	c Do not add any new ISIS 2000 Engines to this existing Storage Group until the ISIS v4.6 upgrade data conversion redistribution has completed.
	c Do not add any new ISIS 2000 Engines to this existing Storage Group until the ISIS v4.6 upgrade data conversion redistribution has completed.



	19. Install your Avid ISIS client software. For information, see 
	19. Install your Avid ISIS client software. For information, see 
	Avid ISIS Client Software Installation
	Avid ISIS Client Guide






	Avid ISIS Client Software Installation
	Avid ISIS Client Software Installation
	This section contains information about installing or upgrading the client software on your system. A user account with Administrator privileges is required to install Avid ISIS client software on your workstations.
	This section contains information about installing or upgrading the client software on your system. A user account with Administrator privileges is required to install Avid ISIS client software on your workstations.
	This section contains information about installing or upgrading the client software on your system. A user account with Administrator privileges is required to install Avid ISIS client software on your workstations.
	The 
	Avid ISIS Client Guide

	The clients are defined as follows:
	• Avid editing applications (see 
	• Avid editing applications (see 
	• Avid editing applications (see 
	“Hardware and Software Requirements” on page 35


	• Interplay Assist and Instinct
	• Interplay Assist and Instinct

	• Interplay Access
	• Interplay Access

	• Avid Approved Applications Initiative such as Pro Tools
	• Avid Approved Applications Initiative such as Pro Tools



	To install your Avid ISIS Windows client software from the software kit:
	To install your Avid ISIS Windows client software from the software kit:
	1. Log into your Windows client system as a user with Administrative privileges.
	1. Log into your Windows client system as a user with Administrative privileges.

	2. Load the new software kit on you Windows client system.
	2. Load the new software kit on you Windows client system.

	3. Double-click the 
	3. Double-click the 
	Autorun.exe

	The installer detects the existing version of the installed client software (if any) and displays the components that need to be upgraded in the splash screen. 
	The installer detects the existing version of the installed client software (if any) and displays the components that need to be upgraded in the splash screen. 
	n If the Package Selection menu does not allow you to select the software, click Quit and run the Autorun.exe again.
	n If the Package Selection menu does not allow you to select the software, click Quit and run the Autorun.exe again.



	4. Select the “ISIS Windows Client” installer from the Select Software Package menu.
	4. Select the “ISIS Windows Client” installer from the Select Software Package menu.

	5. Click Apply.
	5. Click Apply.
	n The installer automatically uninstalls an earlier version of software.
	n The installer automatically uninstalls an earlier version of software.
	n The installer automatically uninstalls an earlier version of software.



	6. Update the Intel Pro driver on your client system, see 
	6. Update the Intel Pro driver on your client system, see 
	Loading or Updating the Intel Pro Driver on Windows Clients


	7. Repeat this procedure on each Avid ISIS Windows client.
	7. Repeat this procedure on each Avid ISIS Windows client.
	n You can manually copy the client installers to a USB flash drive. The installers are in the Avid ISIS software kit located on [drive]:
	n You can manually copy the client installers to a USB flash drive. The installers are in the Avid ISIS software kit located on [drive]:
	n You can manually copy the client installers to a USB flash drive. The installers are in the Avid ISIS software kit located on [drive]:
	\AvidISISClientInstallers





	To install your Avid ISIS Macintosh client software:
	To install your Avid ISIS Macintosh client software:
	1. Copy and save the new 
	1. Copy and save the new 
	AvidISISClient_MacOSX_x.x.x.dmg 

	t \AvidISISClientInstallers folder in software kit to your Macintosh client system.
	t \AvidISISClientInstallers folder in software kit to your Macintosh client system.
	t \AvidISISClientInstallers folder in software kit to your Macintosh client system.
	t \AvidISISClientInstallers


	t Management Console > Installer page to your Macintosh client system. 
	t Management Console > Installer page to your Macintosh client system. 



	2. Double-click the 
	2. Double-click the 
	AvidISISClient_MacOSX_x.x.x.dmg 


	3. Double-click the 
	3. Double-click the 
	AvidISISClient.mpkg

	Follow the on-screen instructions.
	Follow the on-screen instructions.
	n The installer replaces earlier versions of the software (if any).
	n The installer replaces earlier versions of the software (if any).



	4. Repeat this procedure on each Avid ISIS Macintosh client.
	4. Repeat this procedure on each Avid ISIS Macintosh client.
	n You can manually copy the client installers to a USB flash drive. 
	n You can manually copy the client installers to a USB flash drive. 
	n You can manually copy the client installers to a USB flash drive. 

	c The Macintosh client software installs an uninstaller application located at 
	c The Macintosh client software installs an uninstaller application located at 
	Applications > Avid_Uninstallers > AvidISIS





	To install ISIS Linux client software:
	To install ISIS Linux client software:
	1. Copy and save the new 
	1. Copy and save the new 
	AvidISISClient_el6.x86_x.x.x.bin 

	t \AvidISISClientInstallers folder in software kit to the user’s home directory of your Linux client system.
	t \AvidISISClientInstallers folder in software kit to the user’s home directory of your Linux client system.
	t \AvidISISClientInstallers folder in software kit to the user’s home directory of your Linux client system.
	t \AvidISISClientInstallers


	t Management Console > Installer page to the user's home directory of your Linux client system. 
	t Management Console > Installer page to the user's home directory of your Linux client system. 



	2. Open the Terminal application: 
	2. Open the Terminal application: 
	Application > System Tools > Terminal

	n When using the Terminal program, file names and paths are case sensitive.
	n When using the Terminal program, file names and paths are case sensitive.
	n When using the Terminal program, file names and paths are case sensitive.



	3. Type 
	3. Type 
	cd
	user’s home directory
	Enter


	4. Do one of the following.
	4. Do one of the following.
	t If you are not the root user, type 
	t If you are not the root user, type 
	t If you are not the root user, type 
	sudo ./AvidISISClient_el6.x86_x.x.x.bin
	Enter


	t If you are the root user, type 
	t If you are the root user, type 
	./AvidISISClient_el6.x86_x.x.x.bin 
	Enter



	n The installer replaces earlier versions of the software (if any).
	n The installer replaces earlier versions of the software (if any).
	n The installer replaces earlier versions of the software (if any).

	n You can manually copy the client installers to a USB flash drive. 
	n You can manually copy the client installers to a USB flash drive. 



	5. Restart the Linux client.
	5. Restart the Linux client.





	Hardware and Software Requirements
	Hardware and Software Requirements
	To meet the stringent needs of media applications the ISIS family of storage solutions is built using patented intellectual property in ISIS software running on Avid ISIS hardware. Avid tests and qualifies configurations of Avid ISIS software deploye...
	To meet the stringent needs of media applications the ISIS family of storage solutions is built using patented intellectual property in ISIS software running on Avid ISIS hardware. Avid tests and qualifies configurations of Avid ISIS software deploye...
	only

	The following table provides a list of product clients and infrastructure component software versions needed to work with Avid ISIS.
	n Most Windows editing clients require the 1-Gb Intel Pro 1000 Ethernet board to connect to the Avid ISIS system. Macintosh clients and some Windows clients have been qualified to use the on-board 1-Gb ports. For instructions on installing the board ...
	n Most Windows editing clients require the 1-Gb Intel Pro 1000 Ethernet board to connect to the Avid ISIS system. Macintosh clients and some Windows clients have been qualified to use the on-board 1-Gb ports. For instructions on installing the board ...
	Avid ISIS Client Guide.


	<TABLE>
	<TABLE>
	<TABLE HEADING>
	<TABLE ROW>
	Avid ISIS v4.6 Qualified Clients 
	Avid ISIS v4.6 Qualified Clients 


	<TABLE ROW>
	Software
	Software

	ISIS 2000 Workspaces
	ISIS 2000 Workspaces

	ISIS 5500 Workspaces
	ISIS 5500 Workspaces

	ISIS 7000 Mirrored Workspaces
	ISIS 7000 Mirrored Workspaces

	ISIS 7000 RAID Workspaces
	ISIS 7000 RAID Workspaces
	ISIS 7000 RAID 6 Workspaces support only resolutions that draw 16 MB/s (50 Mb/s) or less. 




	<TABLE BODY>
	<TABLE ROW>
	Media Composer 
	Media Composer 

	v5.5.x, v6.x, v6.5.x, v7.0.x
	v5.5.
	x
	x
	x


	v5.5.x, v6.x, v6.5.x, v7.0.x
	v5.5.
	x
	x
	x


	v5.5.x, v6.x, v6.5.x, v7.0.x
	v5.5.
	x
	x
	x


	v5.5.x, v6.x, v6.5.x, v7.0.x
	v5.5.
	x
	x
	x



	<TABLE ROW>
	Media Composer 10-Gb client
	Media Composer 10-Gb client
	Ultra High Resolution Clients can mount RAID workspaces although, only resolutions that draw 16 MB/s (50 Mb/s) or less are supported. 


	v5.5.x, v6.x, v6.5.x, v7.0.x
	v5.5.
	x
	x
	x


	v5.5.x, v6.x, v6.5.x, v7.0.x
	v5.5.
	x
	x
	x


	v5.5.x, v6.x, v6.5.x, v7.0.x
	v5.5.
	x
	x
	x


	v5.5.x, v6.x, v6.5.x, v7.0.x
	v5.5.
	x
	x
	x



	<TABLE ROW>
	Avid Symphony 
	Avid Symphony 

	v5.5.x, v6.x, v6.5.x, v7.0.x
	v5.5.
	x
	x
	x


	v5.5.x, v6.x, v6.5.x, v7.0.x
	v5.5.
	x
	x
	x


	v5.5.x, v6.x, v6.5.x, v7.0.x
	v5.5.
	x
	x
	x


	v5.5.x, v6.x, v6.5.x, v7.0.x 
	v5.5.
	x
	x
	x



	<TABLE ROW>
	Avid Symphony 10-Gb clientc
	Avid Symphony 10-Gb client
	c


	v5.5.x, v6.x, v6.5.x, v7.0.x
	v5.5.
	x
	x
	x


	v5.5.x, v6.x, v6.5.x, v7.0.x
	v5.5.
	x
	x
	x


	v5.5.x, v6.x, v6.5.x, v7.0.x
	v5.5.
	x
	x
	x


	v5.5.x, v6.x, v6.5.x, v7.0.x
	v5.5.
	x
	x
	x



	<TABLE ROW>
	NewsCutter 
	NewsCutter 

	v9.5.x, v10.x, v10.5.x, v11.0.x
	v9.5.
	x
	x
	x


	v9.5.x, v10.x, v10.5.x, v11.0.x
	v9.5.
	x
	x
	x


	v9.5.x, v10.x, v10.5.x, v11.0.x
	v9.5.
	x
	x
	x


	v9.5.x, v10.x, v10.5.x, v11.0.x
	v9.5.
	x
	x
	x



	<TABLE ROW>
	NewsCutter 10-Gb clientc
	NewsCutter 10-Gb client
	c


	v9.5.x, v10.x, v10.5.x, v11.0.x
	v9.5.
	x
	x
	x


	v9.5.x, v10.x, v10.5.x, v11.0.x
	v9.5.
	x
	x
	x


	v9.5.x, v10.x, v10.5.x, v11.0.x
	v9.5.
	x
	x
	x


	v9.5.x, v10.x, v10.5.x, v11.0.x
	v9.5.
	x
	x
	x



	<TABLE ROW>
	Avid DS
	Avid DS

	No real-time support (push/pull only)
	No real-time support (push/pull only)

	v11.1
	v11.1

	v11.1
	v11.1

	Not supported
	Not supported


	<TABLE ROW>
	Avid DS 10-Gb client
	Avid DS 10-Gb client

	No real-time support (push/pull only)
	No real-time support (push/pull only)

	v11.1
	v11.1

	v11.1
	v11.1

	Not supported
	Not supported


	<TABLE ROW>
	Avid Interplay Common Services (ICS)
	Avid Interplay Common Services (ICS)

	v1.7 with v4.6 ISIS client
	v1.7 with v4.6 ISIS client

	v1.7 with v4.6 ISIS client
	v1.7 with v4.6 ISIS client

	v1.7 with v4.6 ISIS client
	v1.7 with v4.6 ISIS client

	v1.7 with v4.6 ISIS client
	v1.7 with v4.6 ISIS client


	<TABLE ROW>
	Avid Interplay with Assist
	Avid Interplay with Assist

	v2.6, v2.7
	v2.6, v2.7

	v2.6, v2.7
	v2.6, v2.7

	v2.6, v2.7
	v2.6, v2.7

	v2.6, v2.7
	v2.6, v2.7


	<TABLE ROW>
	Avid Interplay Low-Res Encode
	Avid Interplay Low-Res Encode

	Not supported
	Not supported

	Not supported
	Not supported

	v2.6, v2.7
	v2.6, v2.7

	v2.6, v2.7
	v2.6, v2.7


	<TABLE ROW>
	Avid Instinct
	Avid Instinct

	v2.7, v3.0, v3.0.5
	v2.7, v3.0, v3.0.5

	v2.7, v3.0, v3.0.5
	v2.7, v3.0, v3.0.5

	v2.7, v3.0, v3.0.5
	v2.7, v3.0, v3.0.5

	v2.7, v3.0, v3.0.5
	v2.7, v3.0, v3.0.5


	<TABLE ROW>
	AirSpeed 5000
	AirSpeed 5000

	v2.5.x, v2.6
	v2.5.x, v2.6

	v2.5.x, v2.6
	v2.5.x, v2.6

	v2.5.x, v2.6
	v2.5.x, v2.6

	v2.5.x, v2.6
	v2.5.x, v2.6


	<TABLE ROW>
	AirSpeed Multi Stream
	AirSpeed Multi Stream

	v1.8.12
	v1.8.12

	v1.8.12
	v1.8.12

	v1.8.12
	v1.8.12

	v1.8.12
	v1.8.12


	<TABLE ROW>
	AirSpeed
	AirSpeed

	v2.7.12
	v2.7.12

	v2.7.12
	v2.7.12

	v2.7.12
	v2.7.12

	v2.7.12
	v2.7.12


	<TABLE ROW>
	Pro Tools
	Pro Tools

	v10.x, v11.0 No real-time support (push/pull only)
	v10.
	x


	v10.x, v11.0 Real-time 
	v10.
	x

	v8.1.
	x
	x


	v10.x, v11.0 Real-time 
	v10.
	x,

	v8.1.
	x
	x

	Macintosh — No real-time support (push/pull only)

	v8.1.x, v9.0.x, v10.x, v11.0 No real-time support (push/pull only)
	v8.1.
	x
	x
	x







	Supported ISIS 7000 System Directors
	Supported ISIS 7000 System Directors
	The following System Director servers are supported in Avid ISIS 7000 v4.
	The following System Director servers are supported in Avid ISIS 7000 v4.
	x

	• AS3000 (Window Storage Server 2008 or Window Storage Server 2008 R2)
	• AS3000 (Window Storage Server 2008 or Window Storage Server 2008 R2)
	• AS3000 (Window Storage Server 2008 or Window Storage Server 2008 R2)

	• SR2500 (Window Storage Server 2003)
	• SR2500 (Window Storage Server 2003)
	n Avid ISIS v2.4 was the last release with support for the Intel SR2400 System Directors. If you have SR2400 System Directors, plan for System Director replacements before upgrading to this release.
	n Avid ISIS v2.4 was the last release with support for the Intel SR2400 System Directors. If you have SR2400 System Directors, plan for System Director replacements before upgrading to this release.





	Supported ISIS Client Operating Systems
	Supported ISIS Client Operating Systems
	The following table list the operating systems and Avid client software that are supported in Avid ISIS v4.6.
	The following table list the operating systems and Avid client software that are supported in Avid ISIS v4.6.
	<TABLE>
	<TABLE>
	<TABLE HEADING>
	<TABLE ROW>
	Supported Software Client Operating Systems and Service Packs 
	Supported Software Client Operating Systems and Service Packs 


	<TABLE ROW>
	Operating System
	Operating System

	Version
	Version



	<TABLE BODY>
	<TABLE ROW>
	Windows 8.1
	Windows 8.1

	No Service Pack
	No Service Pack


	<TABLE ROW>
	Windows 8 (64-bit)
	Windows 8 (64-bit)

	No Service Pack
	No Service Pack


	<TABLE ROW>
	Windows 7 (64-bit)
	Windows 7 (64-bit)

	Service Pack 1
	Service Pack 1


	<TABLE ROW>
	Windows Vista (64-bit)
	Windows Vista (64-bit)

	Service Pack 2
	Service Pack 2


	<TABLE ROW>
	Windows XP (32-bit)
	Windows XP (32-bit)

	Service Pack 3
	Service Pack 3


	<TABLE ROW>
	Windows Storage Server 2008 R2 (64-bit)
	Windows Storage Server 2008 R2 (64-bit)

	Service Pack 2
	Service Pack 2


	<TABLE ROW>
	Windows Storage Server 2008 (64-bit)
	Windows Storage Server 2008 (64-bit)

	Service Pack 2
	Service Pack 2


	<TABLE ROW>
	Windows Storage Server 2003 (64-bit)
	Windows Storage Server 2003 (64-bit)

	Service Pack 2
	Service Pack 2


	<TABLE ROW>
	Windows Server 2003 (64-bit)
	Windows Server 2003 (64-bit)

	Service Pack 2
	Service Pack 2


	<TABLE ROW>
	Mac OS X Mountain Lion (64-bit kernel)
	Mac OS X Mountain Lion (64-bit kernel)

	10.8.x and 10.9.x
	10.8.x and 10.9.x


	<TABLE ROW>
	Mac OS X Mountain Lion (32-bit kernel)
	Mac OS X Mountain Lion (32-bit kernel)

	v10.8.x
	v10.8.x


	<TABLE ROW>
	Mac OS X Lion (64-bit kernel)
	Mac OS X Lion (64-bit kernel)

	v10.7.5
	v10.7.5


	<TABLE ROW>
	Mac OS X Lion (32-bit kernel)
	Mac OS X Lion (32-bit kernel)

	v10.7.x
	v10.7.x


	<TABLE ROW>
	Red Hat Enterprise Linux (64-bit kernel)
	Red Hat Enterprise Linux (64-bit kernel)

	v6.2
	v6.2





	The following table lists the 10 Gb Avid clients that are supported in Avid ISIS.
	<TABLE>
	<TABLE>
	<TABLE HEADING>
	<TABLE ROW>
	Supported Operating Systems with 10 Gigabit Ethernet Network Interface Cards 
	Supported Operating Systems with 10 Gigabit Ethernet Network Interface Cards 


	<TABLE ROW>
	10-Gb Ethernet Network Interface Card
	10-Gb Ethernet Network Interface Card

	Supported Operating System
	Supported Operating System



	<TABLE BODY>
	<TABLE ROW>
	Myricom
	Myricom

	Windows XP 32-bit, Windows Vista 64-bit, Windows Storage Server 2008, Windows 7 64-bit, Windows 8 64-bit, and dual quad-core MacPro workstations running Mac OS v10.7.x (Lion) and Mac OS v10.8.x (Mountain Lion), and Linux Red Hat v6.2
	Windows XP 32-bit, Windows Vista 64-bit, Windows Storage Server 2008, Windows 7 64-bit, Windows 8 64-bit, and dual quad-core MacPro workstations running Mac OS v10.7.x (Lion) and Mac OS v10.8.x (Mountain Lion), and Linux Red Hat v6.2


	<TABLE ROW>
	Chelsio — Chelsio cards are only supported in the Interplay Copy/Move services in an ISIS 7000 environment. 
	Chelsio — Chelsio cards are only supported in the Interplay Copy/Move services in an ISIS 7000 environment. 
	n Editing clients with the 10-Gb Chelsio card are not supported in ISIS v4.5 and later.
	n Editing clients with the 10-Gb Chelsio card are not supported in ISIS v4.5 and later.


	Windows XP 32-bit, Windows Vista 64-bit, Windows Server 2003
	Windows XP 32-bit, Windows Vista 64-bit, Windows Server 2003







	Supported Browsers in an ISIS Environment
	Supported Browsers in an ISIS Environment
	The following are the browsers qualified in ISIS v4.6. These browsers were qualified with the client operating systems supported in the current release.
	The following are the browsers qualified in ISIS v4.6. These browsers were qualified with the client operating systems supported in the current release.
	<TABLE>
	<TABLE>
	<TABLE HEADING>
	<TABLE ROW>
	Supported Client Browser per Operating System 
	Supported Client Browser per Operating System 


	<TABLE ROW>
	Browser
	Browser

	Operating System 
	Operating System 



	<TABLE BODY>
	<TABLE ROW>
	Internet Explorer 9 and Internet Explorer 10
	Internet Explorer 9 and Internet Explorer 10

	Windows
	Windows


	<TABLE ROW>
	Safari
	Safari

	Macintosh
	Macintosh


	<TABLE ROW>
	Mozilla Firefox
	Mozilla Firefox

	Windows, Macintosh, and Linux 
	Windows, Macintosh, and Linux
	n If you plan to use the Firefox browser for FTP connections via the File Gateway, use the following format in your browser: username: virtual host name|ftpuser
	n If you plan to use the Firefox browser for FTP connections via the File Gateway, use the following format in your browser: username: virtual host name|ftpuser



	<TABLE ROW>
	Google Chrome
	Google Chrome

	Windows and Macintosh 
	Windows and Macintosh
	n If you plan to use the Chrome browser for FTP connections via the File Gateway, use the following format in your browser: ftp://ftpuser@virtual host name:password@ alias.domain.com
	n If you plan to use the Chrome browser for FTP connections via the File Gateway, use the following format in your browser: ftp://ftpuser@virtual host name:password@ alias.domain.com








	Intel Ethernet Drivers
	Intel Ethernet Drivers
	Intel Pro Ethernet adapter boards are recommended for most Windows based editing systems that connect to the Avid ISIS system.” The Intel Pro 1000 PT and Intel i350 T2 are a copper interface and the Intel Pro 1000 PF is an optical interface. The In...
	Intel Pro Ethernet adapter boards are recommended for most Windows based editing systems that connect to the Avid ISIS system.” The Intel Pro 1000 PT and Intel i350 T2 are a copper interface and the Intel Pro 1000 PF is an optical interface. The In...
	\Drivers\ISIS xxxx\Intel_Pro1000
	Intel_17.4_Winxxxx_xx.exe

	c Do not update the Intel drivers on Avid Interplay Engine cluster unless instructed to do so by the Interplay ReadMe or by Customer Support. Doing so could compromise the integrity of the cluster. 
	c Do not update the Intel drivers on Avid Interplay Engine cluster unless instructed to do so by the Interplay ReadMe or by Customer Support. Doing so could compromise the integrity of the cluster. 

	<TABLE>
	<TABLE>
	<TABLE HEADING>
	<TABLE ROW>
	Intel Network Driver Per Operating System
	Intel Network Driver Per Operating System


	<TABLE ROW>
	Operating System
	Operating System

	Driver installer
	Driver installer



	<TABLE BODY>
	<TABLE ROW>
	Windows 8 (64-bit)
	Windows 8 (64-bit)

	Intel_17.4_Win2K8-8-7-Vista_64.exe
	Intel_17.4_Win2K8-8-7-Vista_64.exe


	<TABLE ROW>
	Windows 7 (64-bit)
	Windows 7 (64-bit)

	Intel_17.4_Win2K8-8-7-Vista_64.exe
	Intel_17.4_Win2K8-8-7-Vista_64.exe


	<TABLE ROW>
	Windows Vista (64-bit)
	Windows Vista (64-bit)

	Intel_17.4_Win2K8-8-7-Vista_64.exe
	Intel_17.4_Win2K8-8-7-Vista_64.exe


	<TABLE ROW>
	Windows XP (32-bit)
	Windows XP (32-bit)

	Intel_17.4_Win2K3-XP_32.exe
	Intel_17.4_Win2K3-XP_32.exe


	<TABLE ROW>
	Windows Storage Server 2008 R2 (64-bit)
	Windows Storage Server 2008 R2 (64-bit)

	Intel_17.4_Win2K8-8-7-Vista_64.exe
	Intel_17.4_Win2K8-8-7-Vista_64.exe


	<TABLE ROW>
	Windows Storage Server 2008 (64-bit)
	Windows Storage Server 2008 (64-bit)

	Intel_17.4_Win2K8-8-7-Vista_64.exe
	Intel_17.4_Win2K8-8-7-Vista_64.exe


	<TABLE ROW>
	Windows Storage Server 2003 (64-bit)
	Windows Storage Server 2003 (64-bit)

	Intel_17.4_Win2K3-XP_64.exe
	Intel_17.4_Win2K3-XP_64.exe


	<TABLE ROW>
	Windows Server 2003 (64-bit)
	Windows Server 2003 (64-bit)

	Intel_17.4_Win2K3-XP_64.exe
	Intel_17.4_Win2K3-XP_64.exe






	Loading or Updating the Intel Pro Driver on Windows Clients
	Loading or Updating the Intel Pro Driver on Windows Clients
	To load the Intel Pro driver on a Windows system:
	To load the Intel Pro driver on a Windows system:
	To load the Intel Pro driver on a Windows system:
	1. Copy the file titled 
	1. Copy the file titled 
	Intel_xx.x
	Avid ISIS software kit 
	\Drivers\ISIS Client\Intel_Pro1000\


	2. Double-click the .exe file to expand the compressed file and run the installer.
	2. Double-click the .exe file to expand the compressed file and run the installer.

	3. Accept the default settings to install the driver.
	3. Accept the default settings to install the driver.
	n The default Intel transmit and receive descriptors are set to 256 however, when loading the Avid ISIS client software the transmit and receive descriptors are set to 1024. For more information, see 
	n The default Intel transmit and receive descriptors are set to 256 however, when loading the Avid ISIS client software the transmit and receive descriptors are set to 1024. For more information, see 
	n The default Intel transmit and receive descriptors are set to 256 however, when loading the Avid ISIS client software the transmit and receive descriptors are set to 1024. For more information, see 
	Avid ISIS Client Guide




	4. After the Intel driver is installed, restart the Windows system.
	4. After the Intel driver is installed, restart the Windows system.




	Intel Pro Driver on ISIS 5500 Engines
	Intel Pro Driver on ISIS 5500 Engines
	The Intel driver is automatically updated and configured on the ISIS 5500 System Director and Engines when you install the ISIS 5500 Software. 
	The Intel driver is automatically updated and configured on the ISIS 5500 System Director and Engines when you install the ISIS 5500 Software. 


	HP Z820 Integrated Network Port Not Supported
	HP Z820 Integrated Network Port Not Supported
	The integrated 82759LM port is marked with the letters AMT in the HP Z820 Workstation is not supported as an ISIS client connection. The other integrated Ethernet port that is not labeled is qualified for an ISIS client a connection. To use a dual 1 ...
	The integrated 82759LM port is marked with the letters AMT in the HP Z820 Workstation is not supported as an ISIS client connection. The other integrated Ethernet port that is not labeled is qualified for an ISIS client a connection. To use a dual 1 ...


	HP Z400, HP Z420, and HP Z800 Integrated Network Port Not Supported
	HP Z400, HP Z420, and HP Z800 Integrated Network Port Not Supported
	The integrated Gigabit Ethernet controller in the HP Z400, HP Z420, and HP Z800 Workstations are not supported as an ISIS client connection. The HP Z400, HP Z420, and HP Z800 require the installation of the Intel Pro 1000 PT, Intel i350 T2 or Intel P...
	The integrated Gigabit Ethernet controller in the HP Z400, HP Z420, and HP Z800 Workstations are not supported as an ISIS client connection. The HP Z400, HP Z420, and HP Z800 require the installation of the Intel Pro 1000 PT, Intel i350 T2 or Intel P...


	HP Z200 and Z210 Integrated Network Port Is Supported
	HP Z200 and Z210 Integrated Network Port Is Supported
	The integrated Intel 82578 Gigabit Ethernet controller in HP Z200 and Z210 Workstations are supported as an ISIS client connection. The Z200 Z210 were qualified for use with Avid Assist, Avid Instinct, and software-only Avid editing clients. The curr...
	The integrated Intel 82578 Gigabit Ethernet controller in HP Z200 and Z210 Workstations are supported as an ISIS client connection. The Z200 Z210 were qualified for use with Avid Assist, Avid Instinct, and software-only Avid editing clients. The curr...


	HP xw8600 ISIS Client Support
	HP xw8600 ISIS Client Support
	The Intel Pro 1000 board slot in HP xw8600 with has changed in ISIS v3.2. The previous slot for the Intel Pro 1000 was slot 6; the new slot requirement is slot 5. For details on the slot location, search the Avid Knowledge Base for the “Avid Config...
	The Intel Pro 1000 board slot in HP xw8600 with has changed in ISIS v3.2. The previous slot for the Intel Pro 1000 was slot 6; the new slot requirement is slot 5. For details on the slot location, search the Avid Knowledge Base for the “Avid Config...
	www.avid.com/US/support

	The Intel driver for the Intel Pro 1000 board in slot 5 also requires Intel driver v14.7. This is the same version as previously supported. Do not update the Intel Pro 1000 driver to v17.4 as required for all other supported Windows clients. The Inte...
	\Drivers\ISIS Client\Intel_Pro1000




	Small Tree Optical Adapters for Macintosh Clients
	Small Tree Optical Adapters for Macintosh Clients
	Avid has also qualified the Small Tree PEG1F single port or PEG2F dual port optical adapters in the slot 2 of a Macintosh Pro Nehalem system (2.66 GHz or 2.93 GHz) to be used in the Force10 S24P optical (fibre) switch.
	Avid has also qualified the Small Tree PEG1F single port or PEG2F dual port optical adapters in the slot 2 of a Macintosh Pro Nehalem system (2.66 GHz or 2.93 GHz) to be used in the Force10 S24P optical (fibre) switch.


	Qualified and Approved ISIS Switches
	Qualified and Approved ISIS Switches
	The following tables provide a summary of what switches have been qualified or approved for use in the Avid Production Network (APN) of the indicated ISIS Shared Storage Environment. The tables also identifies the qualified external switches (EXS) fo...
	The following tables provide a summary of what switches have been qualified or approved for use in the Avid Production Network (APN) of the indicated ISIS Shared Storage Environment. The tables also identifies the qualified external switches (EXS) fo...
	Avid Network and Switch Setup Guide
	Avid Network and Switch Setup Guide

	\AvidISISDocumentation

	Qualified and approved switches are defined as follows:
	• Qualified — tested with each major software release.
	• Qualified — tested with each major software release.
	• Qualified — tested with each major software release.

	• Approved — tested once with no subsequent re-testing.
	• Approved — tested once with no subsequent re-testing.


	<TABLE>
	<TABLE>
	<TABLE HEADING>
	<TABLE ROW>
	APN Switches Qualified for the ISIS Environment 
	APN Switches Qualified for the ISIS Environment 


	<TABLE ROW>
	Switch
	Switch

	ISIS 7000
	ISIS 7000

	ISIS 7000 External Expansion Switches (EXS)
	ISIS 7000 External Expansion Switches (EXS)

	ISIS 5500
	ISIS 5500

	ISIS 2000
	ISIS 2000



	<TABLE BODY>
	<TABLE ROW>
	Cisco Catalyst 4948E
	Cisco Catalyst 4948E

	3
	3

	3
	3


	<TABLE ROW>
	Cisco Catalyst 4948-10GE
	Cisco Catalyst 4948-10GE

	3
	3

	3
	3


	<TABLE ROW>
	Cisco Catalyst 4900M
	Cisco Catalyst 4900M

	3
	3

	3
	3

	3
	3

	3
	3


	<TABLE ROW>
	Force10 S25N and S25P
	Force10 S25N and S25P

	3
	3


	<TABLE ROW>
	Force10 S60
	Force10 S60

	3
	3

	3
	3


	<TABLE ROW>
	Force10 S4810
	Force10 S4810

	3
	3

	3
	3

	3
	3


	<TABLE ROW>
	Foundry/Brocade FESX424 and FESX624
	Foundry/Brocade FESX424 and FESX624

	3
	3

	3
	3





	<TABLE>
	<TABLE>
	<TABLE HEADING>
	<TABLE ROW>
	APN Switches Approved for the ISIS Environment 
	APN Switches Approved for the ISIS Environment 


	<TABLE ROW>
	Switch
	Switch

	ISIS 7000
	ISIS 7000

	ISIS 7000 External Expansion Switches (EXS)
	ISIS 7000 External Expansion Switches (EXS)

	ISIS 5500
	ISIS 5500

	ISIS 2000
	ISIS 2000



	<TABLE BODY>
	<TABLE ROW>
	Arista Networks 7048T-A
	Arista Networks 7048T-A

	3
	3

	3
	3


	<TABLE ROW>
	Cisco Nexus 7000 series
	Cisco Nexus 7000 series

	3
	3

	3
	3

	3
	3


	<TABLE ROW>
	Cisco Catalyst 4500-X
	Cisco Catalyst 4500-X

	3
	3

	3
	3

	3
	3

	3
	3


	<TABLE ROW>
	Cisco Catalyst 6500-E series
	Cisco Catalyst 6500-E series

	3
	3

	3
	3

	3
	3


	<TABLE ROW>
	Foundry/Brocade SuperX
	Foundry/Brocade SuperX

	3
	3

	3
	3

	3
	3


	<TABLE ROW>
	Foundry/Brocade FESX448 and FESX648
	Foundry/Brocade FESX448 and FESX648

	3
	3

	3
	3





	Most Windows editing clients must use the 1 Gb Intel Pro 1000 PT, Intel i350 T2 or Intel Pro 1000 PF Ethernet board to connect to all Avid ISIS system. Macintosh clients can use the built-in Ethernet port or Small Tree PEG1F or PEG2F optical adapters.
	n All Force10 switches ship from Avid preconfigured for an Avid ISIS 5500 environment. You should upgrade your switch to the latest configuration file found in the ISIS software kit. For information on configuring the switches, see the 
	n All Force10 switches ship from Avid preconfigured for an Avid ISIS 5500 environment. You should upgrade your switch to the latest configuration file found in the ISIS software kit. For information on configuring the switches, see the 
	Avid Network and Switch Setup Guide
	[drive]:\AvidISISDocumentation


	n When connecting 10 Gb clients on Force10 S25 switches, you must enable flow control TX and RX on the 10 Gb switch ports for the ISIS clients, servers, and Engines, see 
	n When connecting 10 Gb clients on Force10 S25 switches, you must enable flow control TX and RX on the 10 Gb switch ports for the ISIS clients, servers, and Engines, see 
	Turning on Flow Control in the Force10 S25 Switch




	Cascaded Switches
	Cascaded Switches
	Limited cascaded switch configurations are supported in ISIS environments. For information on supported configurations, see the 
	Limited cascaded switch configurations are supported in ISIS environments. For information on supported configurations, see the 
	Avid Network and Switch Setup Guide
	Avid Network and Switch Setup Guide

	\AvidISISDocumentation



	Gold Disk Qualification
	Gold Disk Qualification
	The following Avid ISIS systems comply with US Defense Information Systems Agency (DISA) Gold Disk requirements for network devices:
	The following Avid ISIS systems comply with US Defense Information Systems Agency (DISA) Gold Disk requirements for network devices:
	• Avid ISIS 7000 v4.
	• Avid ISIS 7000 v4.
	• Avid ISIS 7000 v4.
	x


	• Avid ISIS 5500 v4.
	• Avid ISIS 5500 v4.
	x


	• Avid ISIS 2000 v4.5
	• Avid ISIS 2000 v4.5
	n Only Windows 8, Windows 7, and Windows Vista (64-bit) clients were qualified the Gold Disk environment. Macintosh and Linux clients are not supported.
	n Only Windows 8, Windows 7, and Windows Vista (64-bit) clients were qualified the Gold Disk environment. Macintosh and Linux clients are not supported.



	The following requirements apply in a Gold Disk environment.

	Software Installation
	Software Installation
	To install the ISIS software in a Gold Disk environment:
	To install the ISIS software in a Gold Disk environment:
	To install the ISIS software in a Gold Disk environment:
	1. Remove the System Director from the Active Directory Domain.
	1. Remove the System Director from the Active Directory Domain.

	2. Log into the local Administrator account, created prior to adding the System Director to the Active Directory Domain (note that Administrator is disabled).
	2. Log into the local Administrator account, created prior to adding the System Director to the Active Directory Domain (note that Administrator is disabled).

	3. Install the ISIS software (System Director, switch, storage blades and Engine upgrades).
	3. Install the ISIS software (System Director, switch, storage blades and Engine upgrades).

	4. Once completed, add the System Director back into the Active Directory Domain.
	4. Once completed, add the System Director back into the Active Directory Domain.




	ISIS Control Panel Functions
	ISIS Control Panel Functions
	In a Gold Disk environment you must open the System Director Control Panel from the Programs menu.
	In a Gold Disk environment you must open the System Director Control Panel from the Programs menu.
	In a Gold Disk environment you must open the System Director Control Panel from the Programs menu.

	To use the ISIS Control Panel in a Gold Disk environment:
	To use the ISIS Control Panel in a Gold Disk environment:
	1. Click Start > Programs > Avid > ISIS System Director > Control Panel. 
	1. Click Start > Programs > Avid > ISIS System Director > Control Panel. 

	2. When prompted, select “Run as Administrator.”
	2. When prompted, select “Run as Administrator.”
	This enables you to Start and Stop the System Director, as well as set or modify other configurations. 
	This enables you to Start and Stop the System Director, as well as set or modify other configurations. 





	Compatibility with Internet Explorer
	Compatibility with Internet Explorer
	To turn on compatibility mode in Internet Explorer:
	To turn on compatibility mode in Internet Explorer:
	To turn on compatibility mode in Internet Explorer:
	1. Click the Tools menu and select Compatibility View Settings in your Internet Explorer browser.
	1. Click the Tools menu and select Compatibility View Settings in your Internet Explorer browser.

	2. Type in the IP address of your Storage Manager and click Add.
	2. Type in the IP address of your Storage Manager and click Add.

	3. Close the open browser dialog box.
	3. Close the open browser dialog box.




	Add Storage Manager as a Trusted Site
	Add Storage Manager as a Trusted Site
	To add Storage Manager as a trusted site:
	To add Storage Manager as a trusted site:
	To add Storage Manager as a trusted site:
	1. Click the Tools menu and select Internet Options in your Internet Explorer browser.
	1. Click the Tools menu and select Internet Options in your Internet Explorer browser.

	2. Click the security tab.
	2. Click the security tab.

	3. Click Trusted sites.
	3. Click Trusted sites.

	4. Click the Sites button.
	4. Click the Sites button.

	5. Type in the IP address of your Storage Manager and click Add.
	5. Type in the IP address of your Storage Manager and click Add.

	6. Close the two open browser dialog boxes.
	6. Close the two open browser dialog boxes.






	Special Notes (ISIS 7500 | 7000, 5500 | 5000, and 2000)
	Special Notes (ISIS 7500 | 7000, 5500 | 5000, and 2000)
	This section contains important information about the Avid ISIS environment.
	This section contains important information about the Avid ISIS environment.

	Delete Logging Setting
	Delete Logging Setting
	Turning delete logging on or off while files are actively being deleted from the ISIS file system will cause the ISIS System Director to crash. Avid recommends that you do not change the delete logging setting during normal operation of your ISIS sys...
	Turning delete logging on or off while files are actively being deleted from the ISIS file system will cause the ISIS System Director to crash. Avid recommends that you do not change the delete logging setting during normal operation of your ISIS sys...


	User Permissions
	User Permissions
	A user account with Administrator privileges is required to install Avid ISIS client software on your workstations.
	A user account with Administrator privileges is required to install Avid ISIS client software on your workstations.


	Flash Player Software
	Flash Player Software
	To use the ISIS Management Console, make sure the Adobe Flash Player (v11.
	To use the ISIS Management Console, make sure the Adobe Flash Player (v11.
	x



	Avid Interplay Authentication
	Avid Interplay Authentication
	Avid Interplay Authentication requires the Avid ISIS System Director to use a virtual name. The System Director’s virtual name must not match the actual host name and must be entered in the General Configuration Options dialog box. For instructions...
	Avid Interplay Authentication requires the Avid ISIS System Director to use a virtual name. The System Director’s virtual name must not match the actual host name and must be entered in the General Configuration Options dialog box. For instructions...
	Avid ISIS Administration Guide



	Avid Interplay Copy Service and Move Service in Zone 3
	Avid Interplay Copy Service and Move Service in Zone 3
	The Avid Interplay Copy Service and Move Service using an AS3000 or the SR2500 Interplay Copy/Move server with a single 10 Gb Myricom board installed has been qualified in Zone 3 of the ISIS 7000 and ISIS 5500 environments. This qualification require...
	The Avid Interplay Copy Service and Move Service using an AS3000 or the SR2500 Interplay Copy/Move server with a single 10 Gb Myricom board installed has been qualified in Zone 3 of the ISIS 7000 and ISIS 5500 environments. This qualification require...
	The Avid Interplay Copy Service and Move Service on the SR2500 server with the Chelsio 10 Gb network adapter is only qualified in Zone 1 of the ISIS 7000 environment. 


	Illegal Characters in File, User, and Workspace Names
	Illegal Characters in File, User, and Workspace Names
	You must use Unicode characters in workspace names. The following is a list of 17 illegal characters you should not use in workspace names, workgroup names, filenames, user names, device names, and storage group names: \ / = @ [ ] % * ? + | : " ; , <...
	You must use Unicode characters in workspace names. The following is a list of 17 illegal characters you should not use in workspace names, workgroup names, filenames, user names, device names, and storage group names: \ / = @ [ ] % * ? + | : " ; , <...
	n The System Director does not support viewing regional language characters in the Management Console.
	n The System Director does not support viewing regional language characters in the Management Console.



	LDAP Requires Unicode User Names and Passwords
	LDAP Requires Unicode User Names and Passwords
	The Avid implementation of LDAP (Lightweight Directory Access Protocol) requires that you restrict LDAP user names and passwords to ASCII. The LDAP/ISIS Account Synchronizer searches for groups and their users on an LDAP server and synchronizes (reco...
	The Avid implementation of LDAP (Lightweight Directory Access Protocol) requires that you restrict LDAP user names and passwords to ASCII. The LDAP/ISIS Account Synchronizer searches for groups and their users on an LDAP server and synchronizes (reco...


	Fast User Switching Not Supported
	Fast User Switching Not Supported
	Fast User Switching is a Windows feature that allows multiple user accounts to log on to a computer simultaneously. Fast User Switching is enabled by default in Windows computers. The Fast User Switching feature and multiple concurrent logged on user...
	Fast User Switching is a Windows feature that allows multiple user accounts to log on to a computer simultaneously. Fast User Switching is enabled by default in Windows computers. The Fast User Switching feature and multiple concurrent logged on user...
	• When one user maps a drive letter to one workspace and another user maps the same drive letter to a different workspace
	• When one user maps a drive letter to one workspace and another user maps the same drive letter to a different workspace
	• When one user maps a drive letter to one workspace and another user maps the same drive letter to a different workspace

	• When one user maps a workspace to one drive letter, and another user maps a different drive letter for the same workspace.
	• When one user maps a workspace to one drive letter, and another user maps a different drive letter for the same workspace.




	Avid ISIS Firewall
	Avid ISIS Firewall
	Avid ISIS ships with the Windows Firewall turned off. For a list of the ports used in the Avid ISIS, see the 
	Avid ISIS ships with the Windows Firewall turned off. For a list of the ports used in the Avid ISIS, see the 
	Avid Network and Switch Guide
	\AvidISISDocumentation



	Multiple ISIS Systems
	Multiple ISIS Systems
	If you are setting up multiple ISIS shared storage systems, make sure that each system is on a separate network.
	If you are setting up multiple ISIS shared storage systems, make sure that each system is on a separate network.


	Macintosh Resource Files and Windows Clients
	Macintosh Resource Files and Windows Clients
	If Macintosh files are copied to a Windows system with the Macintosh resource fork files, the resource fork files cannot be copied to mounted workspaces from a Windows client. Avid ISIS does not accept Macintosh resource fork files from Windows clien...
	If Macintosh files are copied to a Windows system with the Macintosh resource fork files, the resource fork files cannot be copied to mounted workspaces from a Windows client. Avid ISIS does not accept Macintosh resource fork files from Windows clien...


	Adobe Premiere Pro Software Approved
	Adobe Premiere Pro Software Approved
	Avid has tested Adobe Premiere Pro as a client in the Avid ISIS 7000 and ISIS 5500 shared storage environments. The ISIS 2000 only supports Adobe Premiere Pro in push/pull workflows. The following guidelines and restrictions apply to Adobe Premiere c...
	Avid has tested Adobe Premiere Pro as a client in the Avid ISIS 7000 and ISIS 5500 shared storage environments. The ISIS 2000 only supports Adobe Premiere Pro in push/pull workflows. The following guidelines and restrictions apply to Adobe Premiere c...
	• Adobe Premiere was qualified on Windows 7 64-bit and Macintosh v10.7.3 64-bit operating systems.
	• Adobe Premiere was qualified on Windows 7 64-bit and Macintosh v10.7.3 64-bit operating systems.
	• Adobe Premiere was qualified on Windows 7 64-bit and Macintosh v10.7.3 64-bit operating systems.

	• Adobe Premiere 10 Gb clients are not supported.
	• Adobe Premiere 10 Gb clients are not supported.

	• Avid ISIS supports Adobe Premiere Pro clients in Zones 1, 2, and 3.
	• Avid ISIS supports Adobe Premiere Pro clients in Zones 1, 2, and 3.

	• Media from both Adobe Premier and Avid Media Composer are able to co-exist in the same Storage Group. Although for optimal performance, you should not mix Avid and Adobe Premier editors in the same Storage Group.
	• Media from both Adobe Premier and Avid Media Composer are able to co-exist in the same Storage Group. Although for optimal performance, you should not mix Avid and Adobe Premier editors in the same Storage Group.

	• Adobe Premiere clients follow the same guidelines as for Avid editors in regards to the Avid ISIS Client Manager Preference settings. The default Client Type setting is set to Medium Resolution (limited to resolutions that draw 16 MB/s or less). ...
	• Adobe Premiere clients follow the same guidelines as for Avid editors in regards to the Avid ISIS Client Manager Preference settings. The default Client Type setting is set to Medium Resolution (limited to resolutions that draw 16 MB/s or less). ...
	Avid ISIS Performance Guide
	www.avid.com/support





	Final Cut Pro Software Approved
	Final Cut Pro Software Approved
	Avid has tested Final Cut Pro version 7 as a client in the Avid ISIS 7500 | 7000 and ISIS 5500 | 5000 shared storage environments. The ISIS 2000 only supports Final Cut Pro in push/pull workflows. Testing was done with Final Cut Pro v7.0.3 with Mac O...
	Avid has tested Final Cut Pro version 7 as a client in the Avid ISIS 7500 | 7000 and ISIS 5500 | 5000 shared storage environments. The ISIS 2000 only supports Final Cut Pro in push/pull workflows. Testing was done with Final Cut Pro v7.0.3 with Mac O...
	x
	Avid ISIS Performance Guide
	www.avid.com/support

	n Avid Interplay Access supports the Mac OSX platform, and through this application Final Cut Pro QuickTime files and projects can be checked into Interplay. Any Interplay workstation can search for these files and edit their Interplay metadata, thou...
	n Avid Interplay Access supports the Mac OSX platform, and through this application Final Cut Pro QuickTime files and projects can be checked into Interplay. Any Interplay workstation can search for these files and edit their Interplay metadata, thou...
	n Avid Interplay Access supports the Mac OSX platform, and through this application Final Cut Pro QuickTime files and projects can be checked into Interplay. Any Interplay workstation can search for these files and edit their Interplay metadata, thou...




	Power Saving Modes
	Power Saving Modes
	Do not use power saving modes on Avid ISIS clients. Your power saving options should be set to never go into low power mode and should be set to “Always On” (Windows) or High Performance (Macintosh). Is it critical that each client in a Direct Co...
	Do not use power saving modes on Avid ISIS clients. Your power saving options should be set to never go into low power mode and should be set to “Always On” (Windows) or High Performance (Macintosh). Is it critical that each client in a Direct Co...


	Virus Protection
	Virus Protection
	Windows updates are not installed automatically on the System Director. If you are connected to the Internet, Avid recommends you manually select your Windows updates and install them during a scheduled maintenance intervals. Some updates require tha...
	Windows updates are not installed automatically on the System Director. If you are connected to the Internet, Avid recommends you manually select your Windows updates and install them during a scheduled maintenance intervals. Some updates require tha...
	Access the Knowledge Base at 
	www.avid.com/securityupdate
	www.avid.com/securityupdate


	c Virus protection software and Windows updates will result in workflow interruptions, and should be performed during a scheduled maintenance interval.
	c Virus protection software and Windows updates will result in workflow interruptions, and should be performed during a scheduled maintenance interval.



	Uninterruptible Power Supply
	Uninterruptible Power Supply
	Avid highly recommends using an Uninterruptible Power Supply (UPS) with all Avid ISIS components. 
	Avid highly recommends using an Uninterruptible Power Supply (UPS) with all Avid ISIS components. 
	Without a UPS if you lose power while capturing media, some data loss for newly captured media will likely occur. The recently written data in the RAID controller that has not been written out to the data drives would be lost. 



	Avid ISIS 7500 | 7000 Special Notes
	Avid ISIS 7500 | 7000 Special Notes
	The following is a list of features for should keep in mind with Avid ISIS 7500 | 7000 infrastructures:
	The following is a list of features for should keep in mind with Avid ISIS 7500 | 7000 infrastructures:

	Upgrading Unstacked Switches
	Upgrading Unstacked Switches
	If you need to upgrade switches that are not yet stacked, the Avid ISIS software kit includes the Avid ISIS Upgrade Utility. This stand-alone application allows field engineers to start and monitor the installation of switch and ISB upgrades from a l...
	If you need to upgrade switches that are not yet stacked, the Avid ISIS software kit includes the Avid ISIS Upgrade Utility. This stand-alone application allows field engineers to start and monitor the installation of switch and ISB upgrades from a l...
	Avid ISIS 7000 Setup Guide

	The Avid ISIS Upgrade Utility (AvidUnityISISTools.msi) can be found on the Avid ISIS software kit in the 
	\ISISUtilities\ISIS 7000



	ISIS 7500 | 7000 System Director
	ISIS 7500 | 7000 System Director
	The Avid ISIS System Director uses an Avid AS3000 server or Intel SR2500 server with 9 GB of memory and a 64-bit Window operating system. The new 64-bit System Director provides the following support:
	The Avid ISIS System Director uses an Avid AS3000 server or Intel SR2500 server with 9 GB of memory and a 64-bit Window operating system. The new 64-bit System Director provides the following support:
	• 64-bit System Director — 10 million files
	• 64-bit System Director — 10 million files
	• 64-bit System Director — 10 million files

	• 64-bit System Director — 500,000 folders (25,000 files per folder)
	• 64-bit System Director — 500,000 folders (25,000 files per folder)

	• 5638 users
	• 5638 users

	• 1000 groups — a user can be in 15 groups
	• 1000 groups — a user can be in 15 groups




	ISIS 7000 Client Connections
	ISIS 7000 Client Connections
	Starting with ISIS v4.0, Avid ISIS 7000 automatically supports up to 330 ISIS client licenses. 
	Starting with ISIS v4.0, Avid ISIS 7000 automatically supports up to 330 ISIS client licenses. 


	Storage Group Size
	Storage Group Size
	Storage Managers are combined to create Storage Groups in the ISIS file system. These Storage Groups can be configured to operate using either 512 KB (default) or 256 KB chunk sizes. Earlier Avid ISIS releases used 256 KB chunk sizes. For more inform...
	Storage Managers are combined to create Storage Groups in the ISIS file system. These Storage Groups can be configured to operate using either 512 KB (default) or 256 KB chunk sizes. Earlier Avid ISIS releases used 256 KB chunk sizes. For more inform...
	Avid ISIS Administration Guide.

	n Avid ISIS switch hardware shipped with v1.x (ISS1000 and IXS1000) does not support 512 KB chunk sizes. If you have Avid ISIS v2.x software running on v1.x switches, you must select the 256 KB chunk size when adding Storage Managers to the file syst...
	n Avid ISIS switch hardware shipped with v1.x (ISS1000 and IXS1000) does not support 512 KB chunk sizes. If you have Avid ISIS v2.x software running on v1.x switches, you must select the 256 KB chunk size when adding Storage Managers to the file syst...

	You cannot change the chunk size of a Storage Group once the Storage Group has been created. To change the chunk size of an existing Storage Group, you must delete the Storage Group and create a new Storage Group with the desired chunk size. The chun...


	Chunk Size Support With ISB
	Chunk Size Support With ISB
	All ISBs (i500, i1000, i2000, i4000 and i8000) support the 512 KB chunk size, although you must have v2.x switch hardware (ISS2000 and IXS2000) to use the 512 KB chunk size. Only i500 and i1000 ISBs support 256 KB chunk sizes.
	All ISBs (i500, i1000, i2000, i4000 and i8000) support the 512 KB chunk size, although you must have v2.x switch hardware (ISS2000 and IXS2000) to use the 512 KB chunk size. Only i500 and i1000 ISBs support 256 KB chunk sizes.


	10 Gb Client Support in ISIS 7000
	10 Gb Client Support in ISIS 7000
	The following are guidelines as to the number of clients that are supported in Zone 1 (directly connected to an ISS in an ISIS 7000 Engine). When a 10 Gb device is connected to your ISS, some of the 1 Gb ports cannot be used:
	The following are guidelines as to the number of clients that are supported in Zone 1 (directly connected to an ISS in an ISIS 7000 Engine). When a 10 Gb device is connected to your ISS, some of the 1 Gb ports cannot be used:
	• High Resolution 1 Gb clients — four or less with one Ultra High Resolution 10 Gb client
	• High Resolution 1 Gb clients — four or less with one Ultra High Resolution 10 Gb client
	• High Resolution 1 Gb clients — four or less with one Ultra High Resolution 10 Gb client

	• Medium Resolution 1 Gb clients — five or less with one Ultra High Resolution 10 Gb client
	• Medium Resolution 1 Gb clients — five or less with one Ultra High Resolution 10 Gb client




	RAID-6 Storage Groups, Single ISB Failure
	RAID-6 Storage Groups, Single ISB Failure
	When there is a single ISB failure in an ISIS Storage Group configured with RAID protection, the Storage Group continues to function normally at a lower bandwidth. For mirrored Storage Groups, see 
	When there is a single ISB failure in an ISIS Storage Group configured with RAID protection, the Storage Group continues to function normally at a lower bandwidth. For mirrored Storage Groups, see 
	“Mirrored Storage Groups, Single ISB Failure” on page 51

	After confirming the failure of an ISB, Avid highly recommends that you initiate the remove redistribution process of the failed ISB immediately. There are two benefits to doing this: 
	• Immediately upon initiation of the remove redistribution, all new writes to the Storage Group have the full benefit of RAID-6 protection (dual-parity protection). 
	• Immediately upon initiation of the remove redistribution, all new writes to the Storage Group have the full benefit of RAID-6 protection (dual-parity protection). 
	• Immediately upon initiation of the remove redistribution, all new writes to the Storage Group have the full benefit of RAID-6 protection (dual-parity protection). 

	• Upon completion of the remove redistribution process, existing data in the Storage Group is once again fully protected. Prior to completion, if another ISB were to fail, the Storage Group would be in an unprotected state (though no data would be ...
	• Upon completion of the remove redistribution process, existing data in the Storage Group is once again fully protected. Prior to completion, if another ISB were to fail, the Storage Group would be in an unprotected state (though no data would be ...




	RAID-6 Storage Groups, Dual ISB Failure
	RAID-6 Storage Groups, Dual ISB Failure
	An “unprotected state” exists if a RAID-6 Storage Group has two failed ISBs. In an unprotected state with no additional failures, read operations continue to function normally at a lower bandwidth. 
	An “unprotected state” exists if a RAID-6 Storage Group has two failed ISBs. In an unprotected state with no additional failures, read operations continue to function normally at a lower bandwidth. 
	However, in an unprotected state, due to the distributed architecture of the ISIS file system (optimized for real-time performance), under certain circumstances the system cannot correctly update the parity information when writing new data. As a res...
	This issue only applies when the Storage Group is in an unprotected state and the remove redistribution process on the failed ISBs has not been initiated. Therefore, it is highly recommended that the remove redistribution process is initiated immedia...


	Mirrored Storage Groups, Single ISB Failure
	Mirrored Storage Groups, Single ISB Failure
	An “unprotected state” exists if a single ISB fails in a mirrored Storage Group. In an unprotected state with no additional failures, read operations continue to function normally.
	An “unprotected state” exists if a single ISB fails in a mirrored Storage Group. In an unprotected state with no additional failures, read operations continue to function normally.
	However, in an unprotected state a subsequent or infrastructure failure will cause operational issues which could result in failures when writing new data or prevent you from accessing data in the Storage Group. An additional ISB failure creates a si...
	This issue only applies when the Storage Group is in an unprotected state and the remove redistribution process on the failed ISBs has not been initiated. Therefore, it is highly recommended that the remove redistribution process is initiated immedia...


	Adding or Removing ISBs (Mirrored or RAID-6)
	Adding or Removing ISBs (Mirrored or RAID-6)
	When permanently adding or removing ISBs from an ISIS Storage Group (for example, adding or removing an engine to the storage stack), Avid recommends performing a full redistribution for all workspaces in the Storage Group, after the ISB add or remov...
	When permanently adding or removing ISBs from an ISIS Storage Group (for example, adding or removing an engine to the storage stack), Avid recommends performing a full redistribution for all workspaces in the Storage Group, after the ISB add or remov...
	The full redistribution makes sure all blocks in the Storage Group are optimally distributed based on the new permanent configuration, and minimizes the potential for problems if a full redistribution is required in the future; for example, storage b...
	This recommendation does not apply to the case of removing and then replacing failed storage blades. For other examples of symmetric and non-symmetric redistributions, see the 
	Avid ISIS Performance and Redistribution Guide
	www.avid.com/US/support



	Adding a Storage Manager (ISB) to the File System
	Adding a Storage Manager (ISB) to the File System
	If you add an Storage Manager (displays as an unbound Storage Manager) to your file system, make sure you match the Chunk Size of the new Storage Manager to the Chunk Size of the existing Storage Group. New Storage Managers are added with a default c...
	If you add an Storage Manager (displays as an unbound Storage Manager) to your file system, make sure you match the Chunk Size of the new Storage Manager to the Chunk Size of the existing Storage Group. New Storage Managers are added with a default c...


	Zone 1 Switches
	Zone 1 Switches
	The ISIS v2.
	The ISIS v2.
	x
	“Storage Group Size” on page 49

	The Avid ISIS documentation refers to IXS2000 and ISS2000 switches as v2.
	x
	x



	Full Redistribution
	Full Redistribution
	After updating the Avid ISIS server software, and the ISIS software on all the clients, Avid recommends you do a full redistribution (one-time full remapping redistribution) at your earliest convenience to take advantage of the performance optimizati...
	After updating the Avid ISIS server software, and the ISIS software on all the clients, Avid recommends you do a full redistribution (one-time full remapping redistribution) at your earliest convenience to take advantage of the performance optimizati...
	c Once you do a full redistribution with v2.
	c Once you do a full redistribution with v2.
	x
	x
	“Software Installation Instructions” on page 13


	The faster full redistributions only apply to workspaces that have had symmetric configuration changes; for example, if you removed and then added the same number of ISBs to a storage group in a single configuration change. For examples of symmetric ...
	Avid ISIS Performance and Redistribution Guide.

	A full redistribution is still recommended at 10 configuration changes. At 32 configuration changes the Avid ISIS software automatically performs a full redistribution. 


	Automatic Redistribution on Disk Failure
	Automatic Redistribution on Disk Failure
	Avid ISIS performs an automatic redistribution on Disk Failure notification. Storage Elements continuously monitors disk status and sends a “Disk Failed” notification to the System Director upon determination that a disk is not usable. The System...
	Avid ISIS performs an automatic redistribution on Disk Failure notification. Storage Elements continuously monitors disk status and sends a “Disk Failed” notification to the System Director upon determination that a disk is not usable. The System...
	The Automatic Removal feature is controlled by a system preference, called “Auto Remove Redistribution on Disk Failure,” that is configured using the ISIS Management Console Preferences tool. The default setting is “enabled.” The Storage Elem...
	• The Storage Element participates in the removal redistribution. This is required to prevent data loss when full redundancy has not been attained for all data blocks.
	• The Storage Element participates in the removal redistribution. This is required to prevent data loss when full redundancy has not been attained for all data blocks.
	• The Storage Element participates in the removal redistribution. This is required to prevent data loss when full redundancy has not been attained for all data blocks.

	• The Storage Element continues to report status, such as physically replacing the blade.
	• The Storage Element continues to report status, such as physically replacing the blade.


	Auto-removal status is reported in the System Event Log. A sequence of event log entries is generated for the initial report of the failure, the decision to remove the Storage Element, and subsequent success or failure. Events are also logged for the...
	When using Automatic Redistribution: 
	• Keep at least 7% of your Storage Group unused at all times. Failure to do so can cause the system to run out of space after an automatic redistribution has initiated and cause a client outage. For more information, see 
	• Keep at least 7% of your Storage Group unused at all times. Failure to do so can cause the system to run out of space after an automatic redistribution has initiated and cause a client outage. For more information, see 
	• Keep at least 7% of your Storage Group unused at all times. Failure to do so can cause the system to run out of space after an automatic redistribution has initiated and cause a client outage. For more information, see 
	“Minimum ISIS 7000 Storage Space Requirement” on page 55


	• If an automatic redistribution of a Storage Group is started during a critical time the overall system performance can degrade significantly and be disruptive. For more information on understanding the performance characteristics during remove re...
	• If an automatic redistribution of a Storage Group is started during a critical time the overall system performance can degrade significantly and be disruptive. For more information on understanding the performance characteristics during remove re...
	Avid ISIS Performance and Redistribution Guide


	• An automatic redistribution removes the Storage Element from the Storage Group but not from the file system. Once an automatic redistribution has completed, remove the Storage Element from the file system with the software and then physically rep...
	• An automatic redistribution removes the Storage Element from the Storage Group but not from the file system. Once an automatic redistribution has completed, remove the Storage Element from the file system with the software and then physically rep...

	• If unmirrored workspaces are in use, the data will be damaged on those workspaces in that Storage Group.
	• If unmirrored workspaces are in use, the data will be damaged on those workspaces in that Storage Group.




	Firmware Upgrade During a Redistribution
	Firmware Upgrade During a Redistribution
	Do not perform an ISB firmware upgrade while a Redistribution is in process. Make sure all firmware upgrades are completed before starting any redistribution. The following events trigger redistribution:
	Do not perform an ISB firmware upgrade while a Redistribution is in process. Make sure all firmware upgrades are completed before starting any redistribution. The following events trigger redistribution:
	Do not perform an ISB firmware upgrade while a Redistribution is in process. Make sure all firmware upgrades are completed before starting any redistribution. The following events trigger redistribution:
	• Moving a Workspace
	• Moving a Workspace
	• Moving a Workspace

	• Clicking “Full Redistribution” on a Workspace
	• Clicking “Full Redistribution” on a Workspace

	• Adding a Storage Element to a Storage Group
	• Adding a Storage Element to a Storage Group

	• Removing a Storage Element from a Storage Group
	• Removing a Storage Element from a Storage Group

	• Changing the state of a Workspace to mirrored or unmirrored 
	• Changing the state of a Workspace to mirrored or unmirrored 



	If a firmware upgrade must be done and a redistribution in progress, do the following:
	If a firmware upgrade must be done and a redistribution in progress, do the following:
	1. Suspend the active redistribution using the Advanced Commands in Workspace window.
	1. Suspend the active redistribution using the Advanced Commands in Workspace window.

	2. Verify that the Workspace displays “redistribution suspended” in the Status column and all other workspaces do not have “redistribution in progress” displayed.
	2. Verify that the Workspace displays “redistribution suspended” in the Status column and all other workspaces do not have “redistribution in progress” displayed.

	3. Perform the firmware upgrade on the ISB(s) that must be upgraded.
	3. Perform the firmware upgrade on the ISB(s) that must be upgraded.

	4. Wait until the firmware upgrade is completed successfully.
	4. Wait until the firmware upgrade is completed successfully.

	5. Resume the redistribution using the Workspace window.
	5. Resume the redistribution using the Workspace window.




	Avid Interplay Authentication
	Avid Interplay Authentication
	Avid Interplay Authentication requires the Avid ISIS System Director to use a virtual name. The System Director’s virtual name must not match the actual host name and must be entered in the General Configuration Options dialog box even if your Avid...
	Avid Interplay Authentication requires the Avid ISIS System Director to use a virtual name. The System Director’s virtual name must not match the actual host name and must be entered in the General Configuration Options dialog box even if your Avid...
	Avid ISIS Administration Guide



	Workspace Names
	Workspace Names
	You must use Unicode characters in workspace names. You cannot use the following 16 illegal characters in workspace names, workgroup names, filenames, user names, device names, and storage group names: \ / = @ [ ] % * ? + | : " ; , < >. In addition, ...
	You must use Unicode characters in workspace names. You cannot use the following 16 illegal characters in workspace names, workgroup names, filenames, user names, device names, and storage group names: \ / = @ [ ] % * ? + | : " ; , < >. In addition, ...
	You must use Unicode characters in workspace names. You cannot use the following 16 illegal characters in workspace names, workgroup names, filenames, user names, device names, and storage group names: \ / = @ [ ] % * ? + | : " ; , < >. In addition, ...
	n The System Director does not support viewing regional language characters in the Management Console.
	n The System Director does not support viewing regional language characters in the Management Console.

	Workspace names beginning or ending with a period are no longer valid in Avid ISIS v1.4 and later. If you already have workspace names with periods and upgrade to Avid ISIS v1.4, the original issues continue to exist as outlined below: 
	• Windows — Data is preserved and intact with display issues. A filename or directory with a period at the end is invalid in Windows. As a result the Avid ISIS client is trying to interpret a period at the end of a workspace into something Window...
	• Windows — Data is preserved and intact with display issues. A filename or directory with a period at the end is invalid in Windows. As a result the Avid ISIS client is trying to interpret a period at the end of a workspace into something Window...
	• Windows — Data is preserved and intact with display issues. A filename or directory with a period at the end is invalid in Windows. As a result the Avid ISIS client is trying to interpret a period at the end of a workspace into something Window...

	• Macintosh — Data is preserved and intact, but any workspace with a name that starts with a period is treated as a hidden directory by Mac OS X. By default such a workspace cannot be accessed via the Desktop and cannot be seen in the “/Volumes...
	• Macintosh — Data is preserved and intact, but any workspace with a name that starts with a period is treated as a hidden directory by Mac OS X. By default such a workspace cannot be accessed via the Desktop and cannot be seen in the “/Volumes...



	To access the contents of the Macintosh workspace:
	To access the contents of the Macintosh workspace:
	t Click Go > Go to Folder… menu in the Finder and type the path “/Volumes/” followed by the workspace name (for example, “/Volumes/
	t Click Go > Go to Folder… menu in the Finder and type the path “/Volumes/” followed by the workspace name (for example, “/Volumes/
	.MyWorkspace

	A window opens showing the contents of the workspace and makes the workspace temporarily visible as a subdirectory of “/Volumes.”
	A window opens showing the contents of the workspace and makes the workspace temporarily visible as a subdirectory of “/Volumes.”





	Network Connections
	Network Connections
	The ISIS network topology uses two separate domains, with one domain represented by the ISSs on the left side of the ISIS Engine and the second domain represented by the ISSs on the right side. The default network IP address configuration is shown in...
	The ISIS network topology uses two separate domains, with one domain represented by the ISSs on the left side of the ISIS Engine and the second domain represented by the ISSs on the right side. The default network IP address configuration is shown in...
	<TABLE>
	<TABLE>
	<TABLE HEADING>
	<TABLE ROW>
	Default Network Addresses for Avid ISIS Engines
	Default Network Addresses for Avid ISIS Engines


	<TABLE ROW>
	Location 
	Location 

	Network IP Addresses
	Network IP Addresses

	Subnet Mask
	Subnet Mask



	<TABLE BODY>
	<TABLE ROW>
	Left side of engine
	Left side of engine

	192.168.10.0
	192.168.10.0

	255.255.255.0
	255.255.255.0


	<TABLE ROW>
	Right side of engine
	Right side of engine

	192.168.20.0
	192.168.20.0

	255.255.255.0
	255.255.255.0





	For more addressing information, see “IP Addressing Overview” in the 
	Avid ISIS 7000 Setup Guide

	Avid ISIS does not support Zone 1, 10/100 BASE-T network interface connections. 10/100 BASE-T clients must be attached as a Zone 2 or 3 client. 


	Minimum ISIS 7000 Storage Space Requirement
	Minimum ISIS 7000 Storage Space Requirement
	Avid recommends that you maintain 7% of free space in each Storage Group. In other words, you should not fill a Storage Group more than 93% full. Exceeding 93% used space can produce severe performance issues in some situations. 
	Avid recommends that you maintain 7% of free space in each Storage Group. In other words, you should not fill a Storage Group more than 93% full. Exceeding 93% used space can produce severe performance issues in some situations. 
	To calculate the right amount of free space, log into the ISIS management Console and navigate to the Storage Group window. For each Storage Group, take the Effective number and multiply by 0.07. This will be your recommended free space in GBs. To ma...


	Enabling the Distributed File System on Windows Vista
	Enabling the Distributed File System on Windows Vista
	Avid ISIS v2.0.4 and earlier disabled the Windows Vista Distributed File System (DFS) on Windows Vista clients. DFS was disabled because Avid ISIS clients running Windows Vista were experiencing delays when opening files over the shared storage netwo...
	Avid ISIS v2.0.4 and earlier disabled the Windows Vista Distributed File System (DFS) on Windows Vista clients. DFS was disabled because Avid ISIS clients running Windows Vista were experiencing delays when opening files over the shared storage netwo...


	Spanning Tree PortFast Required with Dual Network Client Ports
	Spanning Tree PortFast Required with Dual Network Client Ports
	If Spanning Tree PortFast is disabled when your system is recovering from a link failure using a dual network client port, a “semaphore time-out” error message appears.
	If Spanning Tree PortFast is disabled when your system is recovering from a link failure using a dual network client port, a “semaphore time-out” error message appears.



	Avid ISIS 5500 | 5000 Special Notes
	Avid ISIS 5500 | 5000 Special Notes
	The following list applies to Avid ISIS 5500 infrastructures:
	The following list applies to Avid ISIS 5500 infrastructures:

	ISIS 5500 | 5000 Single Engine Configurations with Routed Clients
	ISIS 5500 | 5000 Single Engine Configurations with Routed Clients
	For single engine ISIS 5500 | 5000 configurations that include routed clients (Layer 3 to the ISIS 5500 | 5000), the Engine can be connected to the switch using either 10 Gb or 4 x 1Gb.
	For single engine ISIS 5500 | 5000 configurations that include routed clients (Layer 3 to the ISIS 5500 | 5000), the Engine can be connected to the switch using either 10 Gb or 4 x 1Gb.


	ISIS 5500 System Director
	ISIS 5500 System Director
	The Avid ISIS Engine System Director provides the following support:
	The Avid ISIS Engine System Director provides the following support:
	• System Director — 8 million files and folders (combined total)
	• System Director — 8 million files and folders (combined total)
	• System Director — 8 million files and folders (combined total)

	• 5638 users
	• 5638 users

	• 1000 groups — a user can be in 15 groups
	• 1000 groups — a user can be in 15 groups




	Up to Six Engines on ISIS 5500
	Up to Six Engines on ISIS 5500
	The initial release of Avid ISIS 5000 supported one or two Engines. Avid ISIS 5000 v3.1 included support for four Engines; starting in ISIS v3.2 six Engines are supported. New Engines can be configured as separate Storage Groups or be added to existi...
	The initial release of Avid ISIS 5000 supported one or two Engines. Avid ISIS 5000 v3.1 included support for four Engines; starting in ISIS v3.2 six Engines are supported. New Engines can be configured as separate Storage Groups or be added to existi...
	“Redistributing Data on ISIS 5500” on page 58
	Avid ISIS 5500 Setup Guide

	n You can mix both 1 TB, 2 TB and 4 TB Engines in the same Storage Group, but 2 TB drives are restricted to the same capacity as 1 TB drives.
	n You can mix both 1 TB, 2 TB and 4 TB Engines in the same Storage Group, but 2 TB drives are restricted to the same capacity as 1 TB drives.

	You can add unassigned storage Engines to a Storage Group to increase its storage capacity and bandwidth. This is typically done when adding a new Engine to your Avid ISIS system. Redistribution is an operation that ensures all files on a Workspace a...
	Avid ISIS Administration Guide

	When redistributing files in a Storage Group, the redistribution applies to all Workspaces in that Storage Group.


	ISIS 5500 Client Connections
	ISIS 5500 Client Connections
	Starting with ISIS v4.0, Avid ISIS 5000 supports up to 90 ISIS client licenses. Direct Connect configurations to support up to 9 clients. The ISIS 5500 connections are summarized in 
	Starting with ISIS v4.0, Avid ISIS 5000 supports up to 90 ISIS client licenses. Direct Connect configurations to support up to 9 clients. The ISIS 5500 connections are summarized in 
	ISIS 5500 Terminology



	10 Gb Client Support in ISIS 5500
	10 Gb Client Support in ISIS 5500
	You can have one 10 Gb client per ISIS 5500 Engine. For example, in a six Engine configuration you can have six 10 Gb clients. These 10-Gb clients connect into a 10-Gb port on a qualified switch or can connect directly into the ISIS 5500 System Direc...
	You can have one 10 Gb client per ISIS 5500 Engine. For example, in a six Engine configuration you can have six 10 Gb clients. These 10-Gb clients connect into a 10-Gb port on a qualified switch or can connect directly into the ISIS 5500 System Direc...


	Initialize RAID Set on ISIS 5000
	Initialize RAID Set on ISIS 5000
	Avid ISIS 5000 v3.1 provided an alternative method of initializing the RAID set. You can initialize the RAID set on the 16 data drives without installing the ISIS 5500 | 5000 software. This might be helpful if you want to create the RAID set before s...
	Avid ISIS 5000 v3.1 provided an alternative method of initializing the RAID set. You can initialize the RAID set on the 16 data drives without installing the ISIS 5500 | 5000 software. This might be helpful if you want to create the RAID set before s...
	Avid ISIS 5000 v3.1 provided an alternative method of initializing the RAID set. You can initialize the RAID set on the 16 data drives without installing the ISIS 5500 | 5000 software. This might be helpful if you want to create the RAID set before s...
	n If you click the Initialize Raidset link and your RAID set is already configured, a “Raidset created” message is displayed.
	n If you click the Initialize Raidset link and your RAID set is already configured, a “Raidset created” message is displayed.

	When you initially install the Avid ISIS software, the RAID set is initialized automatically. With no client traffic on the system, this will take up to approximately 54 hours. During this initialization, the system is functional and able to support ...

	To initializing the RAID set:
	To initializing the RAID set:
	1. Do one of the following:
	1. Do one of the following:
	t Double-click the Autorun.exe file in Avid ISIS 5500 | 5000 software kit.
	t Double-click the Autorun.exe file in Avid ISIS 5500 | 5000 software kit.
	t Double-click the Autorun.exe file in Avid ISIS 5500 | 5000 software kit.

	t Click the “Initialize Raidset” link on the lower right-side of the splash screen.
	t Click the “Initialize Raidset” link on the lower right-side of the splash screen.






	Redistributing Data on ISIS 5500
	Redistributing Data on ISIS 5500
	You can add unassigned Storage Elements to a Storage Group to increase its storage capacity and bandwidth. When adding a new Engine to the ISIS system, a redistribution is required if adding the new Engine to an existing Storage Group. If adding a ne...
	You can add unassigned Storage Elements to a Storage Group to increase its storage capacity and bandwidth. When adding a new Engine to the ISIS system, a redistribution is required if adding the new Engine to an existing Storage Group. If adding a ne...
	Avid ISIS Administration Guide

	ISIS 5000 v4.0 and ISIS 5500 | 5000 v4.5 and later supports removing Storage Managers from a Storage Group.
	n When redistributing files in a Storage Group, the redistribution applies to all Workspaces in that Storage Group.
	n When redistributing files in a Storage Group, the redistribution applies to all Workspaces in that Storage Group.

	c When a Workspace is deleted, a redistribution is initiated. If you start the delete during high client usage, it might cause a negative performance impact on your clients. This can include dropped frames, underruns, and failed captures. Delete Work...
	c When a Workspace is deleted, a redistribution is initiated. If you start the delete during high client usage, it might cause a negative performance impact on your clients. This can include dropped frames, underruns, and failed captures. Delete Work...



	Minimum ISIS 5500 | 5000 Storage Space Requirement
	Minimum ISIS 5500 | 5000 Storage Space Requirement
	Avid recommends that you maintain 5% of free space in each Storage Group. In other words, you should not fill Storage Group more than 95% full. Exceeding 95% used space can produce severe performance issues in some situations. 
	Avid recommends that you maintain 5% of free space in each Storage Group. In other words, you should not fill Storage Group more than 95% full. Exceeding 95% used space can produce severe performance issues in some situations. 
	To calculate the right amount of free space, log into the ISIS management Console and navigate to the Storage Group page. For each Storage Group, multiply the Effective number by 0.05. This is your recommended free space in GBs. To make sure that you...



	Avid ISIS 2000 Special Notes
	Avid ISIS 2000 Special Notes
	The following list applies to Avid ISIS 2000 infrastructures:
	The following list applies to Avid ISIS 2000 infrastructures:

	ISIS 2000 System Director
	ISIS 2000 System Director
	The Avid ISIS 2000 System Director uses an AS3000 server with 24 GB of memory and a 64-bit Window Storage Server 2008 R2 operating system. The ISIS 2000 System Director provides the following support:
	The Avid ISIS 2000 System Director uses an AS3000 server with 24 GB of memory and a 64-bit Window Storage Server 2008 R2 operating system. The ISIS 2000 System Director provides the following support:
	• 64-bit System Director — 10 million files
	• 64-bit System Director — 10 million files
	• 64-bit System Director — 10 million files

	• 64-bit System Director — 500,000 folders (25,000 files per folder)
	• 64-bit System Director — 500,000 folders (25,000 files per folder)

	• 5638 users
	• 5638 users

	• 1000 groups — a user can be in 15 groups
	• 1000 groups — a user can be in 15 groups




	Up to Five ISIS 2000 Engines
	Up to Five ISIS 2000 Engines
	The initial release of Avid ISIS 2000 supported one Engine; ISIS v4.5 added support for up to five ISIS 2000 Engines. New Engines can be configured as separate Storage Groups or be added to existing Storage Groups. For instructions on adding new Engi...
	The initial release of Avid ISIS 2000 supported one Engine; ISIS v4.5 added support for up to five ISIS 2000 Engines. New Engines can be configured as separate Storage Groups or be added to existing Storage Groups. For instructions on adding new Engi...
	Avid ISIS 2000 Setup Guide

	You can add unassigned storage Engines to a Storage Group to increase its storage capacity and bandwidth. This is typically done when adding a new Engine to your Avid ISIS system. 
	Redistribution is an operation that ensures all files on a Workspace are balanced evenly across the Storage Elements in the Storage Group to provide optimal file system performance. For more information, see “Redistributing Data” in the 
	Avid ISIS Administration Guide



	Initialize RAID Set
	Initialize RAID Set
	When you initially install the Avid ISIS 2000 system and initialize the RAID set, it takes approximately 72 hours regardless of the Engine configuration. During this initialization, the system is functional and able to support a limited amount of cli...
	When you initially install the Avid ISIS 2000 system and initialize the RAID set, it takes approximately 72 hours regardless of the Engine configuration. During this initialization, the system is functional and able to support a limited amount of cli...
	When you initially install the Avid ISIS 2000 system and initialize the RAID set, it takes approximately 72 hours regardless of the Engine configuration. During this initialization, the system is functional and able to support a limited amount of cli...
	Avid ISIS Performance Guides




	Minimum ISIS 2000 Storage Space Requirement
	Minimum ISIS 2000 Storage Space Requirement
	Avid recommends that you maintain 5% of free space in each Storage Group. In other words, you should not fill Storage Group more than 95% full. Exceeding 95% used space can produce severe performance issues in some situations. 
	Avid recommends that you maintain 5% of free space in each Storage Group. In other words, you should not fill Storage Group more than 95% full. Exceeding 95% used space can produce severe performance issues in some situations. 
	To calculate the right amount of free space, log into the ISIS management Console and navigate to the Storage Group page. For each Storage Group, multiply the Effective number by 0.05. This is your recommended free space in GBs. To make sure that you...


	ISIS 2000 Client Connections
	ISIS 2000 Client Connections
	Avid ISIS 2000 systems support 200 ISIS clients using either 1 Gb, dual 1 Gb, and 10 Gb connections at any client Type setting. ISIS 2000 clients must connect through a Zone 2 or Zone 3 switch network segment port. 
	Avid ISIS 2000 systems support 200 ISIS clients using either 1 Gb, dual 1 Gb, and 10 Gb connections at any client Type setting. ISIS 2000 clients must connect through a Zone 2 or Zone 3 switch network segment port. 
	The ISIS 2000 includes a File Gateway function that allows an unlimited number of clients to push and pull data to and from the ISIS 2000 through a Common Internet File System (CIFS) or FTP connection without the ISIS Client Manager software. 
	n When the File Gateway is configured as a CIFS server, workspaces are mapped to drive letters on the File Gateway. Depending on the number of drives in the File Gateway, the maximum number of workspaces that can be shared out as a CIFS share is 22 w...
	n When the File Gateway is configured as a CIFS server, workspaces are mapped to drive letters on the File Gateway. Depending on the number of drives in the File Gateway, the maximum number of workspaces that can be shared out as a CIFS share is 22 w...



	ISIS 2000 Switches 
	ISIS 2000 Switches 
	Avid has qualified the Force10 S4810 and Cisco 4900M switches. The ISIS 2000 nearline storage is designed for workflows with your ISIS 7000 and ISIS 5500 online environments. Sample ISIS 7000 and ISIS 5500 configurations files are included in the sof...
	Avid has qualified the Force10 S4810 and Cisco 4900M switches. The ISIS 2000 nearline storage is designed for workflows with your ISIS 7000 and ISIS 5500 online environments. Sample ISIS 7000 and ISIS 5500 configurations files are included in the sof...
	Qualified and Approved ISIS Switches
	Qualified and Approved ISIS Switches




	ISIS 2000 Engine
	ISIS 2000 Engine
	Starting in ISIS v4.5, five Engines are supported in an ISIS 2000 configuration. New Engines can be configured as separate Storage Groups or be added to existing Storage Groups. If you add the new Engines to an existing Storage Group, a redistributio...
	Starting in ISIS v4.5, five Engines are supported in an ISIS 2000 configuration. New Engines can be configured as separate Storage Groups or be added to existing Storage Groups. If you add the new Engines to an existing Storage Group, a redistributio...
	Avid ISIS 2000 Setup Guide

	n You can mix both ISIS 2000-120 TB and ISIS 2000-240 TB Engines in the same Storage Group.
	n You can mix both ISIS 2000-120 TB and ISIS 2000-240 TB Engines in the same Storage Group.

	The ISIS 2000 is not intended to be used for real time editing of high resolution material, although real time playback of resolutions of up to 3 Mb/s or less is supported. 


	Moving ISIS 2000 Workspaces
	Moving ISIS 2000 Workspaces
	The following sections list the supported methods for moving data between online (ISIS 7000 and ISIS 5500 | 5000) and nearline (ISIS 2000) Workspaces.
	The following sections list the supported methods for moving data between online (ISIS 7000 and ISIS 5500 | 5000) and nearline (ISIS 2000) Workspaces.

	Interplay Workflows
	Interplay Workflows
	Avid Interplay v2.6 and v2.7 have been qualified in the Avid ISIS v4.5 ISIS environments. You can move assets from one ISIS system to another using Interplay workflows. The Interplay Media Services is required. Interplay workgroups with a single IP D...
	Avid Interplay v2.6 and v2.7 have been qualified in the Avid ISIS v4.5 ISIS environments. You can move assets from one ISIS system to another using Interplay workflows. The Interplay Media Services is required. Interplay workgroups with a single IP D...


	AirSpeed Workflows
	AirSpeed Workflows
	Avid AirSpeed 5000 v2.1, AirSpeed Multi Stream v1.8.6 and AirSpeed v2.7.12 have been qualified in the Avid ISIS v4.5 ISIS environments. The AirSpeed 5000 can capture high resolution to online environments, and proxy to nearline environments (or proxy...
	Avid AirSpeed 5000 v2.1, AirSpeed Multi Stream v1.8.6 and AirSpeed v2.7.12 have been qualified in the Avid ISIS v4.5 ISIS environments. The AirSpeed 5000 can capture high resolution to online environments, and proxy to nearline environments (or proxy...


	Editor Workflows
	Editor Workflows
	Editors can move clips and sequences between ISIS workspaces using the Consolidate/Transcode feature. In addition, with online and nearline workspaces mounted on a single client, you can drag files from one workspace to another.
	Editors can move clips and sequences between ISIS workspaces using the Consolidate/Transcode feature. In addition, with online and nearline workspaces mounted on a single client, you can drag files from one workspace to another.
	c Moving files in an Interplay shared storage environment from a client at the file system level could be detrimental to system operations. Use Interplay Media Services applications when moving files in an Interplay shared storage environment.
	c Moving files in an Interplay shared storage environment from a client at the file system level could be detrimental to system operations. Use Interplay Media Services applications when moving files in an Interplay shared storage environment.



	Data Migration Utility Workflows
	Data Migration Utility Workflows
	The Data Migration Utility can be used to move complete Workspaces between ISIS infrastructures. You can use the Data Migration utility to move Workspaces between any combination of ISIS 7500 | 7000, ISIS 5500 | 5000, and ISIS 2000 systems; this incl...
	The Data Migration Utility can be used to move complete Workspaces between ISIS infrastructures. You can use the Data Migration utility to move Workspaces between any combination of ISIS 7500 | 7000, ISIS 5500 | 5000, and ISIS 2000 systems; this incl...
	Avid ISIS Client Guide

	When Workspaces are migrated, the protection type is inherited from the ISIS system. For example, Workspaces migrated to ISIS 5500 inherits RAID 5 protection. Workspaces migrated to ISIS 2000 inherits RAID 6 protection. Workspaces migrated to ISIS 75...


	RichCopy Workflows
	RichCopy Workflows
	RichCopy is a free computer utility program developed by Microsoft to copy file directories. It performs faster than conventional copy and paste commands in the Windows operating system. 
	RichCopy is a free computer utility program developed by Microsoft to copy file directories. It performs faster than conventional copy and paste commands in the Windows operating system. 




	Known Issues
	Known Issues
	The following are known issues with the Avid ISIS software. 
	The following are known issues with the Avid ISIS software. 

	Client Issues
	Client Issues
	The following are known issues with the Avid ISIS v4.
	The following are known issues with the Avid ISIS v4.
	x

	On a Linux OS, right-clicking to access a context menu in the Management Console window does not work properly. The context menu does not stay open when you right-click and release the mouse button.
	On a Linux OS, right-clicking to access a context menu in the Management Console window does not work properly. The context menu does not stay open when you right-click and release the mouse button.
	On a Linux OS, right-clicking to access a context menu in the Management Console window does not work properly. The context menu does not stay open when you right-click and release the mouse button.

	Workaround: 
	Workaround: 
	Keep the right-click button applied while scrolling through the menu options.


	When installing the Client Manager on an Mac OS X v10.9 you might receive the following message: “Kernel Extension is not from an identified developer.” The Client Manager will install successfully if you continue through the install process.
	When installing the Client Manager on an Mac OS X v10.9 you might receive the following message: “Kernel Extension is not from an identified developer.” The Client Manager will install successfully if you continue through the install process.
	When installing the Client Manager on an Mac OS X v10.9 you might receive the following message: “Kernel Extension is not from an identified developer.” The Client Manager will install successfully if you continue through the install process.


	There is currently an issue with handling Final Cut Pro rendered media files. Until this issue is resolved, Avid recommends that you render to a local volume.
	There is currently an issue with handling Final Cut Pro rendered media files. Until this issue is resolved, Avid recommends that you render to a local volume.
	There is currently an issue with handling Final Cut Pro rendered media files. Until this issue is resolved, Avid recommends that you render to a local volume.


	After updating your Windows ISIS client software, your client might not find your ISIS infrastructure and display “Failed to open key SYSTEM\CurrentControlSet\Services\AvidFosFS\Parameters\FwProfiles” in the Logs portion of the Client Manager win...
	After updating your Windows ISIS client software, your client might not find your ISIS infrastructure and display “Failed to open key SYSTEM\CurrentControlSet\Services\AvidFosFS\Parameters\FwProfiles” in the Logs portion of the Client Manager win...
	After updating your Windows ISIS client software, your client might not find your ISIS infrastructure and display “Failed to open key SYSTEM\CurrentControlSet\Services\AvidFosFS\Parameters\FwProfiles” in the Logs portion of the Client Manager win...

	Workaround: 
	Workaround: 
	Uninstall your ISIS Client software (either thought the Windows Control Panel > Programs > Programs and Features or Autorun.exe “Remove ISIS Software” selection in the menu) and reinstall the ISIS Client software again.


	The Client Manager application only supports ASCII characters in user passwords. 
	The Client Manager application only supports ASCII characters in user passwords. 
	The Client Manager application only supports ASCII characters in user passwords. 


	If using Client Manager with a Macintosh Client on any language setting other than English, you must use the Cancel button to cancel an uninstall. Do not click the red “x” to close the client software uninstaller window. (The client software unin...
	If using Client Manager with a Macintosh Client on any language setting other than English, you must use the Cancel button to cancel an uninstall. Do not click the red “x” to close the client software uninstaller window. (The client software unin...
	If using Client Manager with a Macintosh Client on any language setting other than English, you must use the Cancel button to cancel an uninstall. Do not click the red “x” to close the client software uninstaller window. (The client software unin...


	If you select the ISIS System Director or Engine software option from the ISIS software installer splash screen, on a Windows Vista 64 client workstation, an error indicating an application has failed might appear. This error can be safely ignored.
	If you select the ISIS System Director or Engine software option from the ISIS software installer splash screen, on a Windows Vista 64 client workstation, an error indicating an application has failed might appear. This error can be safely ignored.
	If you select the ISIS System Director or Engine software option from the ISIS software installer splash screen, on a Windows Vista 64 client workstation, an error indicating an application has failed might appear. This error can be safely ignored.

	Workaround: 
	Workaround: 
	Avoid selecting these install options on client workstations.


	When you Enable or Disable the Network Interface (the check box in the first column), and then click Apply, it forces a refresh. If you change the setting and click Apply several times in a minute, it might introduce a client system error.
	When you Enable or Disable the Network Interface (the check box in the first column), and then click Apply, it forces a refresh. If you change the setting and click Apply several times in a minute, it might introduce a client system error.
	When you Enable or Disable the Network Interface (the check box in the first column), and then click Apply, it forces a refresh. If you change the setting and click Apply several times in a minute, it might introduce a client system error.

	Workaround: 
	Workaround: 
	Restart the client by powering off the system to clear the condition. 


	When using Nautilus (the default browser included with Red Hat Enterprise Linux v6.2), clients might experience long wait times browsing folders containing files that do not have a file extension. 
	When using Nautilus (the default browser included with Red Hat Enterprise Linux v6.2), clients might experience long wait times browsing folders containing files that do not have a file extension. 
	When using Nautilus (the default browser included with Red Hat Enterprise Linux v6.2), clients might experience long wait times browsing folders containing files that do not have a file extension. 

	Workaround: 
	Workaround: 
	If using files without extensions, limit the number of files per folder. 


	If Avid ISIS Windows clients assign a drive letter to a workspace in the Client Manager, an Avid Interplay client or virus protection software (programs running in the background) could obscure the displayed drive letter in the Client Manager window....
	If Avid ISIS Windows clients assign a drive letter to a workspace in the Client Manager, an Avid Interplay client or virus protection software (programs running in the background) could obscure the displayed drive letter in the Client Manager window....
	If Avid ISIS Windows clients assign a drive letter to a workspace in the Client Manager, an Avid Interplay client or virus protection software (programs running in the background) could obscure the displayed drive letter in the Client Manager window....
	If the UNC path is removed by the program running in background, your assigned drive letter re-appears.

	Workaround: 
	Workaround: 
	You can verify the workspace is mounted to a drive letter by confirming its presence in the My Computer window. You can also unmount the drive through the My Computer window by right clicking it and selecting Disconnect.


	If you attempt to initiate several file copies from workspace to workspace in parallel on a single client, you might experience “can not read and write” or “delayed write failure” error messages.
	If you attempt to initiate several file copies from workspace to workspace in parallel on a single client, you might experience “can not read and write” or “delayed write failure” error messages.
	If you attempt to initiate several file copies from workspace to workspace in parallel on a single client, you might experience “can not read and write” or “delayed write failure” error messages.

	Workaround: 
	Workaround: 
	A maximum of two parallel file copies from workspace to workspace per client is supported. Any number of files can be in a single copy.


	Windows Vista 64-bit clients with SP2 might experience a 10 to 20 second delay when accessing workspaces from Windows Explorer.
	Windows Vista 64-bit clients with SP2 might experience a 10 to 20 second delay when accessing workspaces from Windows Explorer.
	Windows Vista 64-bit clients with SP2 might experience a 10 to 20 second delay when accessing workspaces from Windows Explorer.

	Workaround: 
	Workaround: 
	Disabling the WebClient service removes the delay.
	To change the WebClient service setting:
	To change the WebClient service setting:
	1. Right click My Computer and select Manage.
	1. Right click My Computer and select Manage.

	2. Expand Services and Applications in the left pane and click Services.
	2. Expand Services and Applications in the left pane and click Services.

	3. Right-click WebClient in the right pane and select Properties.
	3. Right-click WebClient in the right pane and select Properties.

	4. In the General tab of the WebClient window, click Stop. 
	4. In the General tab of the WebClient window, click Stop. 

	5. Select Disabled in the Start-up type menu.
	5. Select Disabled in the Start-up type menu.

	6. Click Apply.
	6. Click Apply.

	7. Click OK.
	7. Click OK.


	n You do not need to restart the client after this change.
	n You do not need to restart the client after this change.



	If one workspace in Client Manager is mounted by Mapping a Network drive in Windows, when you unmount the workspace and then mount a different workspace in Client Manager manually using the same drive letter, Windows Explorer displays the previous wo...
	If one workspace in Client Manager is mounted by Mapping a Network drive in Windows, when you unmount the workspace and then mount a different workspace in Client Manager manually using the same drive letter, Windows Explorer displays the previous wo...
	If one workspace in Client Manager is mounted by Mapping a Network drive in Windows, when you unmount the workspace and then mount a different workspace in Client Manager manually using the same drive letter, Windows Explorer displays the previous wo...


	The estimated amount of space available (usually measured in an amount of time at a particular resolution) might differ between what Avid ISIS calculates and what the Avid editing system calculates.
	The estimated amount of space available (usually measured in an amount of time at a particular resolution) might differ between what Avid ISIS calculates and what the Avid editing system calculates.
	The estimated amount of space available (usually measured in an amount of time at a particular resolution) might differ between what Avid ISIS calculates and what the Avid editing system calculates.
	Avid ISIS accurately reports the amount of space available for file storage.
	The Avid editing application accounts for overhead in formatting of the media and is more conservative in reporting how much space is available.


	When the Final Cut Pro Scratch Disk is saved to an ISIS workspace using the Autosave Vault feature, the copies of the project in Autosave Vault folder cannot be opened with Final Cut Pro. An error message is displayed stating “File error: Wrong typ...
	When the Final Cut Pro Scratch Disk is saved to an ISIS workspace using the Autosave Vault feature, the copies of the project in Autosave Vault folder cannot be opened with Final Cut Pro. An error message is displayed stating “File error: Wrong typ...
	When the Final Cut Pro Scratch Disk is saved to an ISIS workspace using the Autosave Vault feature, the copies of the project in Autosave Vault folder cannot be opened with Final Cut Pro. An error message is displayed stating “File error: Wrong typ...


	When the Final Cut Pro Scratch Disk is saved to an ISIS workspace using the Autosave Vault feature, more copies are automatically saved than is set in the Autosave Vault setting.
	When the Final Cut Pro Scratch Disk is saved to an ISIS workspace using the Autosave Vault feature, more copies are automatically saved than is set in the Autosave Vault setting.
	When the Final Cut Pro Scratch Disk is saved to an ISIS workspace using the Autosave Vault feature, more copies are automatically saved than is set in the Autosave Vault setting.


	The Final Cut Pro “Modify > Make Offline > Move them to the Trash” option is not supported with Avid ISIS workspaces. 
	The Final Cut Pro “Modify > Make Offline > Move them to the Trash” option is not supported with Avid ISIS workspaces. 
	The Final Cut Pro “Modify > Make Offline > Move them to the Trash” option is not supported with Avid ISIS workspaces. 


	Final Cut Pro v6.0.5 sometimes stops functioning if you Eject the ISIS workspace using the Final Cut Pro Open menu. When you are done using the ISIS workspace unmount the workspace using the Client Manager window. 
	Final Cut Pro v6.0.5 sometimes stops functioning if you Eject the ISIS workspace using the Final Cut Pro Open menu. When you are done using the ISIS workspace unmount the workspace using the Client Manager window. 
	Final Cut Pro v6.0.5 sometimes stops functioning if you Eject the ISIS workspace using the Final Cut Pro Open menu. When you are done using the ISIS workspace unmount the workspace using the Client Manager window. 


	The Avid ISIS client bandwidth allocation feature is not supported with Final Cut Pro.
	The Avid ISIS client bandwidth allocation feature is not supported with Final Cut Pro.
	The Avid ISIS client bandwidth allocation feature is not supported with Final Cut Pro.


	The Macintosh Finder might display the Avid ISIS folder contents incorrectly, such as the contents of folders containing items whose name includes a pound sign (#) followed by numeric characters. For example, “project # 12” might be erroneously d...
	The Macintosh Finder might display the Avid ISIS folder contents incorrectly, such as the contents of folders containing items whose name includes a pound sign (#) followed by numeric characters. For example, “project # 12” might be erroneously d...
	The Macintosh Finder might display the Avid ISIS folder contents incorrectly, such as the contents of folders containing items whose name includes a pound sign (#) followed by numeric characters. For example, “project # 12” might be erroneously d...

	Workaround: 
	Workaround: 
	Avid recommends avoiding the use of names that include a pound sign (#) followed by numeric characters.


	Your Avid ISIS Macintosh Lion (v10.7.x) client might experience a kernel panic while attempting to uninstall the ISIS client software. 
	Your Avid ISIS Macintosh Lion (v10.7.x) client might experience a kernel panic while attempting to uninstall the ISIS client software. 
	Your Avid ISIS Macintosh Lion (v10.7.x) client might experience a kernel panic while attempting to uninstall the ISIS client software. 

	Workaround: 
	Workaround: 
	Force the Macintosh client to restart by pressing and holding the power button until the Macintosh client powers down. Restart the Macintosh client and attempt to uninstall the client software again. 


	If your Avid ISIS 10 Gb Macintosh Lion (v10.7.x) clients suddenly starts to experience delayed write failures, the Myricom driver might have switched the MTU size to 9000 or to Jumbo Frames. 
	If your Avid ISIS 10 Gb Macintosh Lion (v10.7.x) clients suddenly starts to experience delayed write failures, the Myricom driver might have switched the MTU size to 9000 or to Jumbo Frames. 
	If your Avid ISIS 10 Gb Macintosh Lion (v10.7.x) clients suddenly starts to experience delayed write failures, the Myricom driver might have switched the MTU size to 9000 or to Jumbo Frames. 

	Workaround: Verify the Myricom driver MTU setting is configured as “Standard 1500,” check the setting on the Macintosh client as follows:
	Workaround: Verify the Myricom driver MTU setting is configured as “Standard 1500,” check the setting on the Macintosh client as follows:
	1. On your Macintosh 10-Gb client, click Apple > System Preferences.
	1. On your Macintosh 10-Gb client, click Apple > System Preferences.

	2. In the Internet & Wireless section, click Network.
	2. In the Internet & Wireless section, click Network.

	3. In the left pane, select the Myricom entry and click Advanced.
	3. In the left pane, select the Myricom entry and click Advanced.

	4. Click the Hardware tab.
	4. Click the Hardware tab.

	5. Select “Manually” from the Configure drop-down box to enable the MTU drop-down box.
	5. Select “Manually” from the Configure drop-down box to enable the MTU drop-down box.

	6. Select “Standard 1500” in the MTU setting.
	6. Select “Standard 1500” in the MTU setting.




	If your Avid ISIS Macintosh Lion (v10.7.x) client has a Workspace mounted, the client Disk Log open, and the ISIS 5500 is restarted, you could experience a kernel panic once the ISIS 5500 is back running and you attempt to access the Disk Log. 
	If your Avid ISIS Macintosh Lion (v10.7.x) client has a Workspace mounted, the client Disk Log open, and the ISIS 5500 is restarted, you could experience a kernel panic once the ISIS 5500 is back running and you attempt to access the Disk Log. 
	If your Avid ISIS Macintosh Lion (v10.7.x) client has a Workspace mounted, the client Disk Log open, and the ISIS 5500 is restarted, you could experience a kernel panic once the ISIS 5500 is back running and you attempt to access the Disk Log. 

	Workaround: 
	Workaround: 
	Force the Macintosh client to restart by pressing and holding the power button until the Macintosh client powers down. Restart the Macintosh client and you can continue to working where you left off. 


	Do not disconnect the PCI interface cable from either a Nitris DX or Mojo DX while it is powered up on the Macintosh editing system. If Avid ISIS is running on this system and the cable is removed, the Macintosh produces a kernel panic and reports IS...
	Do not disconnect the PCI interface cable from either a Nitris DX or Mojo DX while it is powered up on the Macintosh editing system. If Avid ISIS is running on this system and the cable is removed, the Macintosh produces a kernel panic and reports IS...
	Do not disconnect the PCI interface cable from either a Nitris DX or Mojo DX while it is powered up on the Macintosh editing system. If Avid ISIS is running on this system and the cable is removed, the Macintosh produces a kernel panic and reports IS...


	If playing two streams of media during a non-symmetrical full redistribution on an Avid editor with a Nitris DX or Mojo DX attached, you will drop frames.
	If playing two streams of media during a non-symmetrical full redistribution on an Avid editor with a Nitris DX or Mojo DX attached, you will drop frames.
	If playing two streams of media during a non-symmetrical full redistribution on an Avid editor with a Nitris DX or Mojo DX attached, you will drop frames.

	Workaround: 
	Workaround: 
	You have the following options.
	• Work with your media after the redistribution is finished.
	• Work with your media after the redistribution is finished.
	• Work with your media after the redistribution is finished.

	• Start the Management Console Tool and suspend the redistribution. Finish working with your media and then resume the redistribution.
	• Start the Management Console Tool and suspend the redistribution. Finish working with your media and then resume the redistribution.


	n Do not leave the redistribution in a suspended state for an extended period of time.
	n Do not leave the redistribution in a suspended state for an extended period of time.



	The Path Diagnostics customized setting for Posix tests does not work correctly on the Macintosh clients. 
	The Path Diagnostics customized setting for Posix tests does not work correctly on the Macintosh clients. 
	The Path Diagnostics customized setting for Posix tests does not work correctly on the Macintosh clients. 

	Workaround: 
	Workaround: 
	Use the default option to automatically select the File Access Method instead.




	Common ISIS Infrastructure Issues
	Common ISIS Infrastructure Issues
	The following are known issues that could be experienced in Avid ISIS 7000, ISIS 5500, and ISIS 2000 infrastructures. When a workaround exists, it appears in the paragraph directly following the issue description.
	The following are known issues that could be experienced in Avid ISIS 7000, ISIS 5500, and ISIS 2000 infrastructures. When a workaround exists, it appears in the paragraph directly following the issue description.
	When accessing the Storage Manager agent using a Chrome browser, you might receive a “This web page is not available” message.
	When accessing the Storage Manager agent using a Chrome browser, you might receive a “This web page is not available” message.
	When accessing the Storage Manager agent using a Chrome browser, you might receive a “This web page is not available” message.

	Workaround: 
	Workaround: 
	Press the F5 key. The page will reload. At the “Site’s Security certificate is not trusted” window click Proceed anyway. 


	When attempting to view system log files (/var/log/messages.*.gz) from the Storage Manager > Agent page > Logging tab, the Agent page stops functioning if you click View on a *.gz file. Do not view any *.gz logs through the Agent pages. 
	When attempting to view system log files (/var/log/messages.*.gz) from the Storage Manager > Agent page > Logging tab, the Agent page stops functioning if you click View on a *.gz file. Do not view any *.gz logs through the Agent pages. 
	When attempting to view system log files (/var/log/messages.*.gz) from the Storage Manager > Agent page > Logging tab, the Agent page stops functioning if you click View on a *.gz file. Do not view any *.gz logs through the Agent pages. 
	n To view *.gz files use the Management Console > ISIS Toolbox > Log Aggregator and save the logs to your local computer.
	n To view *.gz files use the Management Console > ISIS Toolbox > Log Aggregator and save the logs to your local computer.


	Workaround: 
	Workaround: 
	Restart the Engine Agent if you have attempted to view *.gz logs through the Agent page.
	To restart the agent without disrupting clients:
	To restart the agent without disrupting clients:
	1. Install PUTTY or similar SSH Client on the System Director, any client on the network, or on a system connected to the management port.
	1. Install PUTTY or similar SSH Client on the System Director, any client on the network, or on a system connected to the management port.
	http://www.chiark.greenend.org.uk/~sgtatham/putty/


	2. Run SSH Client connecting to Storage Manager using an IP address listed in Management Console.
	2. Run SSH Client connecting to Storage Manager using an IP address listed in Management Console.

	3. Login.
	3. Login.
	Username: 
	Username: 
	root

	Password: <
	local admin password
	se-admin



	4. Stop the Storage Manager web agent using the following command: 
	4. Stop the Storage Manager web agent using the following command: 
	/etc/init.d/userveragent stop


	5. Wait approximately 30 seconds.
	5. Wait approximately 30 seconds.

	6. Restart the Storage Manager web agent using the following command: 
	6. Restart the Storage Manager web agent using the following command: 
	/etc/init.d/userveragent start


	7. Wait approximately 30 seconds.
	7. Wait approximately 30 seconds.

	8. Verify the agent is running again by accessing the Management Console > Storage Manager > Agent page.
	8. Verify the agent is running again by accessing the Management Console > Storage Manager > Agent page.

	9. Close the SSH Client.
	9. Close the SSH Client.




	Chinese and Korean characters are not supported in LDAP Sync Tool.
	Chinese and Korean characters are not supported in LDAP Sync Tool.
	Chinese and Korean characters are not supported in LDAP Sync Tool.




	ISIS 7000 Infrastructure Issues
	ISIS 7000 Infrastructure Issues
	The following are known issues with the Avid ISIS 7000 infrastructure. When a workaround exists, it appears in the paragraph directly following the issue description.
	The following are known issues with the Avid ISIS 7000 infrastructure. When a workaround exists, it appears in the paragraph directly following the issue description.
	Consistency check errors have found when playing back media that has been transcoded while on RAID 6 Workspaces. The transcoded media appears to be fine until you attempt to play it back. 
	Consistency check errors have found when playing back media that has been transcoded while on RAID 6 Workspaces. The transcoded media appears to be fine until you attempt to play it back. 
	Consistency check errors have found when playing back media that has been transcoded while on RAID 6 Workspaces. The transcoded media appears to be fine until you attempt to play it back. 
	Projects and bins should not be shared on a RAID 6 Workspace. To share projects and bins, store them on a mirrored Workspace.

	Workaround: 
	Workaround: 
	To transcode media on a RAID 6 Workspace, close the project, move the project and bin files to a local drive, perform the transcode, then move them back to the RAID 6 Workspace. 
	n You cannot share bins and projects when they are saved on a local drive.
	n You cannot share bins and projects when they are saved on a local drive.



	When reading media to do a mixdown on a “Westmere” Macintosh client with the Client Type set to Low Resolution in the Client Manager > Preferences > General settings, the Macintosh client might become unresponsive. 
	When reading media to do a mixdown on a “Westmere” Macintosh client with the Client Type set to Low Resolution in the Client Manager > Preferences > General settings, the Macintosh client might become unresponsive. 
	When reading media to do a mixdown on a “Westmere” Macintosh client with the Client Type set to Low Resolution in the Client Manager > Preferences > General settings, the Macintosh client might become unresponsive. 

	Workaround: 
	Workaround: 
	Switch Client Type setting to Medium Resolution or High Resolution. 


	If the ISIS Management Console is opened from the Client Manager, and an Avid ISIS System Director failover occurs while the ISIS Management Console is open, the ISIS Management Console does not automatically reconnect to the new Active System Director.
	If the ISIS Management Console is opened from the Client Manager, and an Avid ISIS System Director failover occurs while the ISIS Management Console is open, the ISIS Management Console does not automatically reconnect to the new Active System Director.
	If the ISIS Management Console is opened from the Client Manager, and an Avid ISIS System Director failover occurs while the ISIS Management Console is open, the ISIS Management Console does not automatically reconnect to the new Active System Director.

	Workaround: 
	Workaround: 
	Once the Client Manager reconnects to the new Active System Director, restart the ISIS Management Console within the Client Manager to connect to the new Active System Director.


	ISIS v2.x has a install status of “Downloading” when updating the ISB and switch firmware. While in the downloading state, the blade is downloading the firmware package from the FTP Publishing service on the System Director. 
	ISIS v2.x has a install status of “Downloading” when updating the ISB and switch firmware. While in the downloading state, the blade is downloading the firmware package from the FTP Publishing service on the System Director. 
	ISIS v2.x has a install status of “Downloading” when updating the ISB and switch firmware. While in the downloading state, the blade is downloading the firmware package from the FTP Publishing service on the System Director. 
	If a blade is in the downloading state for more than 15 minutes, it indicates a problem retrieving the package or connecting to the FTP service. 

	Workaround: 
	Workaround: 
	Open the Agent page for the blade and click the Statistics tab and click Network. Look for errors on either 
	eth0
	eth1

	• Select “offline ISB”
	• Select “offline ISB”
	• Select “offline ISB”

	• If possible move the ISB to a new engine. If the problem persists, replace the ISB.
	• If possible move the ISB to a new engine. If the problem persists, replace the ISB.

	• If the ISB cannot be moved to a new engine, move it to a different slot. If the problem persists, reseat the switch associated with the network errors (eth0 is associated with the right switch, eth1 is associated with the left switch). If the pro...
	• If the ISB cannot be moved to a new engine, move it to a different slot. If the problem persists, reseat the switch associated with the network errors (eth0 is associated with the right switch, eth1 is associated with the left switch). If the pro...


	If no errors are displayed in the Network view of the Agent page, check cabling between the System Director and engine. Verify the FTP Publishing service is running on the System Director (right-click My Computer > Manage > Services). 


	If a client has a workspace mounted and that workspace is deleted within the Management Console and then recreated using the same name, the mounted workspace becomes inaccessible to the client, although it displays a green icon within Client Manager ...
	If a client has a workspace mounted and that workspace is deleted within the Management Console and then recreated using the same name, the mounted workspace becomes inaccessible to the client, although it displays a green icon within Client Manager ...
	If a client has a workspace mounted and that workspace is deleted within the Management Console and then recreated using the same name, the mounted workspace becomes inaccessible to the client, although it displays a green icon within Client Manager ...

	Workaround: 
	Workaround: 
	To access that workspace again, unmount the workspace using the client manager and then mount it again.


	When attempting to consolidate media from an Avid editing client on a RAID workspace that has a failed ISB, the consolidate function in the editing application might fail with an Exception error.
	When attempting to consolidate media from an Avid editing client on a RAID workspace that has a failed ISB, the consolidate function in the editing application might fail with an Exception error.
	When attempting to consolidate media from an Avid editing client on a RAID workspace that has a failed ISB, the consolidate function in the editing application might fail with an Exception error.

	Workaround: 
	Workaround: 
	If the ISB failure cannot be repaired within your time frame, retry the consolidation again. The failure is intermittent.


	When the maximum number of licensed users are logged in to the Avid ISIS environment and another client attempts to log in, a “User authentication failed” error is displayed.
	When the maximum number of licensed users are logged in to the Avid ISIS environment and another client attempts to log in, a “User authentication failed” error is displayed.
	When the maximum number of licensed users are logged in to the Avid ISIS environment and another client attempts to log in, a “User authentication failed” error is displayed.
	The message should state that the maximum number of licenses has been reached.


	Deleting an ISS from a stack does not clear the engine configuration.
	Deleting an ISS from a stack does not clear the engine configuration.
	Deleting an ISS from a stack does not clear the engine configuration.
	Use the Reset Factory defaults button to clear stack configuration information.


	When in the Advanced tab of the Switch Agent page, if you select Switch Blade > “Reset to factory defaults” and enter the password to confirm the reset, one of the two switches in the engine becomes the master and the other switch keeps restarting. 
	When in the Advanced tab of the Switch Agent page, if you select Switch Blade > “Reset to factory defaults” and enter the password to confirm the reset, one of the two switches in the engine becomes the master and the other switch keeps restarting. 
	When in the Advanced tab of the Switch Agent page, if you select Switch Blade > “Reset to factory defaults” and enter the password to confirm the reset, one of the two switches in the engine becomes the master and the other switch keeps restarting. 

	Workaround: Log into the ISS Agent on the new master, click the System tab and select Basic, then click Submit in the Chassis Configuration window.
	Workaround: Log into the ISS Agent on the new master, click the System tab and select Basic, then click Submit in the Chassis Configuration window.


	If a redistribution stops after a Storage Element has failed, it can indicate that the system is trying to fix parity blocks that no longer exist. 
	If a redistribution stops after a Storage Element has failed, it can indicate that the system is trying to fix parity blocks that no longer exist. 
	If a redistribution stops after a Storage Element has failed, it can indicate that the system is trying to fix parity blocks that no longer exist. 

	Workaround: Suspend and resume an in-progress redistribution to do a Block Rectify, using the Advanced Commands options available on the Workspaces page. The following steps are summarized. For detailed instructions, see the 
	Workaround: Suspend and resume an in-progress redistribution to do a Block Rectify, using the Advanced Commands options available on the Workspaces page. The following steps are summarized. For detailed instructions, see the 
	Avid ISIS Administration Guide

	c Do not allow the RAID 6 redistribution to stay suspended for indefinite periods of time. Once the rectify completes, immediately resume the redistributions across all Workspaces.
	c Do not allow the RAID 6 redistribution to stay suspended for indefinite periods of time. Once the rectify completes, immediately resume the redistributions across all Workspaces.

	To suspend a redistribution and rectify blocks:
	To suspend a redistribution and rectify blocks:
	1. Suspend a redistribution: Management Console > Workspaces > Advanced Commands and select Suspend Redistribution.
	1. Suspend a redistribution: Management Console > Workspaces > Advanced Commands and select Suspend Redistribution.

	2. Rectify files: Management Console > Storage Elements > Command and select Initiate Block Rectify.
	2. Rectify files: Management Console > Storage Elements > Command and select Initiate Block Rectify.

	3. Resume the redistribution: Management Console > Workspaces > Advanced Commands and select Resume Redistribution.
	3. Resume the redistribution: Management Console > Workspaces > Advanced Commands and select Resume Redistribution.






	ISIS 5500 | 5000 Infrastructure Issues
	ISIS 5500 | 5000 Infrastructure Issues
	The following are known issues with the Avid ISIS 5500 | 5000 infrastructure. When a workaround exists, it appears in the paragraph directly following the issue description.
	The following are known issues with the Avid ISIS 5500 | 5000 infrastructure. When a workaround exists, it appears in the paragraph directly following the issue description.


	File Gateway Issues
	If your Avid ISIS experiences a fatal error to a blue screen, press and hold the power button until the system powers off and then power on the system again.
	If your Avid ISIS experiences a fatal error to a blue screen, press and hold the power button until the system powers off and then power on the system again.
	If your Avid ISIS experiences a fatal error to a blue screen, press and hold the power button until the system powers off and then power on the system again.



	File Gateway Issues
	When you make any changes in the storage group Details pane and click Close, you are asked if you would like to save your changes. If you click Yes, your changes are not saved. You must re-apply the changes and click Apply before you click Close. 
	When you make any changes in the storage group Details pane and click Close, you are asked if you would like to save your changes. If you click Yes, your changes are not saved. You must re-apply the changes and click Apply before you click Close. 
	When you make any changes in the storage group Details pane and click Close, you are asked if you would like to save your changes. If you click Yes, your changes are not saved. You must re-apply the changes and click Apply before you click Close. 

	Workaround: 
	Workaround: 
	Always click Apply before you click Close.



	File Gateway Issues
	If there is a power failure with no spare data drive, an assert error could appear in the Windows System Event logs similar to the following. 
	If there is a power failure with no spare data drive, an assert error could appear in the Windows System Event logs similar to the following. 
	If there is a power failure with no spare data drive, an assert error could appear in the Windows System Event logs similar to the following. 
	Assert Error from .\FScommLayer.cpp MAX_RESPONSE_SIZE
	Assert Error from .\FScommLayer.cpp MAX_RESPONSE_SIZE


	Workaround: 
	Workaround: 
	The System Director typically stops and automatically restarts but if it does not, power off the System Director and then restart it. 



	File Gateway Issues
	File Gateway Issues
	The following are known issues with the Avid File Gateway. When a workaround exists, it appears in the paragraph directly following the issue description.
	The following are known issues with the Avid File Gateway. When a workaround exists, it appears in the paragraph directly following the issue description.

	In the File Gateway Configuration Editor, if you enter a user name that contains a space, the part of the user name that follows the space will not be displayed in the User List after saving the configuration.
	In the File Gateway Configuration Editor, if you enter a user name that contains a space, the part of the user name that follows the space will not be displayed in the User List after saving the configuration.
	In the File Gateway Configuration Editor, if you enter a user name that contains a space, the part of the user name that follows the space will not be displayed in the User List after saving the configuration.


	The Avid ISIS File Gateway does not support Macintosh Common Internet File System (CIFS) clients that have non-ASCII user names (including Asian and Diacritical characters). An error occurs on the Macintosh client indicating you have an incorrect URL.
	The Avid ISIS File Gateway does not support Macintosh Common Internet File System (CIFS) clients that have non-ASCII user names (including Asian and Diacritical characters). An error occurs on the Macintosh client indicating you have an incorrect URL.
	The Avid ISIS File Gateway does not support Macintosh Common Internet File System (CIFS) clients that have non-ASCII user names (including Asian and Diacritical characters). An error occurs on the Macintosh client indicating you have an incorrect URL.


	Macintosh CIFS Clients connected to the Avid ISIS File Gateway clients using the Terminal application hang when attempting to create a filename with invalid characters. Invalid characters are as follows:
	Macintosh CIFS Clients connected to the Avid ISIS File Gateway clients using the Terminal application hang when attempting to create a filename with invalid characters. Invalid characters are as follows:
	Macintosh CIFS Clients connected to the Avid ISIS File Gateway clients using the Terminal application hang when attempting to create a filename with invalid characters. Invalid characters are as follows:
	? * < > | : " \ / 
	? * < > | : " \ / 

	This hang occurs on Mac OS 10.6.2 and later.

	Workaround: 
	Workaround: 
	You must force quit or restart the Macintosh Finder to clear the copy dialog box. 


	If copying between the Avid ISIS File Gateway and a Macintosh CIFS client and the “share name” is renamed in the configuration file (on File Gateway server), the copy operation on the Macintosh client gets interrupted with an appropriate error me...
	If copying between the Avid ISIS File Gateway and a Macintosh CIFS client and the “share name” is renamed in the configuration file (on File Gateway server), the copy operation on the Macintosh client gets interrupted with an appropriate error me...
	If copying between the Avid ISIS File Gateway and a Macintosh CIFS client and the “share name” is renamed in the configuration file (on File Gateway server), the copy operation on the Macintosh client gets interrupted with an appropriate error me...

	Workaround: 
	Workaround: 
	You must force quit or restart the Macintosh Finder to clear the copy dialog box. 


	When ISIS File Gateway clients map ISIS Workspaces to their client systems, the Used and Free space values displayed in the Windows Properties window and the Macintosh Get Info window are not accurate. 
	When ISIS File Gateway clients map ISIS Workspaces to their client systems, the Used and Free space values displayed in the Windows Properties window and the Macintosh Get Info window are not accurate. 
	When ISIS File Gateway clients map ISIS Workspaces to their client systems, the Used and Free space values displayed in the Windows Properties window and the Macintosh Get Info window are not accurate. 






	Legal Notices
	Legal Notices
	Legal Notices
	Legal Notices
	Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.
	Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.
	Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.
	This product is subject to the terms and conditions of a software license agreement provided with the software. The product may only be used in accordance with the license agreement.

	This product may be protected by one or more U.S. and non-U.S patents. Details are available at 
	This product may be protected by one or more U.S. and non-U.S patents. Details are available at 
	www.avid.com/patents


	This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (
	This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (
	http://www.openssl.org/


	Part of the software embedded in this product is gSOAP software. 
	Part of the software embedded in this product is gSOAP software. 
	Portions created by gSOAP are Copyright (C) 2001-2009 Robert A. van Engelen, Genivia inc. All Rights Reserved. 
	THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL TH...

	The following disclaimer is required by Apple Computer, Inc.:
	The following disclaimer is required by Apple Computer, Inc.:
	APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PER...

	The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
	The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
	Copyright © 1988–1997 Sam Leffler Copyright © 1991–1997 Silicon Graphics, Inc.
	Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all c...
	THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
	IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY O...

	The following disclaimer is required by the Independent JPEG Group:
	The following disclaimer is required by the Independent JPEG Group:
	This software is based in part on the work of the Independent JPEG Group.

	This Software may contain components licensed under the following conditions:
	This Software may contain components licensed under the following conditions:
	Copyright (c) 1989 The Regents of the University of California. All rights reserved. 
	Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distri...
	Copyright (C) 1989, 1991 by Jef Poskanzer. 
	Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permissi...
	Copyright 1995, Trinity College Computing Center. Written by David Chappell. 
	Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permissi...
	Copyright 1996 Daniel Dardailler. 
	Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in ...
	Modifications Copyright 1999 Matt Koss, under the same license as above. 
	Copyright (c) 1991 by AT&T. 
	Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and i...
	THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTI...
	This product includes software developed by the University of California, Berkeley and its contributors.

	The following disclaimer is required by Paradigm Matrix:
	The following disclaimer is required by Paradigm Matrix:
	Portions of this software licensed from Paradigm Matrix.

	The following disclaimer is required by Ray Sauers Associates, Inc.:
	The following disclaimer is required by Ray Sauers Associates, Inc.:
	“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shal...

	The following disclaimer is required by Videomedia, Inc.:
	The following disclaimer is required by Videomedia, Inc.:
	“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with respect to its merchantability or its fitness for any particular purpose.”
	“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this ...

	The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source Code:
	The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source Code:
	©1993–1998 Altura Software, Inc.

	The following disclaimer is required by Ultimatte Corporation:
	The following disclaimer is required by Ultimatte Corporation:
	Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are subject to copyright protection.

	The following disclaimer is required by 3Prong.com Inc.:
	The following disclaimer is required by 3Prong.com Inc.:
	Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

	The following disclaimer is required by Interplay Entertainment Corp.:
	The following disclaimer is required by Interplay Entertainment Corp.:
	The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.
	This product includes portions of the Alloy Look & Feel software from Incors GmbH.
	This product includes software developed by the Apache Software Foundation
	(http://www.apache.org/

	© DevelopMentor

	This product may include the JCifs library, for which the following notice applies:
	This product may include the JCifs library, for which the following notice applies:
	JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL
	(http://jcifs.samba.org/


	Attn. Government User(s). Restricted Rights Legend
	Attn. Government User(s). Restricted Rights Legend
	U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or “commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a unit ...

	Trademarks
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	003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, Assistant Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, Avid DNx...

	Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Auto...
	Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Auto...
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